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Notice
Every effort was made to ensure that the information in this book was complete 
and accurate at the time of printing. However, information is subject to change.

Avaya Web Page
The world wide web home page for Avaya is:
http://www.avaya.com

Preventing Toll Fraud 
Toll Fraud is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or working on your company�s behalf). Be aware that 
there is a risk of toll fraud associated with your system and that, if toll fraud oc-
curs, it can result in substantial additional charges for your telecommunications 
services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical 
assistance or support, call the Technical Service Center�s Toll Fraud Interven-
tion Hotline at 1.800.643.2353.

Providing Telecommunications Security
Telecommunications security of voice, data, and/or video communications is 
the prevention of any type of intrusion to, that is, either unauthorized or mali-
cious access to or use of, your company�s telecommunications equipment by 
some party.

Your company�s �telecommunications equipment� includes both this Avaya 
product and any other voice/data/video equipment that could be accessed via 
this Avaya product (that is, �networked equipment�).

An �outside party� is anyone who is not a corporate employee, agent, subcon-
tractor, or working on your company�s behalf. Whereas, a �malicious party� is 
Anyone, including someone who may be otherwise authorized, who accesses 
your telecommunications equipment with either malicious or mischievous in-
tent.

Such intrusions may be either to/through synchronous (time-multiplexed and/
or circuit-based) or asynchronous (character-, message-, or packet-based) 
equipment or interfaces for reasons of:

� Utilization (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or toll-facility 

access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, regardless of 

motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated with 
your system and/or its networked equipment. Also realize that, if such an intru-
sion should occur, it could result in a variety of losses to your company, includ-
ing but not limited to, human/data privacy, intellectual property, material assets, 
financial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company�s Telecommunications Security
The final responsibility for securing both this system and its networked equip-
ment rests with you � an Avaya customer�s system administrator, your tele-
communications peers, and your managers. Base the fulfillment of your 
responsibility on acquired knowledge and resources from a variety of sources 
including but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your 
peers should carefully program and configure your:

� Avaya provided telecommunications systems and their interfaces
� Avaya provided software applications, as well as their underlying hard-

ware/software platforms and interfaces
� Any other equipment networked to your Avaya products

Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to 
comply with the limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environ-
ment. This equipment generates, uses, and can radiate radio-frequency ener-
gy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference, in which case the user 
will be required to correct the interference at his own expense.

Industry Canada (IC) Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emis-
sions set out in the radio interference regulations of Industry Canada.

Le Présent Appareil Nomérique n�émet pas de bruits radioélectriques dépas-
sant les limites applicables aux appareils numériques de la class A préscrites 
dans le reglement sur le brouillage radioélectrique édicté par le Industrie Can-
ada.

Trademarks
All trademarks identified by ® and � are registered trademarks or trademarks 
of Avaya Inc. All other trademarks are the property of their respective owners. 

Ordering Information
Call: Avaya Publications Center

Voice 1 800 457-1235   International Voice +1 207 866 6701
Fax 1 800 457-1764      International Fax +1 207 626 7269

Write: GlobalWare Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attn: Avaya Account Management

Email: totalware@gwsmail.com

Obtaining Products
To learn more about Avaya products and to order products, visit 
www.avaya.com. 

European Union Declaration of Conformity
The �CE� mark affixed to the equipment means that it conforms to the refer-
enced European Union (EU) Directives listed below:
EMC Directive89/336/EEC   
Low-Voltage Directive73/23/EEC
For more information on standards compliance, contact your local distributor.

Warranty 
Avaya Inc. provides a limited warranty on this product. Refer to your sales 
agreement to establish the terms of the limited warranty. In addition, Avaya�s 
standard warranty language as well as information regarding support for this 
product, while under warranty, is available through the following web site: 
www.avaya.com/support.
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 About this book

Purpose
This book, Avaya Modular Messaging for Microsoft Exchange Release 1.1 Installation, 
Issue 1, contains instructions for installing or upgrading the Avaya Modular Messaging 
software in a Microsoft Exchange environment. Instructions include:

! New system installation including equipment assembly, machine set up 
and configuration, initial administration, and acceptance testing 

! Upgrade instructions for a Unified Messenger Release 5.0 system

! Disaster-recovery procedures for reinstalling the operating system and 
application software on an Avaya-provided Messaging Application 
Server (Avaya MAS) 

Intended audiences
This book is intended for system administrators and on-site technical personnel who 
are responsible for installing, configuring, or upgrading the hardware and software for 
an Avaya Modular Messaging system. 

Users of this book should be familiar with administering Microsoft Windows 2000 and 
Microsoft Exchange systems. It is assumed that they have read the Avaya Modular 
Messaging Concepts and Planning guide. 

Note: This document is intended to get a Modular Messaging system up 
and running. Customers are encouraged to tailor the basic Modular 
Messaging parameters for their site after a successful installation 
using the Avaya Modular Messaging Software Messaging 
Application Server Administration guide (PDF 3 MB). Copies of this 
guide are on the documentation CD and application software DVD.
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Technicians who install an Avaya-provided Messaging Application Server (called the 
�Avaya MAS� in this guide) should have completed a relevant hardware installation 
training course. See Related resources in this preface for information on training.

How to use this book
Review the appropriate overview below depending on whether you are installing a new 
Avaya Modular Messaging system, or upgrading or repairing a system that was already 
in operation. 

For new installations: 

This document covers how to install Avaya Modular Messaging software on either a 
customer-provided Messaging Application Server (MAS), or on hardware provided by 
Avaya (called the �Avaya MAS� in this guide). Although most steps are similar, this 
guide does contain sections that are only applicable to one or another of these specific 
installations, as noted in the text. 

1. Be aware of the system requirements in the Avaya Modular Messaging 
Concepts and Planning guide (PDF 2 MB). This guide explains 
important concepts and provides information that is crucial for planning a 
Modular Messaging system.

2. Complete all the worksheets in Appendix A, ��System planning forms.�� 
You cannot complete an installation or upgrade successfully without 
having this material complete and accurate. The customer must provide 
some of the information in advance.

3. Print the relevant checklist from Appendix B, ��Installation checklists,�� 
depending on whether you are installing the Modular Messaging 
software on a customer-provided MAS or an Avaya MAS. Keep the 
checklist handy and use it to track your progress during the installation.

4. Read Chapter 1, ��Preinstallation requirements.�� This chapter contains 
prerequisites and site preparation, including the documentation, tools, 
and equipment you will need to complete an installation. 

5. Install the hardware required for your specific installation: 

! See Chapter 2, ��Installing Avaya-provided hardware,�� if you are 
installing an Avaya-provided Messaging Application Server (Avaya 
MAS) system and any optional peripheral devices provided by Avaya 
Inc. The port boards and much of the required software are already 
installed on an Avaya MAS. 

! See Chapter 3, ��Installing MAS port boards,�� to install the required 
port boards and Dialogic software in a customer-provided MAS. 

Note: No hardware installation is required if you are using an IP 
H.323 integration on a customer-provided MAS. 
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6. Chapter 4, ��Preparing to install Modular Messaging software,�� covers 
prerequisite steps that must be performed by the directory server 
administrator or other authorized personnel. This work must be 
completed before any other Modular Messaging software is installed. 

7. From there, follow the directions in each chapter relevant to your setup 
to install, configure, and test the Modular Messaging software. 

For system upgrades or repairs:

! For all systems, complete the worksheets in Appendix A, ��System 
planning forms.�� Any information you enter must exactly match what 
was previously administered on the system. Customer input is required. 

! For a software upgrade: Go directly to Chapter 11, ��Upgrading Unified 
Messenger 5.0 to Modular Messaging software.�� Obtain the software 
and documentation listed in the Overview section. Proceed as directed.

! For a hard disk repair: Go directly to Appendix F, ��Recovering from a 
catastrophic disk failure.�� Proceed as directed.

Trademarks
Avaya and the Avaya Logo are trademarks of Avaya Inc. and may be registered in 
certain jurisdictions. Unless otherwise specified, all trademarks identified by ® and � 
are registered trademarks or trademarks, respectively, of Avaya Inc. Microsoft is a 
registered trademark of Microsoft Corporation. All other trademarks are the properties 
of their respective owners.

Related resources
This section describes additional documentation and training available to you.

Documentation

See the inside front cover for information on how to order documentation for this 
product. 

Note: Completely install and test one MAS first, and let it run for 15 
minutes before installing the software on any additional MASs. 

Note: Always refer to the appropriate CD, DVD, or book for specific 
information on planning, installing, administering, or maintaining an 
Avaya system. See the online catalog for more information on 
other books and CD-ROMs in the documentation set.
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Technical assistance

The following technical assistance is available if needed. 

Remote support center

Your project manager or systems consultant is responsible for providing you with the 
telephone number of your remote support center.

The following numbers are available for technical assistance with Avaya products and 
services: 

! Within the United States and Canada: call 1-800-876-2835, prompt 2, 
then 2.

! Within any other country: call your local distributor.

Help on the system

Online help is available for both the system and administration command-line screens. 
On the web-interface screens, use the Help button. On the command-line interface, 
press F6 (Choices) from the field for which you want the help. 

Training 

For information about product training, go to the Avaya web site at www.avaya.com 
and click Training.

How to comment on this book

We are interested in your suggestions for improving this information. Use one of the 
following methods to communicate with us:

Please be sure to include the name of this book:

Avaya Modular Messaging for Microsoft Exchange Release 1.1 Installation, Issue 1. 

Method Contact

Email infodev@avaya.com

Voice mail or fax number 303-538-9625

http://www.avaya.com
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1
Preinstallation requirements

This chapter describes requirements and prerequisites for installing Avaya Modular 
Messaging software on a new system in a Microsoft Exchange environment.  

Section Page

Required documentation 1-2

� Information on the web 1-2

� Documentation and software shipped with the system 1-3

Security considerations 1-4

� Customer's responsibility for their system's security 1-4

� On-site security 1-5

� System security 1-5

Test equipment and tools 1-6

� Test equipment 1-6

� Tools 1-6

Initial switch and LAN administration 1-7

� Initial switch or PBX administration 1-7

� Initial LAN administration 1-7

� Preinstallation planning forms 1-7

Hardware requirements 1-8
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Required documentation

The following documentation is required to install a new Avaya Modular Messaging 
system. Some of this information can only be obtained from the Avaya web site. Other 
information is available in the Avaya Modular Messaging Documentation files on CD 
and DVD shipped with the system software. However, the required documentation can 
also be accessed online and printed out prior to beginning the actual installation.

Information on the web

Required documentation for a new installation is available as follows:

! The configuration notes for integrating the MAS and any Dialogic port 
boards installed in it with the PBX or switch at this site. To view these: 

a. Access the www.avaya.com/support web site. 

b. Under Technical Database, click Messaging.

c. Click Modular Messaging.

d. Under General Info, download or print the appropriate configuration notes 
for your switch integration. 

! An editable Microsoft Word version of the planning forms from Appendix 
A, ��System planning forms,�� and the installation and upgrade checklists 
from Appendix B, ��Installation checklists,�� are also accessible from this 
web site. To download the Word or PDF version: 

a. Under R 1.1, click General Reference.

b. Click the System Planning Forms link to download or print the files 
appropriate for your configuration.

! Additional information needed for installing a new system is on the 
Avaya Modular Messaging Application Software disk and the 
documentation CD. To access this information online:

a. Under R 1.1, click CD Collections.

b. Click the Avaya Modular Messaging Release 1.1 Documentation link.

c. Select the appropriate configuration (such as Avaya Modular Messaging for 
Microsoft Exchange). 

d. On the main page, under Reference, download the files you need:

! The appropriate Dialogic port board installation documents for this 
site (see Table 3-1 on page 3-2 for details)

Note: This information is available only on the Avaya support web 
site and must be obtained prior to installing the software. 

http://www.avaya.com/support
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! The Avaya Modular Messaging Subscriber Options User Guide 
(585-310-789, PDF 1 MB), used for acceptance testing

Documentation and software shipped with the system

The following software and documentation is shipped with every Modular Messaging 
system.  

Table 1-1. Required Modular Messaging software

Disk: Purpose:

Avaya Modular Messaging 
Application Software DVD

� Installing the Modular Messaging software, Dialogic port 
board drivers, and Text-to-Speech (TTS) software

� Upgrading a Unified Messenger Release 5.0 system to 
Modular Messaging Release 1.1 software 

� Accessing a copy of the documentation files (see contents 
listed under the documentation CD) 

Avaya Modular Messaging 
Documentation CD 

(2 copies are shipped, one 
for the customer and one for 
the technician) 

Accessing required documentation, including:
� The port board installation documents listed in Table 3-1 

on page 3-2
� Avaya Modular Messaging Subscriber Options User Guide 

(585-310-789, PDF 1 MB), used for acceptance testing 
� Any required hardware replacement procedures 

Avaya Modular Messaging 
OS Boot Software DVD

� For the Avaya MAS only: Reinstalling the boot-image 
software on a new system if needed, or on an Avaya MAS 
hard disk after a catastrophic disk failure. See Appendix E, 
��Reloading software on an Avaya MAS.�� 

CD-only set (special order only): 

Avaya Modular Messaging 
Application Software and 
Languages CD

Installing Modular Messaging Release 1.1 software on an 
MAS, or upgrading a Unified Messenger Release 5.0 system 
to Modular Messaging Release 1.1 software 

Intel Dialogic Drivers CD Installing or updating Dialogic port board drivers 

Enhanced Email Reader 
Software (3 CDs in set)

Installing ScanSoft RealSpeak Text-to-Speech (TTS) software 
for multiple languages

Documentation CD Identical to the CD shipped with the DVD set 

Note: The configuration notes for your PBX or switch can only be 
obtained from the Avaya support web site. See "Information on the 
web" on page 1-2 for this procedure.
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Security considerations

The following security-related issues apply to all Modular Messaging installations.

Customer's responsibility for their system's security 

No telecommunication system can be entirely free from the risk of unauthorized use. 
Customers have ultimate control over the configuration and use of the product and are 
solely responsible for ensuring the security of their systems. Customers who 
administer and use the system can tailor the system to meet their unique needs and 
are in the best position to ensure that the system is secure to the fullest extent 
possible. Customers are responsible for keeping themselves informed of the latest 
information such as security patches, anti-virus updates and other relevant information 
for configuring their systems to prevent unauthorized use. System managers and 
administrators are also responsible for reading all the recommendations, installation 
instructions, and system administration documents provided with the product in order 
to understand the features that can introduce risk of toll fraud and the steps that need 
to be taken to reduce that risk.

Avaya does not warrant that this product is immune from or will prevent unauthorized 
use of telecommunication services or facilities accessed through or connected to it. 
Avaya will not be responsible for any damages or charges that result from either 
unauthorized uses or from incorrect installations of the security patches that are made 
available from time to time. To aid in combating these crimes, Avaya intends to 
strengthen relationships with its customers and its support of law enforcement officials 
in apprehending and successfully prosecuting those responsible.

Suspected security vulnerabilities with Avaya products should be reported to Avaya by 
sending mail to securityalerts@avaya.com. Reported vulnerabilities are prioritized and 
investigated. Any corrective actions resulting from the vulnerability investigation are 
posted at http://support.avaya.com/security. Whether or not immediate support is 
required, please report all toll fraud incidents perpetrated on Avaya services to Avaya 
Corporate Security. In addition to recording the incident, Avaya Corporate Security is 
available for consultation on product issues, investigation support, law enforcement, 
and education programs.

See Modular Messaging and Security on the documentation CD for more information 
on system security. 

http://support.avaya.com/security
se_toc.htm
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On-site security

It is the responsibility of the on-site installer to take precautions to protect passwords 
and the system�s physical location as described in this section.

Password security 

To protect password security: 

! Do not leave written passwords laying out or allow anyone to see them.

! At the first opportunity, give the passwords directly to the customer's 
designated representative.

! If you suspect that the security of any password has been compromised, 
notify your project manager or system administrator.

System security during the installation

To protect system security during the installation: 

! Remove all test subscribers and test mailboxes from the system when 
the procedures instruct you to do so.

! Always lock the server if you will be leaving it unattended, even for a 
short period of time.

System security

Customers are responsible for obtaining and installing anti-virus software on any 
Microsoft Windows machine that is used to run Avaya Modular Messaging software, in 
accordance with their local policy. In addition, Microsoft Windows security patches 
must be installed and routinely updated to protect the operating system from known 
security weaknesses.
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Test equipment and tools

The following test equipment and tools are recommended for all new Modular 
Messaging installations.

Test equipment

Recommended test equipment for a successful installation includes: 

! At least one telephone that is connected through the switch or Private 
Branch Exchange (PBX). It must be of the same type as the majority of 
telephones the customer will be using on the system. 

� If the message waiting indicator (MWI) for the system is a lamp, the 
test telephone must be equipped with a lamp. If the MWI is a stutter 
tone, it must be able to give the stutter notification. 

� The test telephone must be placed so that you can easily see the 
monitor while using it. 

! A volt/ohm meter. 

Tools

You should have the following tools on site to successfully install a new system: 

! A medium-width flatblade screwdriver 

! A No. 2 Phillips screwdriver 

! A small pair of needlenose pliers 

! A small pair of wire cutters 

! A sharp, pointed instrument such as a ballpoint pen

CAUTION: Do not use the point of a lead pencil to operate the system 
reset switch. The graphite can damage a circuit card, and 
cause problems such as electrical shorts.

!
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Initial switch and LAN administration

This section describes the initial switch or Private Branch Exchange (PBX) and local 
area network (LAN) administration that must completed by the customer before or 
during a new Modular Messaging installation. 

Initial switch or PBX administration

Initial switch or PBX administration may or may not be complete when you arrive on 
site, depending on the contract or customer agreements. When you install a new 
server, the switch must be administered to support the following situations: 

! For configurations that use analog and DSE port boards, testing each 
channel to be connected to the system before assigning the channels to 
the server or another application. During this testing, you must be able to 
call each channel individually. 

! Testing the system with at least one test subscriber. 

! Performing cut-to-service procedures that provide the subscribers with 
an active coverage path.

Verify that initial switch administration and testing is complete.

Initial LAN administration

The LAN administrator must administer the corporate LAN for the messaging system. 
Some LANs might be administered prior to your arrival on site. Other LANs require that 
the administration for a new server be done at the time of installation.  

Preinstallation planning forms

Complete the planning forms in Appendix A, ��System planning forms,�� prior to 
beginning an installation. By acquiring IP addresses, server, and domain name 
information in advance, you can save hours of installation time and debugging.
 

Note: Avaya is not responsible for the installation, administration, or test 
of communications between customer computers and the LAN.

CAUTION: It is crucial to coordinate the IP addresses that will be used 
with a Messaging Application Server (MAS) with those on 
the corporate LAN. If you specify an IP address for an MAS 
that conflicts with another Ethernet endpoint, the resulting 
traffic problems on the LAN may be extremely difficult to 
diagnose and solve.

!
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Hardware requirements

A Modular Messaging software installation requires the following hardware:

! One or more Messaging Application Server (MAS) machines that will run 
the Modular Messaging software. These MASs can be:

� An Avaya-provided Messaging Application Server (called the �Avaya 
MAS� in this guide) on which the port boards and much of the required 
software are already installed. Some preinstallation requirements for 
this configuration are covered in Chapter 2, ��Installing Avaya-provided 
hardware.��

� A customer-provided machine that meets the minimum requirements 
specified in the Avaya Modular Messaging Concepts and Planning 
guide (PDF 2 MB). This machine requires the appropriate port boards 
and drivers to be installed prior to installing the Modular Messaging 
software as described in Chapter 3, ��Installing MAS port boards.�� 

! A server that is running a compatible release of Microsoft Exchange 
software. This server is hereafter referred to as the Exchange server.

! A server that contains the subscriber mailboxes, such as Active 
Directory or the Microsoft Exchange Administrator application. This 
server is hereafter referred to as the directory server. This server may be 
the same as the Exchange server, or it can be a separate machine. 

Both the Exchange server and the directory server must be in place and operational 
prior to installing the Modular Messaging software. 

Because a Modular Messaging installation requires many steps, print a copy of the 
checklist relevant to your configuration in Appendix B, ��Installation checklists.�� Check 
off items as you complete them to track your progress.

Note: No hardware installation is required if you are using an IP 
H.323 integration on a customer-provided MAS. 

Note: Chapter 4, ��Preparing to install Modular Messaging software,�� 
covers prerequisite steps that must be performed by the directory 
server administrator or other authorized personnel. This work may 
be done before or during hardware installation, but must be 
completed before any other Modular Messaging software is 
installed.



December 2003 585-310-331, Issue 1 2�1

2
Installing Avaya-provided hardware

This chapter applies only to installing a Avaya-provided hardware, such as one or more 
Avaya Messaging Application Servers (called the Avaya MAS in this guide) and any 
optional peripheral devices provided by Avaya Inc. The port boards and much of the 
required software are already installed for an Avaya MAS.   

Note: Before you can successfully complete the tasks in this section, you 
must have read Chapter 1, ��Preinstallation requirements,�� and 
verified that all preinstallation requirements have been met. 

To install port boards in a customer-provided MAS, continue with 
Chapter 3, ��Installing MAS port boards.��

Section Page
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Site requirements for an Avaya MAS 2-3
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Overview

This chapter is organized as follows:

! "Site requirements for an Avaya MAS" on page 2-3

! "Unpacking the hardware" on page 2-7

! "Installing the Avaya MAS" on page 2-8

Because a Modular Messaging installation requires many steps, print a copy of the 
checklist relevant to your configuration in Appendix B, ��Installation checklists.�� Check 
off items as you complete them to track your progress.

Installing the Avaya MAS 2-8

� Installing the UPS and EBMs (optional) 2-10

� Installing the Avaya MAS 2-14

� Installing the KVM switch (optional) 2-23

� Attaching ferrites 2-27

� Connecting the USB modem on the MAS 2-28

� Powering up an Avaya MAS system 2-30

Section Page
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Site requirements for an Avaya MAS

This section describes the physical requirements for the installation site, including 
environmental, weight, space, and power considerations for an Avaya Messaging 
Application Server (Avaya MAS).

Environmental requirements

Table 2-1 lists the environmental conditions that must be maintained in the area where 
the Avaya MAS is installed and maintained.  

Weight and space considerations

Table 2-2 lists the weight, height, width, and depth of an Avaya MAS.  

For safety considerations, at least two technicians should be on site and available to 
mount the units.

Customer-provided cabinet requirements

If an Avaya MAS is to be installed in a rack-mount configuration, the customer-provided 
cabinet must meet the following requirements: 

! The cabinet must contain a 4-post rack to support the server�s weight.

! The customer-provided cabinet must be secured to the floor before 
attempting to mount any units.

Table 2-1. Environmental requirements

Operating state Temperature Maximum heat output Humidity (noncondensing)

Operating +10 to +35ºC 
(+50 to +95ºF)

730 BTU per hour 20% to 80% RH

Non-operating 
(in storage or being 
shipped)

-20 to +50ºC 
(-4 to+122ºF)

N/A 20% to 90% RH

Table 2-2. Avaya MAS weight and space considerations

Server Weight (full) Height Width Depth

Avaya Messaging Application Server 
(Avaya MAS)

40 lb.
(18.1 kg)
(without port boards)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)
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! The sliding rails and extender brackets provided with each Avaya MAS 
are designed for mounting in cabinets 22.5 to 32 inches in depth.

! The cabinet height needs to accommodate the number of units to be 
mounted (see Table 2-2 for server height). It may also need to hold the 
MAS modems and optional equipment such as the KVM switch and UPS 
units (see Figure 2-1 on page 2-9 for an example).

Installation area requirements

Observe the following when determining where to place the system: 

! Maintain an air-distribution system that provides adequately cooled, 
filtered and humidity-controlled air. 

! Do not install the Avaya MAS such that the ventilation or fan openings 
will be blocked.

! For T1/E1 connections, the circuits require isolation from exposed lines. 
For T1 lines, the customer must provide a CSU (T1) at the building point 
of entry. This CSU must be UL Listed and/or CSA Certified. For E1 lines, 
either the network provider or the customer must provide a CSU (E1) or 
other equivalent protection that has the product safety approvals 
required by the local jurisdictions. 

! Systems installed in Finland, Norway, Sweden and Australia must be 
installed in a restricted-access location. A restricted-access location is 
defined as an installation location where access can be gained only by 
service personnel or customers who have been instructed on the 
reasons for the restricted access and safety precautions that must be 
taken. A restricted-access location also allows access through the use of 
a tool (such as a lock and key) or other means of security.

CAUTION: To reduce the risk of fire, use only No. 26 AWG or 
larger telecommunication line cord.!

ATTENTION
:

Pour réduire les risques d�incendie, utiliser 
uniquement des conducteurs de 
télécommunications 26 AWG au de section 
supéleure.

!
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Power requirements

Table 2-3 lists the power requirements for the Avaya MAS. The AC power supply 
source needs to be a single phase 3-conductor (line, neutral, and ground), with a 15 A 
circuit breaker for 100-127 Vac installations or a 10 A circuit breaker for 200-240 Vac 
installations. 

Consideration must be given to the server connection to a branch circuit with respect to 
overload or overcurrent protection. Check the system's ratings to ensure that, together 
with other equipment connected to the same branch circuit, an overcurrent or overload 
condition does not exist.

Grounding requirements

An Avaya MAS relies on the ground connection through the mains socket-outlet for 
continued safe operation. Ensure that the AC main outlet to be used to power the 
system (via the power cord or UPS) is a grounded outlet. If you are unsure of the 
ground integrity of the outlet, have a trained and certified electrician check the outlet. 

In addition, observe the following grounding requirements when determining where to 
place the server:

! Use only the power cord provided with each unit to connect it to the 
universal power supply (UPS) or to an AC mains outlet.

! Install the server within 6 feet (2 m) of a grounded AC mains 
socket-outlet.

! Do not use extension cords with the system.

Table 2-3. Avaya MAS power requirements

Server # of power 
supply units Volts AC Hertz Amperes 

120V/240V

Avaya MAS 1 100-240 +/� 10% 50/60 +/� 3 Hz 10/5

WARNING: The Avaya MASs must be connected to an earthed mains 
socket-outlet. Failure to do so will result in allowing a hazard 
to be present that could cause severe personal injury or 
death.

!

CAUTION: System grounding must comply with the general rules for 
grounding provided in article 250 of the National Electrical 
Code (NEC), National Fire Protection Agency (NFPA), or the 
applicable electrical code in the country of installation.

!
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Demarcation points

This section lists the demarcation points for switches (PBXs) and LAN connectivity.

Demarcation point for switches (PBXs)

The demarcation point for switch (PBX) connections to the Avaya MAS is the wall field 
for Avaya switches. 

For non-Avaya switches, it is the end of the connector of the Avaya-provided cables for 
the port boards. Avaya service technicians dispatched for the system installation are 
not responsible for making any connections directly to switches that are not maintained 
by Avaya.

Demarcation point for LAN connectivity 

The demarcation point for the LAN connection to the Avaya MAS is the physical 
Ethernet interface on the server that connects to the corporate LAN. The customer is 
responsible for: 

! The LAN cables that connect the Avaya MAS to the corporate system 
(unless the customer uses Avaya-provided cables, in which case the 
demarcation point is the modular connector at the end of the LAN 
cables). 

! LAN administration not performed on the Avaya MAS.

! Maintaining the TCP/IP addresses and administration on the server after 
cutover, unless otherwise specified by contract.

! Providing the IP address, subnet mask, and gateway information for 
administration on the server, as well as any DNS server IP information 
and corporate domain names.

Avaya service technicians dispatched for system installation are not responsible for 
troubleshooting the customer's LAN.

Note: Avaya recommends joint acceptance testing for systems integrated 
with switches that are not maintained by Avaya. 
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Unpacking the hardware

This section lists the required and optional hardware that is needed to successfully 
install and maintain an Avaya Modular Messaging system. 

Required and optional hardware

An Avaya Messaging Application Server (Avaya MAS) requires the hardware 
components listed in Table 2-4. Verify that all the components needed for this 
installation are on site.

Table 2-4. Required and optional Avaya MAS hardware 

Item Quantity Required/optional

Required equipment:

Avaya Messaging Application Server (Avaya MAS) 1 minimum, 
10 maximum

required

Server AC power cables 1 per Avaya MAS server required

Front bezel 1 per server required

Rack-mount assembly (rails, handles, brackets, and 
connecting hardware)
and rubber spacers for stackable desktop configuration 

1 set of each per server; 
use mount type required

required

Ethernet LAN cable 1 per server required

USB modem (includes USB cable) 1 per MAS server required

Port board cables (see Table 3-1 on page 3-2) 1 set per port board required for port boards 

Optional or customer-provided equipment:

Monitor (includes power cord and VGA cable) 1 optional; may be 
customer-provided

Keyboard and mouse (includes cords and Y cable) 1 set optional; may be 
customer-provided

KVM switch (includes power transformer)

KVM switch cable to each server

includes 1 set of rack-mount brackets if needed for 
rack-mount setup

1 KVM switch

1 cable per server

1 set if needed

optional; other models 
of switching devices 
may be used
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Saving the packing materials

Save the shipping cartons and all packing materials in case any hardware needs to be 
returned to the manufacturer. If you ordered more than one Avaya MAS, saving one 
carton and one set of packing materials should be sufficient. Packing materials include: 

! Antistatic bags 

! Cardboard and foam inlays 

Also save the shipping cartons for all peripheral devices such as the monitor, 
keyboard/mouse, all required modems, and the UPS and any EBMs (if used). 

Installing the Avaya MAS

This section covers how to install one or more Avaya Messaging Application Server 
(Avaya MAS) units. Hardware components that are optional are noted in the text. For 
more information about required and optional hardware, see Table 2-4 on page 2-7. 

The Avaya MAS units can be installed in one or more customer-provided commercial 
cabinets as a rack-mount system, or without a commercial cabinet in a stackable 
desktop configuration. This section includes instructions on how to install both 
rack-mount and stackable desktop configurations.

Figure 2-1 on page 2-9 shows an example of an installed rack-mount system. 

Uninterruptible power supply (UPS) with required power 
cord

includes 1 set of rack-mount brackets and rubber spacers 
for a stackable setup

1 optional; type may vary

Extended battery module (EBM) with required power cord

includes 1 set of rack-mount brackets and rubber spacers 
for a stackable setup

1 to 4 optional; may be 
ordered with the UPS

Table 2-4. Required and optional Avaya MAS hardware 

Item Quantity Required/optional

Note: The packing materials may include a plastic bag designed to 
protect the system from moisture during shipment. Discard this 
bag. It is not reusable. 

Note: The sample figure shows the Avaya MAS servers with their front 
bezels removed.
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Figure 2-1. Example of an installed rack-mount Avaya MAS system (front view)
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1 Customer-provided cabinet (type may vary; see physical requirements in "Installation 
area requirements" on page 2-4)

2 EBM (optional; 0 to 4 may be installed with a UPS)

3 UPS (optional; model may vary)

4 Avaya Messaging Application Server (Avaya MAS); up to 10 units may be present

5 KVM switch (optional; type may vary)

6 External modem; one is required for every MAS 
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Installing the UPS and EBMs (optional)

This section describes how to install an optional uninterruptible power system (UPS) 
and one or more optional extended battery modules (EBMs). 

! Customers may order a different model of UPS, or supply their own. See 
the documentation that was provided with the UPS for instructions.

! If a UPS will not be installed, continue with the next section, "Installing 
the Avaya MAS" on page 2-14.

The UPS is an optional component for the Avaya MAS that can protect the system from 
most common power problems including power failures, power sags, power surges, 
and so on. 

The EBM is an optional component that works in conjunction with the UPS to add 
additional run time for the system. The customer may add up to four EBMs per UPS. 
For more information, see the documentation that was shipped with the EBM and UPS.

To install the UPS and EBMs:

! For rack-mount installations, see "Installing the UPS and any EBMs into 
a rack" on page 2-10. 

! For a stackable desktop configuration, see "Installing the UPS and any 
EBMs as a stackable configuration" on page 2-12.

Installing the UPS and any EBMs into a rack

In a rack-mount configuration, the UPS and EBMs must be positioned in the rack below 
any Avaya MAS units, with the EBM units in the lowest-available position. 

To install the UPS and EBMs into a rack:

1. Gather the necessary rack-mount hardware, including the mounting 
handles, brackets, and screws. 

2. Place the UPS on a flat, stable surface with the front of the UPS facing 
toward you.
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3. Attach the mounting handle to each bracket using the supplied screws. 
See item 1 in Figure 2-2.

4. Align the mounting brackets with the screw holes on the side of the UPS 
and secure using the supplied screws. See item 2 in Figure 2-2.

5. If you are installing one or more EBMs, repeat steps 1 through 4 for each 
EBM. 

6. Place the EBM into the rack in the lowest-available position and attach 
the EBM to the rack using customer-provided screws. 

7. Place the UPS into the rack in the lowest-available position above any 
EBMs and attach the UPS to the rack using customer-provided screws.

8. Continue with the "Cabling the UPS and any EBMs" on page 2-13.

Figure 2-2. Attaching mounting handles and bracket for a rack-mount UPS

Note: The EBMs must be installed below the UPS.

Note: If additional EBMs need to be installed into the rack, install 
them above the first installed EBM.
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Installing the UPS and any EBMs as a stackable configuration

To configure the UPS and any EBMs in a stackable configuration:

1. If you are installing one or more EBMs, remove the adjacent corner 
screws from the rear panels. See Figure 2-3 for the location of these 
screws. If you do not have any EBM units, go to step 4.

2. Install the EBM brackets by aligning each bracket with the screw holes 
and secure the bracket the supplied screws as shown in Figure 2-3.

3. Repeat steps 1 and 2 for each additional EBM.

4. On the bottom unit (either the UPS, or an optional EBM), secure four 
rubber spacers to the bottom of the unit, one at each corner.

5. Set the unit on a stable platform. This unit will form the base of the 
stackable desktop configuration.

Figure 2-3. Attaching connecting brackets between a UPS and EBM (back view)
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Cabling the UPS and any EBMs

To cable the UPS and any EBM units: 

1. Connect the EBM cable to the battery connector on the UPS. See item 1 
in Figure 2-4. 

2. If you need to connect additional EBMs, plug the EBM cable of the 
second EBM into the battery connector on the first EBM. 

3. Repeat step 2 for each additional EBM. Up to four EBMs may be 
connected to the UPS. 

Figure 2-4. Connecting a UPS and an EBM (back view)
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1 UPS (model may vary; see the provided documentation for details)

2 EBM (optional; 0 to 4 may be installed)

3 EBM battery cable to UPS

4 Battery connectors for additional EBMs if needed (optional)

5 UPS power cable to a grounded AC power outlet
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Installing the Avaya MAS 

This section describes Avaya MAS components, and how to install the Avaya MAS in a 
customer-provided commercial cabinet or in a stackable desktop configuration. 

Identifying key components of the Avaya MAS

Figure 2-5 shows an Avaya Messaging Application Server (Avaya MAS). You may 
have up to four Avaya MASs per Modular Messaging system. 

Figure 2-5. Avaya MAS (front view with bezel removed)
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1 Redundant chassis fans

2 Chassis fan retaining screw

3 System reset button

4 Disk drive access indicator 

5 System power indicator

6 System power on/off button

7 DVD player

8 IDE disk drive A (hda)
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Figure 2-6 shows the back view of an Avaya Messaging Application Server (Avaya 
MAS). 

Figure 2-6.  Avaya MAS (back view)
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1 Power supply

2 AC power receptacle

3 Power supply on/off switch

4 Latch for top cover

5 Mouse connector

6 Keyboard connector

7 Serial port (COM1)

8 Parallel port (not used)

9 Serial port (COM2)

10 Corporate LAN interface

11 USB ports, one of which is used for the required modem

12 Audio connectors (not used)

13 Video card (contains monitor connector)

14 Network interface card (not used)

15 Port boards (type varies from machine to machine). Up to six port boards can be 
installed in each MAS (depending on the type of board and traffic requirements), 
typically starting from the end of the cabinet. Port boards are not present for IP 
H.323 integrations. See "Supported MAS port boards" on page 3-2 for details. 
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Attaching the front bezel

The front bezel must be attached to each Avaya MAS as described. 

1. Insert the bottom of the front bezel into the chassis. See item 1 in Figure 
2-7.

2. Push the bezel upright until the two upper tabs snap into place under the 
top cover. 

Installing the Avaya MAS in a rack-mount or stackable setup

The Avaya MAS can be installed either in a commercial cabinet in a rack-mount 
configuration, or stacked on top of one another in a desktop configuration. Continue 
with the appropriate section based on the installation method to be used at your site: 

! "Installing an Avaya MAS in a rack-mount configuration" on page 2-17

! "Installing the Avaya MAS in a stackable desktop configuration" on page 
2-19

Figure 2-7. Attaching the front bezel
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CAUTION: The Avaya MAS is heavy. Get another person to 
assist you with lifting and placing the unit.!
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Installing an Avaya MAS in a rack-mount configuration

The task describes how to install one or more Avaya MASs in a commercial cabinet. 
This is also called a rack-mount configuration.  

Before you begin to install the servers into the rack, verify that the necessary 
rack-mount hardware is on site. Required equipment is summarized in Table 2-5.

To install an Avaya MAS into a rack:

1. Gather the necessary rack-mount hardware as listed in Table 2-5. 

2. Place the server on a flat, stable surface.

3. If the mounting handles are not already attached, attach them now:

a. Connect the handles to the bracket using the supplied flat-head screws. 
See item 1 in Figure 2-8 on page 2-18.

b. Align the mounting bracket with the screw holes on the side of the server 
and secure using the supplied flat-head screws. See item 2 in Figure 2-8.

4. Attach the rack-mount rails to the server as follows:

a. Remove the two screws and retaining bar on the rail slide just before the 
server-retaining latch. Set them aside for later. See item 3 in Figure 2-8.

b. Disassemble the slide (necessary to access all three screw holes).

Note: The first Avaya MAS is typically installed directly above the UPS. If 
a UPS is not present, install the Avaya MAS in any available 
position in the cabinet. 

If more than one Avaya MAS is present, you typically install each 
additional MAS above the first MAS. However, all the Avaya MASs 
do not have to be in the same cabinet.

Table 2-5. Required rack-mount hardware

Part Quantity

Extension bracket (two different lengths may be shipped) 2 per server

Right-side rack-mount rails and slides 1 set per sever

Left-side rack-mount rails and slides 1 set per sever

Front panel handle set (handles and mounting brackets; these 
may already be assembled on some units)

1 set per server

Miscellaneous screws and mounting hardware 1 set per server

Customer-provided: Mounting hardware to secure the extension 
bracket and rack-mount slide to the customer-provided rack.

1 set per rack-mount rail 
and extension bracket
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c. Place the flat piece of the rail slide against the server and secure it with the 
three supplied flat-head screws. See item 4 in Figure 2-8.  

5. Position the extension bracket on end of the rail slide to provide the 
depth needed for the server to fit in the rack. A couple of extension 
brackets may be shipped; choose the correct length for your cabinet. 
See item 5 in Figure 2-8.

6. Attach the extension bracket to the rear of the rail slide using the 
supplied screws and retaining bar (2 pan-head screws per bracket). See 
item 6 in Figure 2-8.

7. Connect the extension bracket and rail slide to the customer-provided 
four-post rack using the correct customer-provided hardware for that 
model of cabinet. See item 7 in Figure 2-8.

8. Fully extend the rail slides to the locked-out position.

9. With another technician supporting the unit, align the front of the rail 
slide with the rack-mount rail that is attached to the server.

10. Push the unit onto the rail slide far enough so that the safety catch 
engages.

11. Slide the server completely into the rack. Ensure that the server moves 
smoothly in an out of the rack.

12. Reattach the two screws and retaining bar on the rail slide just before 
the server-retaining latch (item 3 in Figure 2-8, from step 4a).

Note: The rack-mount rails are labeled L for left and R for right. Verify 
that you are installing the correct rail on the correct side.

Figure 2-8. Attaching server mounting handles, bracket, and rack-mount rail assembly
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13. Repeat steps 2 through 10 for each server that needs to be installed.

14. When all servers are mounted, continue with "Connecting the Avaya 
MAS power cables" on page 2-20.

Installing the Avaya MAS in a stackable desktop configuration

If the system is to be installed in a stackable desktop configuration, you must install 
four rubber spacers on the bottom on each of the servers. This allows you to stack the 
servers on top of one another.

See Figure 2-9 for a sample configuration.

CAUTION: For safety, do not stack more than two servers atop one 
another; use multiple stacks if needed. If you have a UPS 
and an EBM, stack only one server on top of them.

!

Figure 2-9. Installing rubber spacers for a stackable desktop configuration
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To install Avaya MASs in a stackable desktop configuration:

1. Gather the rubber spacers shipped with each server.

2. Attach the rubber spacers to the bottom of each of the servers, one at 
each corner. See Figure 2-9 on page 2-19 for an example.

3. Position the UPS (if present), or the first Avaya MAS (if no UPS is 
present) in an appropriate location. See "Site requirements for an Avaya 
MAS" on page 2-3 for details. 

4. Place the second Avaya MAS (if present) on top of the first one. 

5. If more Avaya MASs are present, create a second stack, placing each 
additional MAS on top of the last one.

Connecting the Avaya MAS power cables

To connect the MAS power cables: 

1. Connect the female end of the MAS power cable to the male power 
connector on the back of the Avaya MAS.

2. Connect the male end of the MAS power cable to AC receptacle on the 
back of the UPS (if present), or to an appropriate AC power outlet. See 
Figure 2-10 for an example. 

3. If you have more than one MAS: repeat steps 1 and 2 for each MAS.

4. If a UPS is present, connect the UPS power cable into an appropriate 
AC power outlet.
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Connecting the Avaya MAS port boards

You are now ready to connect the cables supplied for your port boards to the PBX or 
switch. To do this:

1. See "Connecting the MAS port boards" on page 3-12 and follow the 
instructions for connecting the port board cables.

2. When you have completed that section, return here and continue with 
"Connecting the Ethernet cable" on page 2-22.

Figure 2-10. Attaching power cables to a UPS (sample configuration)
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6 Additional AC sockets; use as needed for additional equipment or MASs



585-310-331, Issue 1

Avaya Modular Messaging for Microsoft Exchange Release 1.1 Installation

2�22 December 2003

Connecting the Ethernet cable

A standard Ethernet cable is shipped with every Avaya MAS. You can use this cable or 
a customer-provided cable to connect the Avaya MAS to the corporate LAN. 

To connect each Avaya MAS to the corporate LAN: 

1. Connect one end of the standard Ethernet cable to the RJ45 connector 
on the back of the server. See Figure 2-11 on page 2-22.  

2. The other end of this cable should be connected to an Ethernet interface 
on the corporate LAN. The entity that is responsible for maintaining the 
corporate LAN should make this connection (see the customer contract 
or the statement of work).

3. Repeat steps 1 and 2 for each Avaya MAS in your configuration.

 

Note: Make sure that you connect the Ethernet cable for the 
corporate LAN to the Ethernet interface on the back of the 
Avaya MAS housing. The Ethernet interface on the NIC in the 
PCI slot is not used in this configuration. 

Figure 2-11. Connecting an MAS to the corporate LAN (rear view)
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Installing the KVM switch (optional)

A keyboard, video, and mouse (KVM) switch may be used to facilitate switching 
between servers in a Modular Messaging installation. See Figure 2-1 on page 2-9 for a 
sample installation.  

The model of KVM switch and the specific monitor, keyboard, and mouse used may 
vary from site to site (for example, a flat-panel monitor setup may be used instead). 
This section describes how to install one specific model. 

To install the Belkin OmniView Pro2 Series KVM switch:

! For rack-mount installations, see Installing the KVM switch in a 
rack-mount configuration. 

! For a stackable desktop configuration, see "Installing the KVM switch in 
a stackable configuration" on page 2-24.

Installing the KVM switch in a rack-mount configuration

To install the Belkin OmniView Pro2 Series KVM switch in a commercial cabinet:

1. Gather the necessary rack-mount hardware, including the adjustable 
mounting brackets and screws. 

2. Select a bracket-hole scheme to determine how far the KVM switch 
should protrude from the rack. 

3. Install the two rack-mount brackets on the KVM switch using the 
provided screws. See Figure 2-12 on page 2-24.

4. Install the KVM switch into the rack above the last installed MAS.

Note: If you are not installing a KVM switch, continue with "Attaching 
ferrites" on page 2-27. 
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5. Continue with "Connecting the KVM cables" on page 2-24. 

Installing the KVM switch in a stackable configuration

To install the Belkin OmniView Pro2 Series KVM switch in a stackable desktop 
configuration: 

1. Place the KVM switch on top of the uppermost MAS. Rubber spacers 
are already in place. 

2. Continue with connecting the KVM cables.

Connecting the KVM cables

The Belkin OmniView Pro2 Series KVM switch must be connected to the keyboard, 
monitor, and mouse, and then to each MAS, as described in this section. 

Connecting the KVM switch to the keyboard, monitor, and mouse

The KVM switch setup for the keyboard, monitor, and mouse may vary from site to site, 
depending on the equipment and cabling used. This section provides instructions for a 
Belkin OmniView Pro2 Series KVM switch setup. 

Figure 2-12. Attaching mounting brackets for a rack-mount KVM

brvykvmm LAO 120502
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To connect the KVM switch to the keyboard, monitor, and mouse:

1. If a new monitor or keyboard/mouse was ordered for this system, 
unpack them now. Otherwise, continue with step 2. 

a. Set up the monitor in the desired location.

b. Connect the keyboard/mouse to the monitor.

c. Plug the female end of the monitor�s power cable into the monitor.

d. Plug the male end of the monitor�s power cable into a free UPS receptacle 
(if available) or into a grounded AC outlet.

2. Connect the VGA cable from the monitor to the female port on the back 
of the KVM switch labeled �Console VGA.� See item 1 in Figure 2-13 on 
page 2-26.

3. Tighten the thumbscrews on the video cable connector with your fingers 
or with a small flatblade screwdriver.

4. Connect the PS/2 cables for the mouse and keyboard to their 
corresponding connectors on the back of the KVM switch in the 
�Console� section using the Y cable. See item 2 in Figure 2-13.

The mouse connector is color-coded green, and the keyboard connector 
is color-coded purple. 

5. Attach the KVM power cable to the DC power jack labeled �DC 12V, 1A� 
on the rear of the KVM switch. 

6. Connect the other end of the KVM power cable (the AC-to-DC 
transformer) to a receptacle on the back of the UPS (if present) or to an 
appropriate power outlet.

When power is connected, the LED for port 01 begins flashing.

7. Push the direct-access port selectors for ports 01 through 08 in order. 
The corresponding LED should flash as each button is pressed, 
indicating that the port is ready for the server connection. 

Note: If a new monitor was not purchased with the system, any 15" or 
greater monitor can be used.
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Connecting the KVM switch to the Avaya MAS 

To connect the KVM switch to any installed Avaya MAS units: 

1. Using the provided KVM cable, plug the male VGA connector into the 
VGA port on the first MAS. See Figure 2-13 on page 2-26.

Figure 2-13. Connecting a Belkin OmniView Pro2 Series KVM switch (rear view)
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1 VGA cord from monitor to Console VGA port on KVM switch

2 Y cable to combination keyboard/mouse (setup may vary)

3 DC power jack for transformer cable

4 KVM switch video/keyboard/mouse cable to each server unit

5 VGA connector on the Avaya MAS (in the AGP slot)

6 Keyboard and mouse connectors on the Avaya MAS 

7 Belkin OmniView Pro2 Series KVM switch. This example shows an Avaya MAS 
connected to the first computer port VGA 01; additional Avaya MASs are connected in 
the subsequent port positions beginning with VGA 02.
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2. Connect the PS/2 keyboard and mouse connectors of the KVM cable to 
the keyboard and mouse ports on the back of the Avaya MAS.  

3. Connect the other end of the KVM cable to the port on the back of the 
KVM switch labeled VGA 01.

4. Connect the ends of the cables to the keyboard and mouse ports located 
directly underneath the VGA 01 port.

5. Repeat steps 1 through 4 for each additional MAS, connecting to port 
VGA 02, VGA 03 and so on, as needed.

Attaching ferrites

Ferrites must be attached to the Avaya MAS video cable and to each T1- or E1-QSIG 
port board cable (if this type of board is present in any MAS) to meet electromagnetic 
conductance (EMC) regulations. The optional flat-panel monitor with an integrated 
KVM switch also requires ferrites. 

To install a ferrite on a cable: 

1. For each Avaya MAS: Locate the video connector in the first slot on the 
back of the Avaya MAS.

2. Open the ferrite by gently pulling the fastener away from the body of the 
ferrite. See Figure 2-14 on page 2-28. 

3. Place the cable cord in the groove inside the ferrite, then gently snap the 
ferrite shut.  

4. Attach a large cable tie directly behind the ferrite to secure it. Trim the 
cable tie. 

5. For MASs that use T1- or E1-QSIG port boards: Repeat steps 2 through 
4 to attach a ferrite to each QSIG port board cable.

6. For systems that use a flat-panel monitor: Repeat steps 2 through 4 to 
attach a ferrite to the mouse and keyboard cables at each server. One 
ferrite can be used for both cables.

Note: The mouse connector is color-coded green, and the keyboard 
connector is color-coded purple.

Note: Place ferrites as close as possible to the chassis to minimize 
the amount of cable between the ferrites and the chassis.

CAUTION: Handle all ferrites with care. They are easily broken. Do not 
use any that are broken or fractured. Damaged ferrites are 
no longer effective for EMC control.

!
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Connecting the USB modem on the MAS

A USB modem is required for every Avaya MAS. The type of modem you have may 
vary depending on your location. See the documentation included with your modem if 
you have questions about modem installation, setup, or operation. 

This section describes a MultiTech USB modem setup. See Figure 2-15 on page 2-29 
for an example.

To connect a USB modem:

1. Attach the rubber spacers to the four marked areas in each corner on 
the bottom of the modem (if spacers are not already in place).

2. Place the USB modem on top of the KVM switch or in a secure location 
as required. 

3. Connect one end of the USB cable to the back of the USB modem.

4. Connect the other end of the USB cable to the back of the Avaya MAS. 
USB port A is recommended as shown in Figure 2-15 on page 2-29. 

5. Connect the RJ-11 cable to the LINE connector on the modem.

Figure 2-14. Attaching a ferrite to a cable
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6. The other end of the cable should be connected to an analog line on the 
corporate switching system. The entity responsible for maintaining the 
corporate switch should make this connection (see the customer 
contract or the statement of work).

7. Repeat steps 1 through 6 for every Avaya MAS modem. 

Figure 2-15. Connecting a USB modem to an Avaya MAS (rear view)
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Powering up an Avaya MAS system

When every Avaya MAS is installed, power up the system as follows:

1. Verify that the power cables for the MASs and all peripheral devices are 
connected to the UPS or an appropriate AC power outlet. See Figure 
2-10 on page 2-21 for an example. Connections include:

! UPS (if present): connected to an appropriate AC power outlet.

! All MAS units: each connected to the UPS (if present), or to an 
appropriate AC power outlet.

! KVM switch and monitor (if present): optionally connected to the UPS 
(if present), or to an appropriate AC power outlet.

! External modems: if a power cord is required, it may be connected to 
the UPS (if present), or to an appropriate AC power outlet.

2. If a UPS is present: Press the On button on the front of the UPS. The 
appropriate lamps should light (see your UPS documentation). 

3. Press the monitor�s power button. The power lamp on the monitor 
should light.

4. If an external modem is present, press the On button if needed. The 
appropriate lamps should light (see your modem documentation). 

5. If a KVM switch is installed, verify that the power lamp is lit.

6. Power up each Avaya MAS as follows: 

a. Toggle the power switch at the rear of the unit to on (| is on, 0 is off). 

b. Press the power button on the front of the unit. The power lamp on the front 
of each server should light. 

c. Wait up to 1 minute for the display to appear on the monitor. 

Note: Always power up the UPS first, if a UPS is installed.

Note: See "Identifying key components of the Avaya MAS" on page 
2-14 to locate the two power switches if needed.

Note: The Windows 2000 Server Setup Wizard automatically runs when 
the unit is powered up (see Chapter 6, �Configuring a new Avaya 
MAS�). However, the steps in Chapter 4, ��Preparing to install 
Modular Messaging software,�� must be completed before you 
install any Modular Messaging software on the Avaya MAS.
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3
Installing MAS port boards

This chapter describes how to install Dialogic port boards and their drivers in a 
customer-provided MAS.   

Note: Before you can successfully complete the tasks in this section, you 
must have read Chapter 1, ��Preinstallation requirements,�� and 
verified that all preinstallation requirements have been met. 

Section Page

Supported MAS port boards 3-2

Installing MAS port boards 3-2

� Preparing for the installation 3-3

� Setting jumpers and switches 3-4

� Installing the port boards 3-8

Installing the Dialogic drivers and software 3-9

� Installing the new Dialogic drivers 3-10

� Applying the Dialogic Feature Pack 3-10

Connecting the MAS port boards 3-12

Completing the hardware installation 3-13
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Supported MAS port boards

Table 3-1 lists the Dialogic port boards that are supported for all new installations. The 
Dialogic documents provide details about installing and connecting the boards and are 
available on the documentation media provided with your Modular Messaging system.  

Installing MAS port boards

Do this procedure on a customer-provided MAS only. 

If you will be installing Modular Messaging software on a customer-provided 
Messaging Application Server (MAS), you must first install the required port boards and 
the appropriate Dialogic drivers and software as described in this section. 

Table 3-1. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic files on documentation CD

Analog 4 - 8

12 - 48

Dialogic 4-port T/R board

Dialogic 12-port T/R board

2

4

D/41JCT-LS (PDF 133K)

D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40
or
8 - 48

Dialogic D/82JCT-U

Dialogic D/82JCT-U-PCI-UNIV

5 - Avaya 
MAS or 
6 - other 
MAS

D/82JCT-U (PDF 240K) 

D/82JCT-U PCI Univ (PDF 234K)

T1-QSIG 23 - 69 Dialogic D/480JCT-2T1 3 DualSpan JCT boards (PDF 104K)

E1-QSIG 30 - 60 Dialogic D/600JCT-2E1 2 DualSpan JCT boards (PDF 104K)

Note: The number of port boards you can install in a customer-provided 
MAS may vary depending on the type of MAS used and the 
number of PCI slots available. These instructions assume that up 
to six PCI slots are available in the MAS, and that board installation 
will begin with the 6th PCI slot. Modify these instructions as 
appropriate for your model of MAS. 

Port boards are not used in an IP H.323 integration. 
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Preparing for the installation

To install Dialogic port boards in a customer-provided MAS:

1. Make sure that this MAS meets the minimum requirements to support 
Modular Messaging software. See the Avaya Modular Messaging 
Concepts and Planning guide (PDF 2 MB) for details. 

2. Print out the appropriate Dialogic PDF file for complete information. See 
Table 3-1 on page 3-2 for a list of the Dialogic documents that cover the 
installation of each type of the board. 

Documents are available on the Modular Messaging documentation CD 
or from the support.avaya.com web site. See "Required documentation" 
on page 1-2 for details about accessing this information. 

3. If the server is already in operation, schedule down time to install the 
new boards.

4. When ready to begin the installation, shut down the system software and 
power off the system. Unplug the AC power cord for safety reasons. 

5. Open the chassis to access the card slots. 

6. Remove the cover for the PCI slot in which you want to install the new 
board. Set the retaining screw aside. 

! If you are installing multiple boards, remove as many card slot covers 
as are needed. 

! Note the maximum number of boards of a certain type that you can 
install in one MAS, as shown in Table 3-1 on page 3-2.

Note: Insert boards starting from the right-most slot if possible. For 
example, if six PCI slots are in the MAS, insert the port boards 
beginning with PCI slot 6. 

CAUTION: Observe proper electrostatic discharge (ESD) precautions 
when you handle computer components. Wear an antistatic 
wrist strap that touches your bare skin and connect the strap 
cable to an earth ground. For detailed ESD instructions, see 
Protecting against ESD damage on the documentation CD.

!

http://support.avaya.com
melectro.htm


585-310-331, Issue 1

Avaya Modular Messaging for Microsoft Exchange Release 1.1 Installation

3�4 December 2003

Setting jumpers and switches

Set the jumpers and switches for board position, bus termination, and other features as 
described in this section. See the Dialogic documentation for details on jumper or 
switch location if needed. 

To set the jumpers and switches on each board:

1. Remove the new port board from its packaging. 

2. Set the jumpers and switches as required for this type of board.

For D/120JCT-LS 12-port analog boards (4 maximum per MAS): 

a. Set the unique board ID for the new card. Turn the SW100 rotary switch, 
located on the top of the card, to set the board ID according to the slot in 
which you are installing it.

Dialogic port boards should be placed in the PCI slots starting from the right 
side of the cabinet (see Figure 2-6 on page 2-15 for an example). For a 
6-PCI slot MAS, the board IDs would be: 

! The card in PCI slot 6 is assigned ID 0. 

! The card in PCI slot 5 is assigned ID 1. 

! The card in PCI slot 4 is assigned ID 2. 

! The card in PCI slot 3 is assigned ID 3. 

b. Set the hook-switch state of the new card to ON so that callers hear a busy 
signal when the card is not initialized. Use the SW1 switch, located at the 
top of the card, to set the hook-switch state. See Figure 3-1.

Figure 3-1. D/120JCT-LS analog board on-hook switch
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For D/41JCT-LS 4-port analog boards (2 maximum per MAS): 

a. Set the unique board ID for the new card. Turn the SW30 rotary switch, 
located on the top of the card, to set the board ID according to the slot in 
which you are installing it.

Dialogic port boards should be placed in the PCI slots starting from the right 
side of the cabinet (see Figure 2-6 on page 2-15 for an example). For a 
6-PCI slot MAS, the board IDs would be: 

! The card in PCI slot 6 is assigned ID 0. 

! The card in PCI slot 5 is assigned ID 1. 

b. Set the hook-switch state of the new card to ON so that callers hear a busy 
signal when the card is not initialized. Use the red SW4 switch, located near 
the top of the card, to set the hook-switch state. See Figure 3-2. 

c. If more than one 4-port board is installed in the system, set up the boards 
for Computer Telephony (CT) bus termination. Use the JP2 jumper to set 
CT bus termination as shown in Table 3-1: 

Figure 3-3 shows the JP2 jumper settings. The setting on the left is 
ON (CT bus is terminated). The setting on the right is OFF. 

Figure 3-2. D/41JCT-LS analog board on-hook switch

jpvysw1 LAO 081803

1 O
N

Table 3-1. D/41JCT-LS analog board CT bus termination settings

Number of cards JP2 jumper CT bus termination

1 OFF bus not terminated 

2 ON pins 1 and 2 terminate bus on both boards

Figure 3-3. D/41JCT-LS analog board CT bus termination settings
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For D/82JCT-U set emulation boards (6 maximum per MAS): 

If more than one card is installed in the system, set up the boards on 
either end of the Computer Telephony (CT) bus for bus termination. Use 
the P8 jumper to set CT bus termination as shown in Table 3-2: 

Figure 3-4 shows the P8 jumper settings. The setting on the left is ON 
(CT bus is terminated). The setting on the right is OFF. 

Table 3-2. D/82JCT-U set emulation board CT bus termination settings

Number of cards P8 jumper CT bus termination

1 OFF bus not terminated 

2 ON pins 1 and 2 terminate bus on both boards

3 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: ON pins 1 and 2 

terminate bus on the end boards 

4 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: ON pins 1 and 2 

terminate bus on the end boards 

5 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: OFF
Card 5: ON pins 1 and 2 

terminate bus on the end boards 

6 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: OFF
Card 5: OFF
Card 6: ON pins 1 and 2 

terminate bus on the end boards 

(A special 6-position CT cable is required 
for this configuration. The 
Avaya-provided H100 cable supports 
only up to 5 DSE boards.) 

Figure 3-4. D/82JCT-U set emulation board CT bus termination settings
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For D/480JCT-2T1 QSIG boards (3 maximum per MAS) 
and D/600JCT-2E1 QSIG boards (2 maximum per MAS): 

a. Set the unique board ID for the new card. Turn the SW100 rotary switch, 
located on the top of the card, to set the board ID according to the slot in 
which you are installing it.

Dialogic port boards should be placed in the PCI slots starting from the right 
side of the cabinet (see Figure 2-6 on page 2-15 for an example). For a 
6-PCI slot MAS, the board IDs would be: 

! The card in PCI slot 6 is assigned ID 0. 

! The card in PCI slot 5 is assigned ID 1. 

! The card in PCI slot 4 is assigned ID 2 (this slot would be used 
only for a D/480JCT-2T1 QSIG board). 

b. If more than one card is installed in the system, set up the boards on either 
end of the Computer Telephony (CT) bus for bus termination. Use the P700 
jumper to set CT bus termination as shown in Table 3-3: 

Figure 3-5 shows the P700 jumper settings. The setting on the left is 
ON (CT bus is terminated). The setting on the right is OFF. 

Table 3-3. D/480JCT-2T1 or D/600JCT-2E1 QSIG board CT bus termination settings

Number of cards P700 jumper CT bus termination

1 OFF bus not terminated 

2 ON pins 3 and 4 terminate bus on both boards

3 Card 1: ON pins 3 and 4
Card 2: OFF
Card 3: ON pins 3 and 4 

terminate bus on the end boards 
(3 cards are present only if the MAS uses 
D/480JCT-2T1 boards) 

Figure 3-5. D/480JCT-2T1 or D/600JCT-2E1 QSIG board CT bus termination settings
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Installing the port boards 

To install the new port board:

1. Slide the card's edge connector into the slot connector and the card's 
slot retainer bracket into the slot guide. Apply pressure to the top of the 
card only, until the edge connector is firmly seated. See Figure 3-6. 

2. Replace and tighten the retaining screw to hold the circuit card in place.

3. Repeat these steps to install any additional port boards.

4. When all boards are in place, attach the Computer Telephony (CT) bus 
cable to connect all the port boards. (This cable is not required if only 
one board is installed.) To attach the bus cable:

a. Position the CT bus cable so that the colored stripe on the ribbon cable 
faces toward the ports at the back of the chassis.

Figure 3-6. Installing a port board in an MAS 

prvycrdr LAO 081103

CAUTION: Make sure that all circuit cards in an MAS are of the same 
type. You cannot mix board types (such as analog tip/ring 
with DSE or T1/E1) within a single MAS.

!
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b. Attach the end connector on the bus cable to the CT bus edge connector at 
the top of the card in the highest numbered slot.

c. Connect the next bus connector to the next port board, and so on.

d. When finished, if the cable has extra connectors or loose ribbon cable, tuck 
the cable down so that it does not snag when you replace the cover.

5. Replace the chassis cover and AC power cord. 

6. Restore power to the system. 

Installing the Dialogic drivers and software

To install the drivers and software required for the new Dialogic port boards:

1. After the system boots, log in to the server using an account that has 
permission to install software (such as the local administrator). 

2. A Found New Hardware wizard appears for every new Dialogic port 
board installed in the system. 

3. Follow the prompts in the wizard to disable the each board for now as 
follows: 

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next.

c. On the Locate Driver Files screen, clear the checkbox for �Specify a 
location� (no boxes will be checked). Click Next.

d. On the Driver Files Search Results screen, make sure that �Disable the 
device� is selected. 

e. Click Finish.

f. Repeat steps a through e for each repetition of the wizard.

Note: Disable the Dialogic hardware for now. It will be activated later 
when you configure the port boards. 
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Installing the new Dialogic drivers

To install the new Dialogic 5.1.1 base release drivers: 

1. Insert the Avaya Modular Messaging Application Software DVD in the 
DVD drive.

For a system that uses CD-ROMs, insert the Intel Dialogic Drivers CD in 
the drive. 

2. Right-click My Computer and select Explore.

3. In Windows Explorer, navigate to the CD or DVD drive (such as D:).

4. Locate the Dialogic files. They are at the root directory of the CD, or 
under a Dialogic Drivers subdirectory of the DVD. 

5. Double-click the file Install_5_11.bat. 

The Intel Dialogic System Software and SDK for Windows System 
Release 5.1.1 for Windows wizard runs. When the installation 
completes, the system automatically reboots. 

Applying the Dialogic Feature Pack

Next, update the new Dialogic drivers with the 5.11 Feature Pack (FP1): 

1. Log back in to the server when the reboot completes. 

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the CD or DVD drive (D:), and locate 
the Dialogic files. 

5. Double-click the file Install_5_11_FP1.bat.

The System Release 5.1.1 Feature Pack 1 wizard launches.

6. On the Welcome screen, click Next.

7. On the License Agreement screen, click Yes.

8. On the Customer Information screen:

CAUTION: Several files have similar names. Verify that you 
are about to select the correct file before clicking it.!
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a. For User Name type Modular Messaging. 

b. Type the appropriate Company Name, then click Next.

9. On the Select Components screen:

a. Verify that the box to install the Program Files is checked.

b. Clear the checkbox to not install the Online Documentation.

c. Click Next.

10. The Start Copying Files screen appears. Click Next. 

This step may take several minutes to complete.

11. When prompted, select Yes, I want to restart my computer now.

12. Click Finish.

The system reboots.

13. Log back in to the server when the reboot completes.

14. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

15. Right-click My Computer and select Explore.

16. In Windows Explorer, navigate to the CD or DVD drive (D:), and locate 
the Dialogic files. 

17. Double-click the file Restore_Config.bat.

The program cleans up any temporary installation files and replaces 
certain files used by the Dialogic boards.

18. Remove the CD or DVD from the drive. 

19. Continue with "Connecting the MAS port boards" on page 3-12 to 
connect the exterior cables.
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Connecting the MAS port boards

Do this procedure on all MASs. 

Connect the new MAS port boards to the switch as described in this section.  

1. Assemble the required cables. 

2. Connect each port on the port boards to the switch (PBX) as required: 

! For analog boards: 

a. Connect each port on the installed analog boards to one end of a standard 
RJ-11 tip/ring cord (individual tip/ring cables and a 12-port harmonica may 
also be used). Note which cables connect to which ports.

b. The other end of the cable should be connected to an analog line on the 
corporate switching system. The entity responsible for maintaining the 
corporate switch should make this connection (see the customer contract or 
the statement of work).

! For set emulation boards: 

a. Connect each port on the Dialogic set emulation board using the D/82U 
cable (Intel part number 86-0155-001). 

b. The other end of the cable should be connected to a 4-wire punch-down 
block on the corporate switching system. The entity responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work). 

! For T1- or E1-QSIG boards: 

a. Connect each port on the Dialogic T1-QSIG or E1-QSIG board using an 
RJ-48C (Ethernet) cable. 

b. Attach a ferrite to this cable. See "Attaching ferrites" on page 2-27. 

c. The other end of the cable should be connected through a patch panel to a 
4-wire punch-down block on the corporate switching system. The entity 

Note: Check the numbering on the board�s faceplate to make sure that 
you are connecting the correct cable to the correct port. 

Note: If the boards are ordered through Avaya or installed in an 
Avaya MAS, the correct cables are provided for each board. 

Note: For an MAS in a rack-mount configuration, you may have to 
slide the server into the cabinet to get enough slack to plug in 
the exterior cables. 
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responsible for maintaining the corporate switch should make this 
connection (see the customer contract or the statement of work). 

3. Complete the hardware installation as appropriate:

! If you were referred to this section from Chapter 2, ��Installing 
Avaya-provided hardware,�� continue with "Connecting the Ethernet 
cable" on page 2-22. 

! If you have a customer-provided MAS, continue with Completing the 
hardware installation. 

Completing the hardware installation

To complete the hardware installation on a customer-provided MAS:

! If you intend to access this MAS remotely using a modem (for 
example, through a services support center), make sure that the 
modem is correctly installed and configured. See the documentation 
included with your modem for information about modem installation, 
setup, and operation. 

! On a customer-provided MAS, if you have DSE or QSIG boards 
installed, you can configure and test the Dialogic port boards now, 
before installing any Modular Messaging software. See Chapter 8, 
��Configuring and testing the port boards,�� for this procedure. 

Note: Dialogic analog boards require a tone file from a directory that 
will not be available until after the Modular Messaging software 
is installed, so they cannot be configured in advance. 
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4
Preparing to install Modular

Messaging software

This chapter describes how to set up Modular Messaging service accounts and 
prepare the directory server to support the Modular Messaging software.  

Note: The steps in this chapter must be done before installing Modular 
Messaging software on the first MAS in the system. 

These steps are performed by the directory server 
administrator or other authorized personnel. 

Section Page

Overview 4-2

Setting up Modular Messaging service accounts 4-3

� Creating the required service accounts 4-3

� Assigning permissions to the service account 4-7

� Adding an MAS account to the Active Directory 4-10

� Creating the voice mail domain container manually if required 4-11

Setting up the MAS for remote access 4-12

Updating the Active Directory and data schema 4-13

� Logging in and preparing to update 4-13

� Launching the Modular Messaging installation wizard 4-14

� Updating the Active Directory 4-15
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Overview

This chapter covers the following system preparation steps:

1. For all installations, you must create Modular Messaging service 
accounts on the directory server and add the correct permissions.

2. If you are running Windows 2000 or 2003 with Active Directory, you must 
update the data schema before you install any Modular Messaging 
software on any Messaging Application Server (MAS) in the domain. 

To successfully install the Modular Messaging software, you need:

! A completed copy of the relevant planning forms listed in Appendix A, 
��System planning forms,�� including: 

� The Modular Messaging MAS planning form on page A-6 showing the 
NetBIOS name of each MAS, the default (or primary) peer Exchange 
server, the directory server, and the Windows domain.

� The Modular Messaging logon accounts form on page A-9 showing 
the customer-specified Modular Messaging service account names 
and passwords. 

! Access to the Avaya Modular Messaging Application Software DVD or 
CD-ROM set. 

Note: This procedure can be done only on a machine that is running 
the Windows 2000 or 2003 Server operating system. These 
components cannot be installed on a workstation OS. 

CAUTION: All servers must meet the requirements listed in the Avaya 
Modular Messaging Concepts and Planning guide (PDF 2 
MB). This guide is available on the documentation media 
shipped with your system. Review this document to make 
sure that your Exchange servers, directory servers, MASs, 
and client machines are all ready to support Modular 
Messaging software.

!
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Setting up Modular Messaging service accounts

Create two new accounts on the directory server and assign them sufficient privileges 
for installing, administering, and accessing the Modular Messaging software. 

Creating the required service accounts

Two Modular Messaging service accounts must be created as a Windows domain user 
account on the directory server. If needed, use your regular Microsoft Windows 
documentation to help you create a new account.

Creating new accounts on Exchange 2000/2003 systems

On a Windows 2000 or 2003 system, you could create the Modular Messaging service 
accounts as follows: 

1. Log in to the Active Directory server using an account that has privileges 
to create new user accounts (such as administrator).

2. Click Start > Programs > Administrative Tools > Active Directory Users 
and Computers.

3. In the Active Directory Users and Computers window, expand the 
directory for the Windows domain you intend to use for Modular 
Messaging. This is item 2 on the Modular Messaging MAS planning form 
on page A-6. 

Creating a group for the Modular Messaging account

4. Create a new group that will give the Modular Messaging service 
account the appropriate permissions. For example, in the left-hand 
pane, right-click Users > New > Group. 

5. In the New Object - Group window, create a new group as follows:

a. Choose an appropriate name (such as MM Service Permissions). 

b. Select the group scope appropriate for your site.

c. Select group type Security. Click Next.

d. On the following screen, do not create a mailbox. Click Next.

e. Click Finish. 

Note: If you do not create the Modular Messaging accounts using the 
procedure in this section (for example, if the service account does 
not have sufficient privileges), see ��Creating the voice mail domain 
container manually if required�� on page 4-11. 
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6. In the right-hand pane, locate the new group�s name (such as MM 
Service Permissions) and double-click it.

7. In the Properties window, click the Member Of tab. 

8. In the Select Group window, add the following groups to assign the 
necessary permissions. Double-click each group to add it to the 
permissions list. 

! Account Operators - required for each domain that will contain user 
accounts to be enabled for Modular Messaging. 

! Administrators - required for the domain that contains the Global 
Catalog servers that will be used as peer directory servers for 
Modular Messaging. 

Creating the Modular Messaging account

9. Create a new account for installing and administering the Modular 
Messaging software. For example, in the left-hand pane, right-click 
Users > New > User. 

10. In the New Object - User window, create a new Modular Messaging 
service account using a secure logon name. For example:

a. First name: MM

b. Last name: Account

c. User logon name: customer-provided (such as mmacct). See item A7 on 
the Modular Messaging logon accounts form on page A-9.

d. Click Next.

e. Enter and confirm the password. See item A7 on the Modular Messaging 
logon accounts form on page A-9. 

f. You must check the box for �Password never expires�. 

g. Set up other parameters required at this site if needed. 

h. Click Next. 

Note: Passwords for Modular Messaging accounts should be at least 
8 characters long. See the logon form for details. 

Note: If you need to change the password for a Modular Messaging 
service account, contact the software-provider for the 
password-changing procedure. 
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i. On the third page, clear the checkbox for �Create an Exchange mailbox.� 

j. Click Next. 

k. When the summary appears, click Finish. 

l. In the right-hand pane, locate the new account (such as mmacct) and 
double-click it.

m. In the Properties window, click the Member Of tab. 

n. In the Select Group window, double-click the Modular Messaging group 
from step 5 (such as MM Service Permissions) to add it to this account.

o. Click OK to close this window. 

You will assign permissions to the Modular Messaging service account 
in ��Assigning permissions to the service account�� on page 4-7. 

Creating the Services remote access account

11. Create a new account to allow remote Services support personnel to 
access and administer the Modular Messaging system. For example, in 
the left-hand pane, right-click Users > New > User. 

12. In the New Object - User window, create a new Modular Messaging 
remote access account using a secure logon name. For example:

a. First name: Services 

b. Last name: Account

c. User logon name: customer-provided (such as craft). See item A8 on the 
Modular Messaging logon accounts form on page A-9.

d. Click Next.

e. Enter and confirm the password. See item A8 on the Modular Messaging 
logon accounts form on page A-9.

f. You must check the box for �Password never expires�. 

g. Set up other parameters required at this site if needed. 

h. Click Next. 

i. On the third page, clear the checkbox for �Create an Exchange mailbox.� 

j. Click Next. 

Note: You do not need to create an Exchange mailbox for a Modular 
Messaging service account. 

Note: If you change the password for the remote access account, be 
sure to notify the appropriate Services support entity. 
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k. When the summary appears, click Finish. 

13. In the right-hand pane, double-click the new account�s name (such as 
craft). 

14. In the Properties window, click the Member Of tab. 

15. Verify that the Domain Users entry is present. Click OK to close this 
window. 

a. If the Domain Users entry is missing, right-click the account�s name and 
select Add members to a group. 

b. Double-click the Domain Users group to add it to the permissions list. 

Creating a test subscriber account

16. Create a new account that will be used for acceptance testing. For 
example, in the left-hand pane, right-click Users > New > User. 

17. In the New Object - User window, create a new account, such as:

a. First name: Test

b. Last name: Subscriber

c. User logon name: customer-provided (such as testsub1). See Required 
switch and messaging information on page A-11.

d. Click Next.

e. Enter and confirm the account�s password (customer-provided). 

f. Set up other parameters as required for this site. 

g. Click Next. 

h. On the third page, check the box to �Create an Exchange mailbox.� 

i. Select the server (Exchange organization) and mailbox store (Exchange 
server) as required.

j. Click Next. 

k. When the summary appears, click Finish. 

A new account is created in the right-hand pane. 

18. When finished, close the Active Directory window.

Note: The extension for the test subscriber must be administered 
on the PBX by the appropriate party. 
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Creating new accounts on Exchange 5.5 systems

Use the tool appropriate for your Exchange 5.5 system to create the two required 
Modular Messaging accounts. For example, for a Windows NT 4.0 domain, you would 
create a new account using the User Manager for Domains application. On a Windows 
2000 or 2003 system, you would use Active Directory. 

1. Log in to the appropriate administration tool using an account that has 
sufficient privileges to create new accounts. 

2. Create the Modular Messaging service account. See ��Creating the 
Modular Messaging account�� on page 4-4 for a sample procedure.

3. Create the remote access account for Services support. See ��Creating 
the Services remote access account�� on page 4-5 for a sample 
procedure.

Assigning permissions to the service account

Sufficient permissions must be assigned to the Modular Messaging service account for 
it to function as required. This procedure varies depending on whether the environment 
uses Exchange 2000/2003, Exchange 5.5, or a mixture of systems. 

For details on permission requirements, see Appendix D, ��Administrator�s reference.��

Assigning Exchange 2000/2003 permissions

Use the steps in this section to assign permissions to the Modular Messaging service 
account for an Exchange 2000 or Exchange 2003 server. You do this through the group 
you created in ��Creating a group for the Modular Messaging account�� on page 4-3. The 
group must be able to access the subscriber mailboxes, but before this can be done a 
registry change is required. 

By default, the Security tab for the Exchange organization container and some of the 
key sub containers are not visible using Exchange System Manager or Active Directory 
Sites and Services. The following registry change enables the Security tab at all levels 
within the Microsoft Exchange container. 

To update the registry:

1. Log in as the Microsoft Exchange administrator.

2. Click Start > Run.

3. In the Run box Open field, type regedit and press Enter.

Note: If Avaya Modular Messaging mailboxes are hosted on a mixture of 
Exchange 5.5 and Exchange 2000 or 2003 servers, then you must 
set up sufficient rights on all systems as directed in this section.
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4. In the Registry Editor window, locate the following key: 

HKEY_CURRENT_USER\Software\Microsoft\Exchange\ExAdmin

5. Right-click ExAdmin and select New > DWORD Value. 

6. Enter the following value name: ShowSecurityPage

7. Double-click the ShowSecurityPage value.

8. On the Edit DWORD Value screen, set the Value data to 1. 

9. Click OK. 

10. Close the Registry Editor window. 

Use Active Directory Sites and Services to add the required permissions. The 
permissions listed below are the absolute minimum required for the Modular 
Messaging software to function. For convenience, all the properties should be created 
at the Exchange Organization level. You may choose to apply them at a level lower 
down the tree if required, but this may impact on your ability to manage Modular 
Messaging using Exchange System Manager. 

To assign permissions to the Modular Messaging service account:

1. Log in to the Active Directory server using an account that has privileges 
to assign permissions to accounts (such as administrator).

2. Click Start > Programs > Administrative Tools > Active Directory Sites 
and Services.

3. In the left-hand pane, select Active Directory Sites and Services.

4. From the View menu, select Show Services Node (the menu item 
should be checked). 

5. In the left-hand pane, expand Services, expand Microsoft Exchange, 
and then locate the appropriate Exchange Organization object that 
Modular Messaging will connect to. Right-click it and select Properties. 

6. In the Properties window, click the Security tab. (This tab is only visible 
if you edited the registry as directed above.)

7. Click Add and locate the new group (such as MM Service Permissions). 
Add it so it appears in the Properties window. Click OK. 

8. Under Permissions for the group, Allow only the following permissions. 
Clear any checkboxes that don�t apply. For details on these permission 
requirements, see Appendix D, ��Administrator�s reference.�� 

! Read

! Execute
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! Read Permissions

! Create Children

! List Contents

! Read Properties

! Write Properties

! Administer Information Store

! Create Named Properties in IS

! View Information Store Status

! Receive As

! Send As

9. Click Apply to verify your settings. When done, click OK. 

10. After you change these permissions, you should stop and restart all 
Exchange services to flush the directory cache (or else wait 10 minutes 
for it to expire). If you have multiple domain controllers in the forest, it 
may also be necessary to wait for directory replication to complete.

Assigning Exchange 5.5 permissions

You must add the Modular Messaging service account to the ACL (permissions list) in 
your Exchange organization in the Site and Configuration containers as described. 

To assign permissions to the Modular Messaging service account for an Exchange 5.5 
server:

1. Run Exchange 5.5 Administrator. 

2. Select the Exchange Site container for the subscriber mailboxes to be 
enabled for Avaya Modular Messaging.

a. From the File menu, select Properties > Permissions.

The Exchange Site security settings are displayed.

b. Click Add.

c. Select the Modular Messaging service account, such as MM Account 
(mmacct), and click OK.

d. Select the Modular Messaging service account in the permissions list.

e. Change the role for the account to Service Account Admin and click OK.
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This right enables Avaya Modular Messaging to access the information 
store of subscribers and to create directory entries in the Exchange 5.5 
directory. 

3. Select the Configuration container in the Exchange site that contains 
the subscriber mailboxes.

a. From the File menu, select Properties > Permissions.

b. Click Add.

c. Select the Modular Messaging service account, such as MM Account 
(mmacct), and click OK.

d. Select the Modular Messaging service account in the permissions list.

e. Change the role for the account to Service Account Admin and click OK. 

Adding an MAS account to the Active Directory

The domain administrator should pre-create computer accounts for each MAS and 
define the Modular Messaging service account as a user that has permission to join the 
Windows domain. This procedure facilitates remote access setup (see ��Setting up the 
MAS for remote access�� on page 4-12) and Modular Messaging software installation 
(see ��Completing the initial setup�� on page 6-9 and ��Joining the Windows domain�� on 
page 7-5). 

To add a new computer account to the Active Directory:

1. Log in to the Active Directory server using an account that has privileges 
to add a computer account to a domain (such as Administrator).

2. Click Start > Administrative Tools > Active Directory Users and 
Computers to create a new computer account.

3. In the Active Directory Users and Computers window, expand the 
directory for the Windows domain you will use for Modular Messaging.

4. Right-click Computers, then select New > Computer. 

5. On the New Object - Computer screen, type the computer name for the 
MAS (such as zippy). See item 1 on the Modular Messaging MAS 
planning form on page A-6.

6. Click Change to specify that a different user or group that can add this 
computer to the domain. 

Note: If you are using a mixture of Exchange 5.5 and Exchange 2000 or 
2003 servers in a single voice mail domain, you must configure a 
Windows 2000 service called Active Directory Connector after the 
Modular Messaging software is installed. See ��Configuring Active 
Directory Connector if required�� on page 9-13.
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7. On the Select User or Group screen, double-click the Modular 
Messaging service account (such as mmacct). Click OK. 

8. If more than one MAS is to be installed, repeat steps 4 through 6 until all 
MASs are added. 

9. When finished, close this window. 

Creating the voice mail domain container manually if required

Do the task in this section only if you did not create the Modular Messaging service 
account using the procedure in ��Creating the required service accounts�� on page 4-3. 

If you don�t assign the permissions we recommend to the Modular Messaging service 
account for security reasons, you can create the voice mail domain container for the 
Modular Messaging service account manually and assign it appropriate security 
settings. Use this procedure if the Modular Messaging service account does not have 
sufficient privileges to create container objects at the voice mail domain base location. 

To use this procedure, you must install ADSIEdit. ADSIEdit is a Microsoft Management 
Console (MMC) snap-in available as part of Microsoft Windows 2000 or 2003 Server 
and Microsoft Windows Advanced 2000 or 2003 Server Support Tools. 

To assign security settings to the voice mail domain container:

1. Run the ADSIEdit Windows support tool.

2. Connect to the Domain NC of the domain containing the Modular 
Messaging service account.

3. Locate the base location for the voice mail domain container. 

4. From the Action menu, select New > Object > Container.

5. Give the container the name �Octel� and click Next. 

6. Display the properties for the new container.

7. Ensure that the Account Operators Group has been assigned Full 
Control in the security settings for the new container.

Note: If you have not selected a custom location, by default the voice 
mail domain container is the root container of the Microsoft 
Windows 2000 or 2003 domain. 

Note: The name of the container is case-sensitive. 
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Setting up the MAS for remote access

Remote access allows Services support personnel to dial into a system to correct 
problems and perform routine maintenance. Unless other arrangements have been 
made, use the following procedure to allow the MAS to support remote access calls. 

1. Log in to the Windows domain administrator account. 

2. Access the Active Directory by clicking Start > Programs > Active 
Directory Users and Computers.

3. In the Active Directory window:

a. Expand the directory for the domain that will be used for Modular 
Messaging (such as zodiac.com).

b. Click Users.

4. In the right-hand pane of the window, double-click RAS and IAS 
Servers to bring up the properties window.

5. In the RAS and IAS Servers Properties window:

a. Click the Members tab.

b. Click Add.

c. In the Select Users, Contacts, Computers or Groups window, locate the first 
MAS (such as ZIPPY); it will have a blue terminal icon beside it. 
Double-click it.

d. Verify that the correct computer name appears underlined in the list box.

e. Repeat steps c and d to add all MASs to this list. See the Modular 
Messaging MAS planning form on page A-6. 

f. Click OK to close this window.

g. Click OK again to close the RAS and IAS Servers Properties window.

6. In the right-hand pane, double-click Services Account to bring up the 
properties window.

7. In the Services Account Properties window:

a. Click the Dial-in tab.

b. Under Remote Access Permission (Dial-in or VPN), click the radio button to 
select Allow access.

c. CallBack Options should be left at No Callback.

d. Click OK. 

8. Close the Active Directory window. 
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Updating the Active Directory and data schema

Do this task only once per Windows domain, on the directory server domain controller, 
before installing the Modular Messaging software on any MAS. 

The Active Directory must be updated as described in this section. 

If you are running Windows 2000 or 2003 with Active Directory, the data schema must 
be updated before you install any Modular Messaging software on any Messaging 
Application Server (MAS) in the domain. The schema defines the objects and 
properties stored in Active Directory, and contains definitions of object attributes. The 
schema is updated only once in the forest. 

For details about the changes made to the schema for a Modular Messaging software 
update, see Appendix D, ��Administrator�s reference.�� 
 

Logging in and preparing to update

To update the Active Directory for Modular Messaging:

1. Log on to the directory server using an account that has permission to 
do Active Directory and data schema administration. 

! This account is usually the Windows domain administrator account. 
For an Exchange 2000/2003 system, this account requires both 
Domain Admin and Schema Admin rights.

! If you are updating the messaging software in a child domain, the 
account must have Domain Admin rights for both the parent domain 
and the child domain. If the Active Directory update is executed from 
the child domain controller, enter the account name in the format: 
Parent Domain\Domain Admin.

Note: This procedure can be done only on a machine that is running 
the Windows 2000 or 2003 Server operating system. These 
components cannot be installed on a workstation OS. 

Note: On an Exchange 5.5 system, the schema does not need to be 
updated unless you are using Octel Analog Networking. However, 
other directory server updates must be made as described in this 
section. 

CAUTION: If you do not update the schema first when required, the 
Modular Messaging software will not install correctly. It will 
have to be completely removed and then reinstalled 
following the Active Directory schema update. 

!
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! If you are using Octel Analog Networking, this procedure must be 
performed on the domain controller that is acting as the schema 
master. 

2. Close applications or stop services as follows:

! Close the Active Directory Users and Computers application or the 
Microsoft Exchange Administrator application, depending on the 
application that is installed to support your version of Exchange. 

! Close any open windows for other applications. 

! Stop any service monitoring tools that are running, such as anti-virus 
software. 

Launching the Modular Messaging installation wizard

When all preparations are done, launch the Modular Messaging Installation Wizard as 
follows: 

1. Insert the Avaya Modular Messaging Application Software DVD in the 
DVD drive.

For a system that uses CD-ROMs, insert the Avaya Modular Messaging 
Application Software and Languages CD in the drive.

2. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the CD or DVD drive (such as D:).

b. Navigate to the Install directory.

c. Double-click the file Setup.exe.

The Modular Messaging - Installation Wizard launches and searches for 
packages relevant to this configuration.

3. On the main screen, verify that the Configuration drop-down box shows 
Microsoft Exchange. 

4. Click the Read Me button to review the Readme file for recent notices.

5. To change the default installation path (optional): 

a. Click the Change button.

b. Browse to an existing destination directory, or create a new destination 
directory as follows:

! If you are using Microsoft Windows 2000 or 2003, use the New 
Folder button to create a new directory for the installation.
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! If you are using NT4, use Windows Explorer to create a new 
directory for the installation, then select this directory. 

Updating the Active Directory

To update the Active Directory and data schema (if required) on this machine: 

1. Click the + sign to expand the Active Directory Updates folder. 

2. Check the following boxes to install the appropriate software 
components to support Modular Messaging:

! Enable Modular Messaging: Check this box to allow Modular 
Messaging to store subscriber configuration information and support 
the correct operation of and access to client applications. 

! Enable Octel Analog Networking: If Octel Analog Networking is used 
at this site, check this box to add the appropriate classes and 
attributes to the schema. 

! Enable User Administration: Check this box to allow administrators to 
enable users, groups, or contacts to use Modular Messaging under 
Microsoft Exchange administration. 

3. When all required components are selected, click Install.

4. You may see a prompt requiring you to supply the name and password 
of an account that has sufficient permissions to update the Active 
Directory. Supply the required information and click OK. 

5. When all components finish installing, click Close.

6. Continue with Chapter 5, ��Updating the Exchange extensions.��

Note: You cannot define different installation paths for individual 
components. 

Note: Do this task only once per Windows domain. 

Note: Although Octel Analog Networking is an optional feature, you 
may choose to install it at this time in case Octel Analog 
Networking is ever added to the system. The other software 
components are always required. 
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5
Updating the Exchange extensions

This chapter describes how to install the Microsoft Exchange extensions that support 
Modular Messaging software. 

Do this task on any machine that you will use for administering subscribers (such as the 
Exchange server, an MAS, or a client machine). You can do this task multiple times per 
network.   

Note: Before you can do the tasks in this section, you must have 
successfully completed the tasks in Chapter 4, ��Preparing to install 
Modular Messaging software.�� 

Although this procedure creates a Modular Messaging tab in 
the Active Directory, the page will not be functional until after 
the Modular Messaging system is installed and operational. 

Section Page

Overview 5-2

Updating the Exchange extensions 5-4

� Logging in and preparing to update 5-4

� Launching the Modular Messaging installation wizard 5-5

� Updating the Exchange extensions 5-6
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Overview

This task assumes that you have already created a Modular Messaging service 
account and updated the directory server as described in Chapter 4, ��Preparing to 
install Modular Messaging software.�� 

To successfully install the Modular Messaging software, you need: 

! Access to the Avaya Modular Messaging Application Software DVD or 
CD-ROM set.

! Downtime scheduled for the Microsoft Exchange server if you need to 
install the following Modular Messaging software components on it: 

� An Exchange 5.5 server always requires the Subscriber 
Administration tools to be installed on it. Therefore an Exchange 
server reboot is always required for an Exchange 5.5 system. 

If Octel Analog Networking is used at this site, then the Octel Analog 
Networking Administration component must also be installed on the 
Exchange 5.5 server. 

� An Exchange 2000 or 2003 server does not require the Subscriber 
Administration tools or Octel Analog Networking Administration 
component to be installed on it. If you do choose to install them, then 
the Exchange server does need to be restarted (see following note). 

Note: You can install the Subscriber Administration tools on any machine 
that has the Microsoft Windows 2000 or 2003 Administration Tools 
installed. The Subscriber Administration Tool adds a tab to the 
Active Directory Users and Computers property page which is used 
for Modular Messaging subscriber administration. This machine 
will need a restart. 

If Octel Analog Networking is used at this site, you can install the 
Octel Analog Networking Administration component on any 
machine where the Microsoft Exchange System Management 
Tools and required service pack are installed. See ��Installing 
required software�� on page 6-12 for details. 

CAUTION: If the directory server has not been updated as described in 
Chapter 4, ��Preparing to install Modular Messaging 
software,�� do not proceed with the steps in this chapter. The 
Modular Messaging software will not install correctly, and will 
have to be completely removed and reinstalled after the 
Active Directory updates have been made. 

!
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Note: In the Exchange 5.5 Voice Mail User Administration Extension, the 
personal operator schedule, Caller Applications, and the Voice 
Control do not display if the Exchange and Modular Messaging 
software are installed on different machines. To fix this problem, 
install the Modular Messaging administration or diagnostic tools on 
every machine from which you plan to run the Voice Mail User 
Administration Extension. This procedure is covered in ��Installing 
the Modular Messaging software�� on page 7-11. 

CAUTION: All servers must meet the requirements listed in the Avaya 
Modular Messaging Concepts and Planning guide (PDF 2 
MB). This guide is available on the documentation media 
shipped with your system. Review this document to make 
sure that your Exchange servers, directory servers, MASs, 
and client machines are all ready to support Modular 
Messaging software.

!
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Updating the Exchange extensions

Do this task on any machine that you will use for administering subscribers (such as 
the Exchange server, an MAS, or a client machine). You can do this task multiple times 
per network. 

You must update the Microsoft Exchange extensions to support Modular Messaging 
software as described in this section.  

Logging in and preparing to update

To update the Microsoft Exchange extensions for Modular Messaging:

1. Log in to the Exchange server using an account that has permission to 
do Active Directory and data schema administration. 

2. Close applications or stop services as follows:

! Close any open Exchange applications including the Microsoft 
Exchange System Management Tools. 

! Close the Active Directory Users and Computers application or the 
Microsoft Exchange Administrator application, depending on what is 
installed to support your version of Exchange. 

! Close any open windows for other applications. 

! Stop any service monitoring tools that are running, such as anti-virus 
software. 

3. On Exchange 5.5 systems, you must set the Auto Naming options as 
follows: 

a. Using Microsoft Exchange Administrator, open the Recipients container.

b. From the Tools menu, select Options.

Note: Read the conditions for installing Modular Messaging software 
components in ��Overview�� on page 5-2. Exchange 5.5 servers 
always require these tools to be installed and must be restarted. 

Although this procedure creates a Modular Messaging tab in 
the Active Directory, the page will not be functional until after 
the Modular Messaging system is installed and operational. 

Note: At some sites, the same server may be running both Active 
Directory and the Exchange software. However, all Exchange 
and Active Directory windows must be closed prior to installing 
the Exchange extensions software 
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c. On the Auto Naming tab, under �Alias Name Generation� and �Display 
Name Generation,� select any options except �None.�

d. Click OK. 

e. Close the Microsoft Exchange Administrator.

Launching the Modular Messaging installation wizard

When all preparations are done, launch the Modular Messaging Installation Wizard as 
follows: 

1. Insert the application software disk in the MAS drive. This is either:

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD.

2. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the CD or DVD drive (such as D:).

b. Navigate to the Install directory.

c. Double-click the file Setup.exe.

The Modular Messaging - Installation Wizard launches and searches for 
packages relevant to this configuration.

3. On the main screen, verify that the Configuration drop-down box shows 
Microsoft Exchange. 

4. Click the Read Me button to review the Readme file for recent notices.

5. To change the default installation path (optional): 

a. Click the Change button.

b. Browse to an existing destination directory, or create a new destination 
directory as follows:

! If you are using Microsoft Windows 2000 or 2003, use the New 
Folder button to create a new directory for the installation.

! If you are using NT4, use Windows Explorer to create a new 
directory for the installation, then select this directory. 

Note: You cannot define different installation paths for individual 
components. 
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Updating the Exchange extensions

To update the Exchange extensions tools on this machine: 

1. Click the + sign to expand the appropriate Exchange extensions folder 
for the version of Exchange that is installed:

! Active Directory / Exchange 2000 extensions (also used for 
Exchange 2003 systems) 

! Exchange 5.5 extensions 

2. Check the boxes to install the appropriate Modular Messaging software 
components for Microsoft Exchange systems on this server:

! Octel Analog Networking Administration: If Octel Analog Networking 
is used at this site, check this box to allow administrators to 
administer an Octel Analog Networking gateway. This allows Modular 
Messaging subscribers to exchange voice messages with any other 
Octel Analog Networking-enabled voice mail system. 

! Subscriber Administration: Check this box to add a Modular 
Messaging property page in Active Directory Users and Computers 
for each user that is assigned a mailbox. This tool allows 
administrators to set up and administer Modular Messaging 
accounts, configure subscriber properties, and launch the Subscriber 
Options package. 

3. When all required components are selected, click Install.

4. When all components finish installing, click Close.

5. If you are prompted to restart the system, click Restart to complete the 
software installation. 

Note: You must install the Subscriber Administration tools, and the 
Octel Analog Networking Administration component if it is used 
at this site, on an Exchange 5.5 server. Installing either of these 
Modular Messaging software components requires the 
machine to be restarted. 

Note: A Restart prompt indicates that the software installation is not 
complete. Do not configure any Modular Messaging settings or 
services until you have restarted the machine. 
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6
Configuring a new Avaya MAS

This chapter is relevant only to an Avaya-provided Messaging Application Server 
(Avaya MAS) installation. It describes how to complete the Windows 2000 Server 
Setup Wizard and initial configuration on the Avaya MAS. The setup wizard runs 
automatically after a new Avaya MAS is powered up (see "Powering up an Avaya MAS 
system" on page 2-30).   

Note: Before you can do the tasks in this section, an appropriate 
administrator must have successfully completed the tasks in 
Chapter 4, ��Preparing to install Modular Messaging software.�� 

If you are using a customer-provided MAS, continue with Chapter 
7, ��Installing and configuring the Modular Messaging software.��

Section Page

Overview 6-2

� Switching the monitor to show the correct server 6-2

� Starting up the system 6-2

Setting up the Windows system 6-4

� Running the setup wizard 6-4

� Assigning IP addresses to this MAS 6-6

� Completing the initial setup 6-9

Testing IP addresses using ping 6-11

Installing required software 6-12

� Installing anti-virus software and Windows updates 6-12

� Installing required Exchange software 6-13

Configuring Modular Messaging components 6-15
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Overview

You need to configure every new Avaya Messaging Application Server (Avaya MAS) 
for local operating settings and to work correctly on the corporate local area network 
(LAN) as described in this section. 

To successfully set up an Avaya MAS, you need:

! A completed copy of all the forms in Appendix A, ��System planning 
forms,�� including the Modular Messaging MAS planning form on page 
A-6 and the Modular Messaging logon accounts form on page A-9.

! All required hardware installed as described in Chapter 2, ��Installing 
Avaya-provided hardware.��

! A printout of the Avaya MAS installation checklist (see New Modular 
Messaging installation on an Avaya MAS on page B-5). Check off steps 
as you complete them to track your progress.

Switching the monitor to show the correct server

Use whatever method is required at your site to have the monitor display the Avaya 
MAS that you are administering. 

For a Belkin OmniView Pro2 KVM: the KVM switch is normally connected to the first 
Avaya MAS (MAS#1) through the first computer port (VGA 01). Subsequent MASs (if 
present) are connected to computer ports VGA02, VGA03, and so on. 

To switch the monitor to show the server that you need to administer:

1. Press slowly in sequence Scroll Lock, then Scroll Lock, then the up (or 
down) arrow key to change to the server connected to a higher or lower 
port number. 

You can alternatively type the port number instead of pressing the up or 
down arrow key (such as 02 for port 2). See your KVM switch 
documentation for complete user instructions.

2. If you cannot access the correct server, see "Connecting the KVM 
cables" on page 2-24 and verify the cable connections. To correct 
cabling problems, power down the system, correct the cabling, then 
power up the system again.

CAUTION: Use your completed planning forms from Appendix A, 
��System planning forms,�� to enter the correct values. You 
cannot use these examples or guess at the values. If you do, 
the current operation of the customer LAN may be damaged.

!
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Starting up the system

The Avaya MAS begins to boot after power up. 

1. If the Avaya MAS is not already on, power up the unit now (push the 
power button on the front panel). 

See "Powering up an Avaya MAS system" on page 2-30 for details if 
needed. 

2. Optional: When the system begins to boot, you can:

a. Press Esc when the splash screen appears.

b. Press the space bar to skip the memory check. 

Note: If an updated version of the Modular Messaging software is 
required, it must be copied to the hard disk on each new Avaya 
MAS server before administration can begin. To reload the 
operating system, continue with Appendix E, ��Reloading 
software on an Avaya MAS.��
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Setting up the Windows system

After the Avaya MAS boots, a setup wizard guides you through the Windows system 
configuration process. Complete all steps as directed. 

Running the setup wizard

To complete the setup wizard:

1. On the Welcome to the Windows 2000 Server Setup Wizard screen, 
click Next. (If you wait, the wizard automatically shows the next screen.) 

2. On the License Agreement screen, review the text. 

! If you agree to the terms, choose I accept this agreement. 

! If you decline the terms, you cannot proceed with the installation.

! Click Next.

3. On the Regional Settings screen: 

a. Check if the settings are correct. 

b. To change system and user locales, click the first Customize button. 

c. In the Regional Options window, on the General tab:

(1) Select your locale from the drop-down list.

(2) Update your language settings if needed. Click Apply. 

(3) Click the other tabs in order, and verify that your Numbers, 
Currency, Time, and Date settings are correct for this system. 
The defaults should reflect the locale you selected.

(4) Click the Input Locales tab. Verify your locale and keyboard 
settings. 

(5) When finished, click OK to close the Regional Options window.

d. Click Next.

4. On the Personalize Your Software screen, enter the customer name and 
organization in the appropriate fields. See item 16 on your Modular 
Messaging MAS planning form on page A-6. Click Next. 
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5. On the Your Product Key screen:

a. Type the Windows product key for this MAS (each unit has a unique product 
key). 

b. Click Next.

6. On the Licensing Modes screen:

a. Select Per Server if needed.

b. For �Number of concurrent connections,� type 50.

c. Click Next.

7. On the Computer Name and Administrator Password screen:

a. Change the �Computer name� to the required host name (NetBIOS name) 
for this MAS (such as zippy). See item 1 on your Modular Messaging MAS 
planning form on page A-6. (The name is forced to upper-case.)

b. Enter and confirm the new password for the administrator account for this 
machine (case is important). See items A1 to A6 on the Modular Messaging 
logon accounts form on page A-9.

c. Click Next. 

8. On the Modem Dialing Information screen: 

a. Select your country or region.

b. Enter the area code or city code.

c. If needed, enter the prefix required to access an outside line (such as 9).

d. Select the type of dialing used (typically Tone dialing).

e. Click Next. 

9. On the Date and Time Settings screen: 

a. Set the Date and Time settings. 

b. Set the Time Zone and daylight savings values as needed.

c. Verify your settings, then click Next. 

The system pauses to update its settings.

Note: This number must be entered exactly as shown. It is located on 
a sticker or tag on the side or rear of each MAS unit.

Note: This screen appears only if a modem is connected. See 
"Connecting the USB modem on the MAS" on page 2-28. 
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10. On the Network Settings screen, when prompted:

a. Select Custom settings.

b. Click Next.

Assigning IP addresses to this MAS

Use your completed Modular Messaging MAS planning form on page A-6 to assign IP 
addresses and other TCP/IP properties for the corporate LAN interface that this MAS 
will use. 

On the Networking Components screen for device Intel(R) PRO/100 VE Network 
Connection, specify the IP addresses for the corporate LAN for this MAS as follows:

1. In the components box, select Internet Protocol (TCP/IP).

2. Click Properties.

The Internet Protocol (TCP/IP) Properties window appears. See Figure 
6-1 on page 6-7 for an example. 

3. In the Internet Protocol (TCP/IP) Properties window:

a. Click the �Use the following IP address� radio button.

b. Change the IP address, Subnet mask, and Default gateway to the corporate 
LAN values for this MAS listed in the Modular Messaging MAS planning 
form on page A-6 (items 8, 9, and 10). 

c. Click �Use the following DNS server addresses.� Specify the corporate DNS 
IP addresses as follows:

(1) For the Preferred DNS server, enter the first Corporate DNS 
server IP address from your planning form (item 11, if any). 

(2) For the Alternate DNS server, enter the next Corporate DNS 
server IP address from your planning form (item 11, if any).

(3) Click the Advanced button.
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The Advanced TCP/IP Settings window appears. 

(4) Click the DNS tab. See Figure 6-2 on page 6-8 for an example.

Figure 6-1. Sample corporate LAN TCP/IP properties 
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(5) On the Advanced TCP/IP Settings DNS tab, enter the following: 

! If you need to add IP addresses for any additional corporate DNS 
servers, click Add (see item 11 on the Modular Messaging MAS 
planning form on page A-6). Click OK to approve each entry. 

! Select the radio button for �Append these DNS suffixes (in order)�. 
Click Add.

! In the TCP/IP Domain Suffix window, in the Domain suffix field, enter 
any corporate domain suffixes listed for Search order of DNS 
domains using item 12 on the system planning form (for example, 
loc.avaya.com and avaya.com). After each entry, click Add. Repeat 
as needed to add all required suffixes.

! In the �DNS suffix for this connection� text box, enter the suffix for the 
fully qualified corporate LAN domain name (do not include the 
machine name). For example, loc.avaya.com (see item 7 on the 
Modular Messaging MAS planning form on page A-6).

Figure 6-2. Sample advanced TCP/IP settings for the corporate LAN
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! If required for this location, check the boxes to �Register this 
connection�s addresses in DNS� and �Use this connection�s DNS 
suffix in DNS registration.� See item 13 on the Modular Messaging 
MAS planning form on page A-6.

(6) If WINS is used at this location, click the WINS tab. Enter the 
following:

! To enter WINS addresses, click Add. Enter the IP address for the 
WINS server needed for information resolution. Click Add. Repeat 
this step until all required WINS addresses are entered. See item 14 
on the Modular Messaging MAS planning form on page A-6.

! Adjust other settings on this page if required. 

(7) Click OK to close the Advanced TCP/IP Settings window.

4. Click OK to close the Internet Protocol (TCP/IP) Properties window.

5. On the Networking Components screen, click Next.

A Networking Components screen for device Intel(R) PRO/100+ PCI 
Adapter screen appears. This LAN interface is not used in this 
configuration.

6. Click Next.

Completing the initial setup

Complete the initial administration for this MAS as follows: 

1. On the Workgroup or Computer Domain screen:

a. Select the second radio button, Yes, make this computer a member of 
the following domain.

b. Enter the name of the corporate Windows domain that the MAS is to join 
(such as zodiac). See item 2 on the Modular Messaging MAS planning form 
on page A-6. (The name is forced to upper case.)

c. Click Next.

d. You are prompted to enter the user name and password that will allow this 
machine to join the Windows domain. Proceed as follows:

(1) Enter the name of an account that has permissions to join the 
Windows domain. This is typically the Modular Messaging 
account, if the domain administrator has set it up as described in 
"Adding an MAS account to the Active Directory" on page 4-10. 

Note: It is strongly recommended that you do not use DHCP settings 
for this installation. Use only static IP addresses. 
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The account name must be in the format domain\account name 
(such as zodiac\mmacct). The name is forced to upper case. 

(2) Enter the correct account password.

(3) Click OK.

It may take several minutes to join the domain.

e. If a Network Identification box welcomes you to the domain, click OK.

f. Click Next.

2. On the Completing the Windows 2000 Setup Wizard screen, click 
Finish.

The machine reboots. 

3. When the reboot completes, press Ctrl+Alt+Del and log in as follows:

a. On the Log On to Windows screen, verify that the user name is 
Administrator. 

b. Enter the same password that you typed for the administrator account when 
you set up this machine. See items A1 to A6 on the Modular Messaging 
logon accounts form on page A-9.

c. Press Enter or click OK. 

4. If a Found New Hardware wizard appears, follow the prompts to 
complete each wizard. The hardware wizard appears once for every 
Dialogic port board installed in the system. 

Disable the Dialogic hardware for now as follows:

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next. 

c. On the Locate Driver Files screen, clear the checkbox for �Specify a 
location� (no boxes will be checked). Click Next.

Note: If the wizard comes up in a tiny window, press Esc to cancel 
this wizard (subsequent wizards should run in a normal-sized 
window). The skipped wizard will reappear the next time the 
system restarts; run it then.

If you reinstalled the operating system (see Appendix E, 
��Reloading software on an Avaya MAS,��) and ran the Found 
New Hardware wizards then, the wizards do not reappear. 

This wizard does not appear for IP H.323 configurations. 
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d. On the Driver Files Search Results screen, make sure that �Disable the 
device� is selected. Click Finish.

e. Repeat steps a through d for each repetition of the wizard.

Testing IP addresses using ping

Use this procedure to verify that the IP addresses for this MAS are correct and working 
as expected with the corporate LAN.

To test the IP addresses for this MAS: 

1. Open a Command prompt window. For example:

a. Click the Start button, then select Run. 

b. In the Run box, type cmd in the Open field and press Enter. 

2. At the command prompt, ping any IP addresses administered on the 
corporate network and verify success. See items 10 and 11 on your 
Modular Messaging MAS planning form on page A-6 for examples.

3. Optional: If you are using a corporate DNS, you may also want to ping 
other machines by name. Any name tests should show the corporate IP 
address for the entity you ping. 

4. If the ping test fails, verify that your network connections to the MAS are 
good. If so, check your administration. 

5. When finished, type exit and press Enter to close this window.

Note: Submenu choices are indicated with a right angle sign (>) in 
the rest of this document. For example, the procedure above 
would appear as Start > Run.

Note: In order for a name test to succeed, the machine names must 
be administered on the corporate DNS. If a corporate DNS is 
not used, ping will not be able to resolve the corporate name.
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Installing required software

You must install some required software on the Avaya MAS before proceeding. Check 
with the customer for the procedures and software required at this site.

Installing anti-virus software and Windows updates

We strongly recommend that anti-virus software be installed on any Microsoft Windows 
machine that is used to run Avaya Modular Messaging software. The type of 
virus-checking software used and the method of installation depends upon the 
customer�s requirements and local implementation.  

In addition, Microsoft Windows security patches must be installed to protect the 
operating system from known security weaknesses. Check with the appropriate 
customer administrator for the software and installation/update procedures to use.

Enabling Exchange 2003 prerequisite software 

For Exchange 2003 systems only, you have to enable the Simple Mail Transfer 
Protocol (SMTP), Network News Transfer Protocol (NNTP), and IIS Admin services, 
which are required by Exchange 2003 Short Message Service (SMS) tools.

To enable the required Windows services:

1. Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand Services and 
Applications, then click Services.

2. In the right-hand pane, scroll down to Simple Mail Transfer Protocol 
(SMTP). Double-click it to open the properties window. 

3. In the Properties window: 

a. On the General tab, set the �Startup type� to Automatic. 

b. Click Apply. 

c. Under �Service status,� click Start. 

d. Wait for service to start, then click OK to close this window.

Note: You need to disable the anti-virus software after installing it so you 
can install the Modular Messaging software. Enable the 
virus-checking software after installation is complete. 

Note: You must enable the required Windows services before installing 
the required Microsoft Exchange software in the next section. 
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4. Repeat steps 2 and 3 for the Network News Transfer Protocol (NNTP) 
service and for the IIS Admin Service. 

5. Close all open windows.

Installing required Exchange software

You must install the appropriate Microsoft Exchange tools on this machine to provide 
the API protocol needed for the Modular Messaging and Exchange systems to 
communicate. The name of the tools varies depending on the Exchange release: 

! Exchange 2000/2003: Microsoft Exchange System Management Tools

! Exchange 5.5: Microsoft Exchange Administration 5.5 Tools

To install this required software on an Exchange 2000 or 2003 machine: 

1. Insert the Microsoft Exchange 2000 or 2003 Server Software CD in the 
MAS drive.

2. Launch the Microsoft Exchange 2000 or 2003 Server menu (if it does not 
appear automatically). To install the tools:

a. Click Exchange Server Setup.

The Microsoft Exchange 2000 or 2003 Installation Wizard appears. 

b. Follow the wizard through the Component Selection screen, then:

(1) In the Action column, click the drop-down arrow by the first box to 
select Custom.

(2) Click the drop-down arrow to select Install for the version of tools 
appropriate for your release of Exchange:

! Exchange 2000/2003: Microsoft Exchange System Management 
Tools (see "Enabling Exchange 2003 prerequisite software" on page 
6-12 for Exchange 2003 systems)

! Exchange 5.5: Microsoft Exchange Administration 5.5 Tools 

c. Click Next. Complete the wizard as prompted. Refer to your Exchange 
documentation for details about this procedure if needed.

d. When the tools are installed, click Finish, then click Exit. 

3. Update your version of Microsoft Exchange and the tools you just 
installed to the latest service pack. 

Note: If the domain contains a mixture of Exchange 2000/2003 and 
Exchange 5.5 servers, install both sets of tools. 
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a. Use the procedures appropriate for this site to access the correct Service 
Pack update software.

b. When the Service Pack Installation Wizard runs, update your Exchange 
server and tools to the appropriate Service Pack: 

! Microsoft Exchange 2000 System Management Tools: SP3. 

! Microsoft Exchange 5.5 Administration Tools: SP4 (only needed 
for a Windows domain that has only Exchange 5.5 servers) 

c. Complete the wizard as prompted. Refer to your Microsoft Exchange 
documentation for details about this procedure if needed.

Setting up remote access (optional)

As an option, you can activate remote access support now instead of waiting until after 
you install the Modular Messaging software. If you want to enable remote access 
support as soon as possible, do the steps appropriate for the Avaya MAS in "Setting up 
remote access" on page 7-17, then return to this section. 

Note: If the domain contains a mixture of Exchange 2000/2003 and 
Exchange 5.5 servers, you need to install only SP3 for the 
Microsoft Exchange 2000 System Management Tools. 
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Configuring Modular Messaging components

Complete the basic machine setup of this Avaya MAS by specifying the message store 
and setting up Modular Messaging accounts for this MAS.

To complete basic Avaya MAS configuration:

1. Double-click the OSConfigWizard.exe icon on the desktop. 

The Modular Messaging OS Component Configuration Wizard appears.

2. On the Welcome screen, click Next.

3. On the Modular Messaging setup information screen:

a. Select the message store type Microsoft Exchange. 

b. For Windows NetBIOS domain, enter the NetBIOS name (such as 
zodiac). See item 2 on the Modular Messaging MAS planning form on page 
A-6.

c. Click Next.

4. On the next Modular Messaging setup information screen, enter the 
Modular Messaging account information as follows: 

a. Under Existing account information:

! For Modular Messaging (MM) account, enter the 
customer-defined Modular Messaging account logon name (such 
as mmacct). Type the password in each password column to 
confirm it. See item A7 on the Modular Messaging logon accounts 
form on page A-9.

! For Services account, enter the customer-defined Services 
access account logon name (such as craft). Type the password in 
each password column to confirm it. See item A8 on the Modular 
Messaging logon accounts form on page A-9.

b. Under New account information, for Administrator account for MAS, 
enter the customer-defined local administrator account logon name for this 
MAS (such as mas1-admin or mas2-admin). Type the password in each 
password column to confirm it. See items A1 to A6 on the Modular 
Messaging logon accounts form on page A-9.

c. Click Next.

5. Wait while the system processes the information you have entered. The 
system automatically restarts.

As the machine reboots, you may see a Hardware Profile/Configuration 
Recovery screen. Wait for the program to move on, or press Enter. 
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6. After the MAS reboots, you are prompted to log in or simply enter a 
password. 

a. If prompted to log in, press Ctrl+Alt+Del. 

b. On the Log On to Windows screen, check the user name. It should be the 
Modular Messaging account (such as mmacct).

c. Enter the correct password for this account. See item A7 on the Modular 
Messaging logon accounts form on page A-9.

7. When prompted to insert the Modular Messaging application software:

a. Insert the first installation disk in the DVD drive. This is either: 

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD 

b. Close the drive door and wait for the green LED to go out. Click OK. 

8. On the Completed Configuration process screen, click Finish. 

9. The Modular Messaging - Installation Wizard window appears 
automatically. Continue with "Installing the Modular Messaging software" 
on page 7-11.
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7
Installing and configuring the
Modular Messaging software

This chapter describes how to install the Modular Messaging software on an Avaya 
Messaging Application Server (Avaya MAS) or a customer-provided MAS.   

Note: Before you can successfully complete the tasks in this section, you 
must have completed the server preparation tasks in Chapter 4, 
��Preparing to install Modular Messaging software,�� and Chapter 5, 
��Updating the Exchange extensions.�� 

Section Page

Overview 7-2

Prerequisite steps for a customer-provided MAS 7-3

� Configuring the network card 7-3

� Installing anti-virus software and Windows updates 7-3

� Adjusting system values 7-3
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� Adding the service accounts to the local Administrators group 7-6
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� Installing required Exchange software 7-8

Installing Modular Messaging software 7-10

� Launching the installation wizard 7-10

� Installing the Modular Messaging software 7-11

Configuring the MAS 7-14

Setting up remote access 7-17
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Overview

You need to install and configure the Modular Messaging software as described in this 
chapter. Begin with the appropriate section depending on whether you are configuring 
an Avaya Messaging Application Server (Avaya MAS) or a customer-provided MAS.

! For a customer-provided MAS: continue with "Prerequisite steps for a 
customer-provided MAS" on page 7-3. 

! For an Avaya MAS: continue with "Installing Modular Messaging 
software" on page 7-10. 

To successfully install and configure Modular Messaging software, you need:

! A completed copy of the forms in Appendix A, ��System planning forms,�� 
specifically:

� Modular Messaging MAS planning form on page A-6

� Modular Messaging logon accounts form on page A-9

� MAS features list on page A-10

! The appropriate prerequisite tasks completed. These include:

� The tasks in Chapter 5, ��Updating the Exchange extensions,�� for a 
customer-provided MAS.

� The tasks in Chapter 6, ��Configuring a new Avaya MAS,�� for an Avaya 
MAS. 

Note: Installing the Modular Messaging software from a Microsoft 
Windows 2000 Terminal Services Client session is not supported. 
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Prerequisite steps for a customer-provided MAS

If you are installing Modular Messaging software on a customer-provided MAS, you 
must complete the steps in this section before you can successfully install the Modular 
Messaging software components. 

Configuring the network card

For each customer-provided MAS, the network card must be configured to support a 
corporate LAN connection. This procedure is similar to that used for the Avaya MAS in 
"Assigning IP addresses to this MAS" on page 6-6. Use your completed Modular 
Messaging MAS planning form on page A-6 to assign IP addresses and other TCP/IP 
properties for the corporate LAN interface that this MAS will use.  

Installing anti-virus software and Windows updates

We strongly recommend that anti-virus software be installed on any Microsoft Windows 
machine that is used to run Avaya Modular Messaging software. The type of 
virus-checking software used and the method of installation depends upon the 
customer�s requirements and local implementation.  

In addition, Microsoft Windows security patches must be installed to protect the 
operating system from known security weaknesses. Check with the appropriate 
customer administrator for the software and installation/update procedures to use.

Adjusting system values

Some default values on the system must be adjusted to support Modular Messaging as 
described in this section. 

Adjust the Event Viewer values as follows: 

1. Right-click My Computer and select Manage. 

2. In the Computer Management window, in the left-hand pane, expand 
Event Viewer. 

3. Right-click Application and select Properties.

Note: It is strongly recommended that only static IP addresses be 
assigned to MAS interfaces and machines. 

Note: You need to disable the anti-virus software after installing it so you 
can install the Modular Messaging software. Enable the 
virus-checking software after installation is complete. 
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4. On the General tab of the Application Properties screen, in the Log size 
frame, adjust the following values: 

a. Set Maximum log size to 4032 KB. 

b. Select the radio button for Overwrite events as needed. 

5. Click OK to close the properties screen. 

6. Close the Computer Management window. 

Adjust the Windows 2000 Server operating system values as follows: 

1. Right-click My Computer and select Properties. 

2. On the System Properties screen, on the Advanced tab, click 
Performance Options. 

3. On the Performance Options screen, adjust the following values: 

a. Select the radio button for Background services. 

b. Click Change to change the Virtual Memory size.

(1) Under �Paging file size for selected drive,� set both the Initial size 
and Maximum size to the recommended value +11 MB. 

(2) Click Set, then click OK to close this screen. 

c. Click OK to close the Performance Options screen.

4. On the System Properties screen Advanced tab, click Startup and 
Recovery. 

5. On the Startup and Recovery screen, under System Failure, clear the 
checkbox to �Automatically reboot�. Click OK. 

6. Close the System Properties screen. 

7. If you are prompted to restart the system, click No (you will reboot later). 

Adjust File and Printer Sharing properties as follows: 

1. Right-click My Network Places and select Properties. 

2. Right-click Local Area Connection and select Properties.

3. Right-click Internet Protocol TCP/IP and select Properties.

4. Select the File and Printer Sharing properties page and make the 
following change:

Enable maximum data throughput for network applications. 

5. Click OK. Close all open screens. 
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Joining the Windows domain

You must manually join the Windows domain as follows:

1. Switch the monitor to show this MAS. 

2. Log in to the local administrator account for this MAS: 

a. On the Log On to Windows screen, change the user name to the local 
administrator account name (such as mas1-admin). items A1 to A6 on the 
Modular Messaging logon accounts form on page A-9. 

b. Enter the password for this account.

c. If the �Log in to:� field shows a different domain, use the drop-down box to 
select this local machine (should be the default). 

d. Press Enter or click OK.

3. Right-click My Computer and select Properties.

4. In the System Properties window, click the Network Identification tab.

5. Click the Properties button. In the Identification Changes window: 

a. Under Member of, click the Domain radio button.

b. Type the corporate Windows domain NetBIOS name, such as zodiac. See 
item 2 on your Modular Messaging MAS planning form on page A-6. 

c. Click OK.

6. A Domain Username and Password screen may appear. Enter the name 
and password of an account that has permissions to join the Windows 
domain. This is typically the Modular Messaging account, if the domain 
administrator has set it up as described in "Adding an MAS account to 
the Active Directory" on page 4-10. The account name must be in the 
format domain\account name (such as zodiac\mmacct). 

7. If a Welcome to the domain screen appears, click OK.

8. Click OK when prompted to reboot the computer.

9. Click OK to close the System Properties window. 

10. Click Yes to restart the machine when prompted. You must reboot. 

Note: Depending on your local configuration, you may need to enter 
the fully qualified name here, such as zodiac.loc.avaya.com. 
This name is a combination of items 2 and 7 on the Modular 
Messaging MAS planning form on page A-6. 
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Adding the service accounts to the local Administrators group

For the accounts to work correctly, the Modular Messaging service account (required 
for software installation and administration) and the Services support remote access 
account must be added to the local administrators group as follows:

1. Log in to the local administrator account for this MAS (see "Joining the 
Windows domain" on page 7-5 for details if needed). 

2. Click Start > Programs > Administrative Tools > Computer Management. 

3. In the Computer Management window, under System Tools, expand 
Local Users and Groups, then click Groups. 

4. Double-click the Administrators group in the right-hand pane.

5. On the Administrators Properties screen, click Add.

6. In the Select Users or Groups window:

a. Under the Look in drop-down, select the Windows domain you just joined, 
such as zodiac. See item 2 on your Modular Messaging MAS planning form 
on page A-6.

b. On the Enter Network Password screen, enter an account name and 
password that has permission to access the Windows domain controller. 
This is typically the Modular Messaging account, if the domain 
administrator has set it up as described in "Adding an MAS account to the 
Active Directory" on page 4-10. The account name must be in the format 
domain\account name (such as zodiac\mmacct).

c. Click OK.

7. Scroll down to the Modular Messaging account, such as mmacct (see 
item A7 on the Modular Messaging logon accounts form on page A-9). 

a. Double-click it or click Add to add it to the Administrators group. 

The account name may appear in the format domain\account name (for 
example, zodiac\mmacct) or as an email account, such as 
mmacct@zodiac.loc.avaya.com. 

b. Click OK.

8. Repeat steps 5 through 7 to add the Services access account, such as 
craft (see item A8 on the Modular Messaging logon accounts form on 
page A-9). 

9. Click OK to close the Administrators Properties screen.

10. Close the Computer Management window.
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Installing Windows prerequisite software

Microsoft Windows Simple Network Management Protocol (SNMP) services must be 
installed on every customer-provided MAS that will be used to handle voice calls. 
SNMP services are required for the Modular Messaging Alarming Server to work. 

To install Windows Simple Network Management Protocol (SNMP) services:

1. Log in to an account that has permissions to install software on this 
machine (such as the local administrator account). See "Joining the 
Windows domain" on page 7-5 for details if needed. 

2. Insert the Microsoft Windows Operating System CD in the MAS drive.

3. Click Start > Settings > Control Panel.

4. In the Control Panel window, double-click Add/Remove Programs.

5. In the Add/Remove Programs window, in the left-hand column, click 
Add/Remove Windows Components. 

6. In the Windows Components Wizard window, check Management and 
Monitoring Tools and click Next. 

7. In the Management and Monitoring Tools window, check the box for 
Simple Network Management Protocol. 

8. Complete the wizard to install the SNMP services.

9. For Exchange 2003 systems only: You also have to install and enable 
the Simple Mail Transfer Protocol (SMTP) and Network News Transfer 
Protocol (NNTP) software, which is required by Exchange 2003 Short 
Message Service (SMS) tools. To do this: 

a. Open Control Panel again and double-click Add/Remove Programs.

b. In the Add/Remove Programs window, in the left-hand column, click 
Add/Remove Windows Components.

c. In the Windows Components Wizard window, check Internet Information 
Services (IIS) and click Details. 

d. Select SMTP Service and NNTP Service, and click OK. (The World Wide 
Web Service including IIS Admin will be installed as part of this package.)

e. When the wizard launches, click Next and then Install. 

f. Complete the wizard to install the software. 

Note: You must install the required SNMP software before installing the 
required Microsoft Exchange software in the next section. 
Exchange 2003 system tools require additional prerequisite 
software as described in step 9. 
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After the software is installed, the following services must be enabled: 

a. Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand Services and 
Applications, then click Services.

b. In the right-hand pane, scroll down to Simple Mail Transfer Protocol 
(SMTP). Double-click it to open the properties window. 

c. In the Properties window: 

(1) On the General tab, set the �Startup type� to Automatic. 

(2) Click Apply. 

(3) Under �Service status,� click Start. 

(4) Wait for service to start, then click OK to close this window.

d. Repeat steps b and c for the Network News Transfer Protocol (NNTP) 
service and for the IIS Admin Service. 

e. Optional: You may choose to disable the World Wide Web Publishing 
service, as it is not specifically required to support Exchange 2003 tools. 

f. Close all open windows.

Installing required Exchange software

You must install the appropriate Microsoft Exchange tools on every MAS to provide the 
API protocol needed for the Modular Messaging and Exchange systems to 
communicate. The name of the tools varies depending on the Exchange release: 

! Exchange 2000/2003: Microsoft Exchange System Management Tools

! Exchange 5.5: Microsoft Exchange Administration 5.5 Tools

For example, to install this required software on an Exchange 2000 or 2003 machine: 

1. Insert the Microsoft Exchange 2000 or 2003 Server Software CD in the 
MAS drive.

2. Launch the Microsoft Exchange 2000 or 2003 Server menu (if it does not 
appear automatically). To install the tools:

a. Click Exchange Server Setup.

The Microsoft Exchange 2000 or 2003 Installation Wizard appears. 

b. Follow the wizard through the Component Selection screen, then:

(1) In the Action column, click the drop-down arrow by the first box to 
select Custom.
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(2) Click the drop-down arrow to select Install for the version of tools 
appropriate for your release of Exchange:

! Exchange 2000/2003: Microsoft Exchange System Management 
Tools

! Exchange 5.5: Microsoft Exchange Administration 5.5 Tools 

c. Click Next. Complete the wizard as prompted. Refer to your Exchange 
documentation for details about this procedure if needed.

d. When the tools are installed, click Finish, then click Exit. 

3. Update your version of Microsoft Exchange and the tools you just 
installed to the latest service pack. 

a. Use the procedures appropriate for this site to access the correct Service 
Pack update software.

b. When the Service Pack Installation Wizard runs, update your Exchange 
server and tools to the appropriate Service Pack: 

! Microsoft Exchange 2000 System Management Tools: SP3. 

! Microsoft Exchange 5.5 Administration Tools: SP4 (only needed 
for a Windows domain that has only Exchange 5.5 servers) 

c. Complete the wizard as prompted. Refer to your Microsoft Exchange 
documentation for details about this procedure if needed.

4. After installing the appropriate Microsoft Exchange tools, open the 
System Management Tools or Administration Tools application and 
connect to the appropriate Exchange server. 

Note: If the domain contains a mixture of Exchange 2000/2003 and 
Exchange 5.5 servers, install both sets of tools. 

Note: If the domain contains a mixture of Exchange 2000/2003 and 
Exchange 5.5 servers, you need to install only SP3 for the 
Microsoft Exchange 2000 System Management Tools. 
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Installing Modular Messaging software

You need to install the required Modular Messaging software and configure each MAS 
as described in this section. 

Launching the installation wizard

If you are continuing an installation from Chapter 6, ��Configuring a new Avaya MAS,�� 
the Modular Messaging - Installation Wizard launches automatically. Continue with 
"Installing the Modular Messaging software" on page 7-11.

If you are configuring a customer-provided MAS, you must launch the Modular 
Messaging Installation Wizard manually as follows:

1. Log in to the Modular Messaging service account. For example:

a. Click Start > Log off admin-account.

b. Click Yes when prompted to confirm the logoff. 

c. Press Ctrl+Alt+Del to log on.

d. On the Log On to Windows screen, change the user name to the Modular 
Messaging service account name (such as mmacct). See item A7 on the 
Modular Messaging logon accounts form on page A-9.

e. Enter the password for this account.

f. Using the drop-down box, change the Log in to: field to show the correct 
Windows domain, such as zodiac. See item 2 on your Modular Messaging 
MAS planning form on page A-6. 

g. Press Enter or click OK.

2. Insert the application software disk in the MAS drive. This is either:

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD. 

3. Close the drive door and wait for the green LED to go out. Click OK. 

4. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the CD or DVD drive (such as D:).

b. Navigate to the Install directory.

Note: Completely install and test one MAS first, and let it run for 15 
minutes before installing any additional MASs. 
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c. Double-click the file setup.exe.

The Modular Messaging - Installation Wizard launches and searches for 
packages relevant to this configuration.

5. Click the Read Me button to review the Readme file for recent notices.

6. To change the default installation path (optional): 

a. Click the Change button.

b. Browse to an existing destination directory, or create a new destination 
directory as follows:

! If you are using Microsoft Windows 2000, use the New Folder 
button to create a new directory for the installation.

! If you are using NT4, use Windows Explorer to create a new 
directory for the installation, then select this directory. 

Installing the Modular Messaging software

Use the Modular Messaging - Installation Wizard to install the appropriate Modular 
Messaging software components.

To install the Modular Messaging software:

1. Check your MAS features list on page A-10 for the software packages 
that must be installed on this particular MAS.

2. On the main screen, verify that the Configuration drop-down box shows 
Microsoft Exchange. 

3. In the components list, check the boxes for any messaging services you 
need to install on this MAS. 

a. Required on every MAS: 

! Administration Tools

! Diagnostic Tools 

Note: You cannot define different installation paths for individual 
components. 

Note: If you want to add Exchange extensions tools to this MAS, you 
can select them at this time. See Chapter 5, ��Updating the 
Exchange extensions,�� for details. 
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b. Required on every MAS that will handle calls: 

! Messaging Application Server (includes the Alarming Server, 
which also installs the Event Monitor Server, Performance Monitor 
Server, and Process Monitor Server) 

! Prompt Files (at least one set is required on every MAS) 

c. Required on this MAS as specified by the customer: See the MAS features 
list on page A-10 for the specific services you need to put on this server. 
Check the appropriate boxes. Services include:

! Call Me Server (includes the Mailbox Monitor Server)

! Caller Applications Editor

! Language Packs 

! Message Waiting Indicator (MWI) Server (also includes the 
Mailbox Monitor Server)

! Tracing Server 

4. When all required services are selected, click Install.

5. Wizards run for all the Modular Messaging software packages you 
selected. Complete each wizard as directed. 

The following components install automatically (no response is needed): 

! Administration Tools (required) 

! Caller Applications Editor (optional on any machine) 

! Diagnostic Tools (required) 

! Language Packs (optional on any MAS) 

! Prompt Files (required; this may take several minutes) 

6. The following components must be installed on every MAS that will 
handle calls:

! Alarming Server 

! Messaging Application Server 

The wizards for these components must be completed as follows: 

a. When one of the above server installation wizards runs, click Next.

Note: These software components are not required on an MAS that 
does not handle calls, such as a machine that has only the 
Caller Applications Editor or Tracing Server installed on it. 
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b. When prompted, enter the following account information:

! For Domain, enter the NetBIOS name of the Windows domain 
(such as zodiac). See item 2 on the Modular Messaging MAS 
planning form on page A-6.

! For User Name and Password, enter the Modular Messaging 
account name (such as mmacct) and its password. See item A7 
on the Modular Messaging logon accounts form on page A-9. 

! Click Next. 

c. Click Install.

d. When done, click Finish.

7. The following components may be installed on any MAS (check your 
MAS features list on page A-10):

! Mailbox Monitor Server (by default, this is installed first if the Call Me 
or MWI Server is selected) 

! Call Me Server 

! Message Waiting Indicator (MWI) Server 

! Tracing Server 

The wizards for these components must be completed as follows: 

a. When one of the above server installation wizards runs, click Next.

b. When prompted, enter name of this MAS machine (such as zippy). See 
item 1 on the Modular Messaging MAS planning form on page A-6. Click 
Next. 

c. When prompted, enter the password for the Modular Messaging account 
(such as mmacct). See item A7 on the Modular Messaging logon accounts 
form on page A-9. Click Next. 

d. Click Install.

e. When done, click Finish.

8. For a system that uses CD-ROMs, you are prompted to insert additional 
disks to install the RealSpeak Text-to-Speech software in multiple 
languages. When prompted to insert installation disk 2: 

a. Remove the Avaya Modular Messaging Application Software and 
Languages CD from the drive. 

b. Insert the first Enhanced Email Reader (Text-to-Speech) RealSpeak 
software CD in the drive and close the door. 

c. Wait for the drive�s green LED to go out. Click OK. 
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d. After the disk is copied, you are prompted to insert the next disk: 

! Insert the next RealSpeak TTS software CD in the drive.

! Repeat steps b and d for each RealSpeak TTS software CD.

Allow several minutes for the RealSpeak software to install. When 
finished, the wizard returns to the main screen. 

9. To complete the installation, click Close.

10. Click Restart when prompted to restart the system now. 

11. Remove the media from the CD or DVD drive. 

Configuring the MAS

To configure Modular Messaging services on this MAS:

1. When the reboot completes, press Ctrl+Alt+Del to log back in. Use the 
Modular Messaging account (such as mmacct) and its password (see 
item A7 on the Modular Messaging logon accounts form on page A-9).

The Messaging Application Server - Configuration Wizard appears. 

2. For the Peer Microsoft Exchange Server Selection screen: 

a. Enter the name of the primary Microsoft Exchange Server. This is 
Windows NetBIOS name of the Exchange server, such as exchange1 (the 
name is forced to upper-case). See item 3 on the Modular Messaging MAS 
planning form on page A-6.

b. Click Next.

The Service configuration may take several minutes.

3. For the Peer Directory Server Selection screen: 

a. For Peer Directory Server, click Browse. 

b. On the Select Computer screen, navigate to the desired peer directory 
server, such as directory1, then double-click or click OK. See item 4 on the 
Modular Messaging MAS planning form on page A-6.

c. Click Next.

The Service configuration may take several minutes.
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4. The Peer Microsoft Exchange Server Configuration screen displays a 
scroll box showing a list of potential errors concerning external caller 
account creation and replication in the environment. For this screen:

a. Wait up to 10 minutes (larger systems will take longer). When the 
configuration is resolved, the screen automatically advances. 

b. If the screen does not advance after several minutes, read the messages in 
the scroll box. Follow the instructions to resolve the problem before the 
installation can proceed.

5. For the Voice Mail Domain Selection screen:

a. Select a new or existing voice mail domain as follows:

! For MAS#1: Click the radio button for �First server in a new voice 
mail domain.�

! For a subsequent MAS: Click the radio button for �Subsequent 
server in an existing voice mail domain.� 

b. Click Next. 

6. On the Voice Mail Domain Selection screen:

a. Specify the voice main domain as follows:

! For MAS#1: Enter the unique voice mail domain name for this set 
of MAS machines (such as zebra). See item 5 on the Modular 
Messaging MAS planning form on page A-6. 

! For a subsequent MAS: Verify that the existing voice mail 
domain name appears in the drop-down box (such as zebra). 

b. Click Next. 

The VMD configuration may take several minutes.

7. For a subsequent MAS: The Offline Storage Location screen appears if 
offline access is enabled in the voice mail domain and an offline 
message store has not already been selected. Browse to an existing, 
shared directory in the domain to set up the remote offline message 
store, used to synchronize messages in a multiple-MAS configuration. 
See item 6 on the Modular Messaging MAS planning form on page A-6. 

Note: Be patient. Do not click the Back button. The system works to 
resolve these errors independently. The screen will be updated 
a couple of times as the resolution progresses. 

CAUTION: If you are restoring MAS#1 to service after a disk failure in a 
multiple-MAS system, you need to join the voice mail domain 
as a subsequent MAS. See Recovering from a catastrophic 
disk failure on page F-1 for details. 

!
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a. For Store Location, click Browse. 

b. In the Browse for Folder window, navigate to the specified directory.

c. Select the folder and click OK. 

d. Click Next. 

8. For a subsequent MAS: The Caller Application screen appears if Caller 
Applications are deployed in the domain. 

a. Use the default setting for this step.

b. Click Next. 

9. For the User Information screen, just click Next.

10. On the Setup Complete screen, click Finish. 

Note: You can enable the anti-virus software on the MAS at this time. 

CAUTION: If you are restoring an MAS following a disk failure, see 
Restoring Caller Applications after a catastrophic disk failure 
on page F-3 for instructions about this feature. 

!
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Setting up remote access

Remote access allows Services support personnel to dial into a system to correct 
problems and perform routine maintenance. Unless other arrangements have been 
made, use the following procedure to set up the MAS to take incoming service calls. 

To set up this MAS for remote access: 

1. Activate remote access service as follows:

a. Double-click the Monitor icon on the desktop.

b. In the Monitor window, click Services (Local) in the left-hand pane.

c. In the right-hand pane, scroll down to Routing and Remote Access. 
Double-click it to open the properties window.

d. In the Routing and Remote Access Properties window: 

(1) On the General tab, set the �Startup type� to Automatic. 

(2) Click Apply. 

(3) Under �Service status,� click Start. 

(4) Wait for service to start, then click OK to close this window.

e. Close the Monitor window.

2. Access Routing and Remote Access using one of these methods:

! Double-click the Configure icon on the desktop (if present).  

! Click Start > Programs > Administrative Tools > Routing and Remote 
Access.

3. Continue as follows:

! If you are setting up a customer-provided MAS, continue with step 4.

! If you are setting up an Avaya MAS, continue with "Preparing an 
Avaya MAS for remote access" on page 7-18.

Note: The modem for this MAS must already be installed and correctly 
configured. See the documentation included with your modem for 
details on modem setup and operation. 

Note: This icon has a .msc extension and is labeled Configure.msc.
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4. If you are setting up a customer-provided MAS, preconfigure routing and 
remote access properties as follows: 

a. In the left-hand pane of the window, right-click Routing and Remote 
Access and select Add Server. 

b. On the Add Server screen, select �This computer.� Click OK. 

c. In the left-hand pane, expand Routing and Remote Access to see the new 
server name (such as ZIPPY). 

d. Right click the server name and select Configure and Enable Routing 
and Remote Access.

e. The wizard is launched. On the Welcome screen, click Next.

f. Choose Remote Access Server and click Next. 

g. Select TCP/IP yes and click Next. 

h. Network selection is �select the appropriate adaptor�. Click Next. 

i. Choose �from a specified range of addresses�. Click Next. 

j. On the Address Range Assignment screen, enter the range of 2 static IP 
addresses provided by the customer. See item 15 on the Modular 
Messaging MAS planning form on page A-6. 

k. Click Next again.

l. On the �managing Multiple remote access servers� screen, choose No to 
RADIUS. 

m. Click Finish. 

The Routing and Remote Access service starts. 

5. Continue with "Completing remote access setup" on page 7-19. 

Preparing an Avaya MAS for remote access

Do the following steps only on an Avaya MAS: 

1. To set up remote access properties for this Avaya MAS:

a. Expand Routing and Remote Access.

b. Expand the server name (such as ZIPPY).

2. Verify that remote access service (RAS) is running as follows:

a. If a green upward-pointing arrow appears on the server�s icon, RAS is 
running. Continue with step 1.

b. If a red symbol appears on the server�s icon, activate RAS as follows:

(1) Right-click the server�s name, and select All Tasks > Start.
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(2) If prompted to re-enable Routing and Remote Access, click Yes. 

3. Set up a static IP address pool as follows:

a. In the left-hand pane, right-click the server name (such as ZIPPY) and 
select Properties.

b. On the server�s local Properties screen, click the IP tab.

c. Check the box to �Enable IP routing�.

d. Check the box to �Allow IP-based remote access and demand-dial 
connections�. 

e. Under �IP address assignment,� select �Static address pool�. 

f. If an IP address range of 0000 to 0000 appears, select it and click Edit. (If 
no address appears, click Add.)

g. In the New Address Range properties box, enter the range of 2 static IP 
addresses provided by the customer. See item 15 on the Modular 
Messaging MAS planning form on page A-6. 

h. Make sure the number of addresses is 2.

i. Click OK.

j. For the Adapter field, select Local Area Connection 2 for the corporate 
LAN. 

k. Click OK to close the Properties window.

Completing remote access setup

Do the following steps on all MASs to set up the modem:

1. Set up inbound remote access to the modem as follows:

a. Right-click Ports and select Properties.

b. In the Ports Properties window, make sure the modem is highlighted, then 
click Configure.

c. In the Configure Device - <model> window, verify that the box to activate 
Remote access connections (inbound only) is checked.

d. Click OK.

e. Click OK to close the Ports Properties window.

2. Verify your modem setup:

a. Click Ports in the left-hand pane.

b. In the right-hand pane, verify that there is an entry for the modem attached 
to this MAS, such as MultiTech ZBA-USB-V92. 
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! If the modem entry is present, go to step 3.

! If the modem entry is missing, continue as follows: 

(1) Verify that the modem is correctly installed. 

For an Avaya MAS, check that the external modem is plugged into 
the recommended USB port (see "Connecting the USB modem 
on the MAS" on page 2-28).

(2) Click Start > Settings > Control Panel.

(3) Double-click Phone And Modem Options.

(4) The first time you select Phone and Modem Options, a wizard 
runs. 

! Complete the wizard following the steps on each screen to configure 
your locale settings. 

! When finished, your new entry appears in the Locations box on the 
Dialing Rules tab.

(5) In the Phone And Modem Options window, click the Modems tab.

(6) Verify that the modem is present and attached to a port (typically 
COM3 if you used the recommended USB port).

(7) If the modem is not present or attached to a port, you may need to 
remove the modem entry, then reinstall the modem.

(8) When finished, click OK to close the Phone And Modem Options 
window.

(9) Close the Control Panel.

(10) Return to step a and verify that the modem is now present.

3. Close the Configure or the Routing and Remote Access window.
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8
Configuring and testing the port

boards

This chapter describes how to configure and test the port boards on every MAS.   

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the tasks in Chapter 7, 
��Installing and configuring the Modular Messaging software.�� 

If you are using an IP H.323 integration, continue with Chapter 9, 
��Configuring the voice mail system.��

Section Page

Configuring the port boards 8-2

� Configuring analog port boards 8-3

� Configuring set emulation boards 8-5

� Configuring T1- or E1-QSIG boards 8-7

Testing the port boards 8-10
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Configuring the port boards

The port boards on each MAS must be configured and tested as described in this 
section. Port board administration involves three phases: 

1. The appropriate party must administer the switch for the port boards 
using the configuration notes for your particular PBX or switch 
integration. See "Required documentation" on page 1-2 for instructions 
on obtaining the configuration notes.

2. Configure and test the port boards as described in this section.

3. Afterwards, complete the port board administration for this MAS using 
the configuration notes as directed in "Configuring the voice mail 
system" on page 9-2. 

Table 8-1 lists supported Dialogic port boards and their associated documents (copies 
of the PDF files are on the documentation CD and application software disk). The type 
of port boards may vary on different MASs in the system, although each MAS can have 
only one type of board installed in it.

CAUTION: You can only install this system by using the required 
configuration notes for your switch or PBX. The PBX 
administrator must have administered the ports on the 
switch before you can proceed.

!

Table 8-1. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic files on documentation CD

Analog 4 - 8

12 - 48

Dialogic 4-port T/R board

Dialogic 12-port T/R board

2

4

D/41JCT-LS (PDF 133K)

D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40
or
8 - 48

Dialogic D/82JCT-U

Dialogic D/82JCT-U-PCI-UNIV

5 - Avaya 
MAS or 
6 - other 
MAS

D/82JCT-U (PDF 240K) 

D/82JCT-U PCI Univ (PDF 234K)

T1-QSIG 23 - 69 Dialogic D/480JCT-2T1 

Dialogic D/240JCT-T1

3 DualSpan JCT boards (PDF 104K)

Span JCT boards (PDF 99K) are 
supported for upgrades only 

E1-QSIG 30 - 60 Dialogic D/600JCT-2E1 

Dialogic D/300JCT-E1-120

2 DualSpan JCT boards (PDF 104K)

Span JCT boards (PDF 99K) are 
supported for upgrades only
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Continue based on the type of port boards installed in this MAS:

! "Configuring analog port boards" on page 8-3

! "Configuring set emulation boards" on page 8-5

! "Configuring T1- or E1-QSIG boards" on page 8-7

Configuring analog port boards 

You may have the following analog port boards installed in an MAS: 

! Dialogic 4-port Tip/Ring board (up to 2 per MAS; see the D/41JCT-LS 
PDF file on the documentation media for details)

! Dialogic 12-port Tip/Ring board (up to 4 per MAS; see the D/120JCT-LS 
PDF file on the documentation media for details)

To configure either of these analog cards:

1. Click Start > Programs > Intel Dialogic System Software > Configuration 
Manager - DCM.

The Intel Dialogic Configuration Manager window appears.

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected and verify the server�s name, such as ZIPPY.

3. Click Connect.

The Dialogic software locates any installed port boards.

4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Files tab.

The TSFFileName parameter should be selected.  

Note: If you are using a D/41JCT-LS card, you must highlight the 
�Configured Devices� parameter on the DCM display when 
selecting Configure Device. This is necessary to be able to 
view the TSFFilename parameter.

CAUTION: If you can�t find a suitable TSF file for your PBX, you need to 
build an appropriate tone file now or the integration will not 
work. Cancel out of this screen, then see Appendix C, 
��Creating a new tone file.��

!
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b. Locate the prerecorded TSF file for your PBX or switch:

(1) Click the ... button to browse, then navigate to the 
C:\Avaya_Support\Tone_Files directory. 

(2) In the Search File window, select a TSF file that is appropriate for 
the PBX to which you are connecting (for example, 
Avaya-G3-US.tsf). Double-click the file name. 

The appropriate TSF file is inserted in the Value field.

6. After an appropriate TSF file is selected, click the Misc tab. 

a. Click the TSFFileSupport parameter. 

b. Select Yes from the Value drop-down list. 

c. Click the DisconnectTone parameter.

d. Select Yes from the Value drop-down list.

e. Click OK to close the Properties window.

7. Repeat steps 4 through 6 for any other installed Dialogic boards (such 
as #1). 

8. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active. See 
Figure 8-1 on page 8-5 for an example. 

9. Close the Intel Dialogic Configuration Manager window.

10. Continue with "Testing the port boards" on page 8-10.

Note: You must have selected an appropriate TSF file for your PBX 
or switch before setting the TSFFileSupport parameter to Yes, 
or errors may occur.

Note: Most of the first board�s settings will persist between boards, 
except for the FirmwareFile parameter.
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Configuring set emulation boards 

You may have up to five 8-port Dialogic Digital Set Emulation (DSE) boards installed in 
an Avaya MAS, or up to six DSE boards installed in a customer-provided MAS. See the 
D/82JCT-U or D/82JCT-U PCI Univ PDF file on the documentation media for more 
information. 

To configure your digital set emulation boards:

1. Click Start > Programs > Intel Dialogic System Software > Configuration 
Manager - DCM.

The Intel Dialogic Configuration Manager window appears.

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected and verify the server�s name, such as ZIPPY.

3. Click Connect.

The Dialogic software locates any installed port boards. See Figure 8-2 
on page 8-6 for an example.

Figure 8-1. Sample Dialogic Configuration Manager analog window - service started
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4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Telephony Bus tab and select the PCMEncoding parameter.

b. On the pull-down list of values, select either A-Law or µ-Law depending on 
your location. Typically, A-Law is Europe and µ-Law is United States.

c. Click the Misc tab and select the PBXSwitch parameter.

d. On the pull-down list of values, select the name of the PBX (for example, 
use Lucent 2-wire for an Avaya G3 switch).

e. Click the Country tab and select the Country parameter.

f. On the pull-down list of values, select your country.

g. Click OK to close the Dialogic Configuration Manager Properties window.

6. Repeat steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

Figure 8-2. Sample Dialogic Configuration Manager DSE window - service not started

CAUTION: If the DSE boards are connected to a Nortel (NTM-1) PBX, 
you need to reboot the MAS before starting the Dialogic 
drivers. Close the DCM and reboot the system now. When 
the reboot completes, log back in and reopen the DCM (see 
step 1), then continue with step 7.

!
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7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active.

8. Check that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. It flashes a code for 
each port consecutively as follows:

! Ports that are connected to a phone line and functioning correctly 
show 0 and the port number (such as 00 or 01).

! Ports that are not connected to a phone line or not functioning 
correctly show En, where n is the port number. For example, the 
display reads E3 if there is an error on port 3.

b. If any errors (En codes) are present, check your board configuration, the 
physical connections between the board and the PBX, or the PBX 
configuration itself. (For example, make sure you have configured the 
correct PBX). Repeat steps 4 through 8 as needed.

9. Close the Intel Dialogic Configuration Manager window.

10. Continue with "Testing the port boards" on page 8-10.

Configuring T1- or E1-QSIG boards 

You may have either of the following QSIG port boards installed in your MAS. See the 
DualSpan JCT boards PDF file on the documentation media for more information. 

! Dialogic D/480JCT-2T1 board (up to 3 boards per MAS)

! Dialogic D/600JCT-2E1 board (up to 2 boards per MAS) 

To configure either T1-QSIG or E1-QISG boards:

1. Click Start > Programs > Intel Dialogic System Software > Configuration 
Manager - DCM.

The Intel Dialogic Configuration Manager window appears.

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected and verify the server�s name, such as ZIPPY.

3. Click Connect. 

The Dialogic software locates any installed port boards. 

Note: The single-span version of these boards (D/240JCT-T1 and 
D/300JCT-E1-120) is supported for upgrades only. 
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4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Interface tab and select the ISDNProtocol parameter.

b. Select the correct value for this type of board from the pull-down list:

! For E1-QSIG: select QTE

! For T1-QSIG: select QTU

c. Click the Telephony Bus tab and select the PCMEncoding parameter.

d. Select the correct value for this type of board from the pull-down list:

! For E1-QSIG: select A-Law 

! For T1-QSIG: select µ-Law 

e. Click the Misc tab. For the FirmwareFile parameter, verify that default is 
displayed.

f. Click the Country tab and select the Country parameter.

g. On the pull-down list of values, always use United States for either type of 
board. 

h. Click OK to close the properties window.

6. Repeat steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active. See 
Figure 8-3 on page 8-9 for an example. 

8. Check that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. 

! A red status LED appears on the back of the voice card during 
driver start-up.

! If the drivers start successfully, the LED of the board whose port is 
connected to the PBX is replaced by a green LED within about 20 
to 30 seconds. LEDs on the other boards remain red.

b. If a problem occurs, check your board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. Repeat steps 4 through 8 as needed. 
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9. Close the Intel Dialogic Configuration Manager window.

10. Continue with "Testing the port boards" on page 8-10.

Figure 8-3. Sample Dialogic Configuration Manager QSIG window - service started
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Testing the port boards 

Test all port boards and channels to verify that they can send and receive calls. 

Prepare for port board testing as follows: 

1. Stop Modular Messaging service as follows:

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left-hand pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand 
Services and Applications, then click Services.

b. In the right-hand pane, scroll down to MM Messaging Application Server.

c. Right-click MM Messaging Application Server and select Stop.

2. For software upgrades only, the Dialogic Line Tester program is not 
yet installed. Access the test program on disk as follows: 

a. Insert the application software disk in the MAS drive. This is either: 

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD 

b. Close the drive door and wait for the green LED to go out. Click OK. 

c. In Windows Explorer, navigate to the CD or DVD drive (D:).

d. Navigate to the Install directory, then to the DLTest subdirectory. 

e. Double-click the file DLTest.exe.

The Dialogic Line Test Application launches.

3. For T1-QSIG or E1-QISG boards, set up the test options as follows: 

a. Click Start > Programs > Avaya Modular Messaging > Dialogic Line Tester 
(or access the program from the applications disk as described in step 2). 

b. In the Dialogic Line Test Application window, click Tools > Options.

c. In the Options window, select the correct values for each field. Use your 
configuration notes to identify the correct values: 

! For Layer 1 Protocol, select your ISDN protocol from the 
drop-down list.

! For Number Type, select the destination number type.
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! For Number Plan, select the destination number plan. 

To test Dialogic port board functionality: 

1. Access the Dialogic Line Test application using one of these methods:

! Click Start > Programs > Avaya Modular Messaging > Dialogic Line 
Tester 

! Access the DLTest program from the applications software disk 
described in step 2 on page 8-10. 

The Dialogic Analog - Line Test Application (or DLTest) window 
appears. The name of the window varies depending on the type of port 
boards installed. All port numbers and channel designations should be 
listed. See Figure 8-4 for an example. 

2. Test the incoming call connectivity of all ports as follows:

a. From a handset on the same PBX, dial each port individually.

! For analog and set emulation boards, use the individual port 
extensions from Required switch and messaging information on 
page A-11.

! For QSIG cards, repeatedly dial the number for that group of 
ports. The switch connects to the next port in the list each time 
you dial.

Note: The values you select here must be the same as those entered 
on the PBX or switch. Check your configuration notes.

Figure 8-4. Sample Dialogic Analog - Line Test Application window



585-310-331, Issue 1

Avaya Modular Messaging for Microsoft Exchange Release 1.1 Installation

8�12 December 2003

b. Check the Status column. Verify that each port shows �Received call� 
followed by �Connected.� See Table 8-2 for different status conditions.

The system should answer each connected call with a standard 
welcome message. 

3. Test the outcalling capability of all ports as follows: 

a. Type the number of an extension on this PBX in the Dial Number field near 
the top of the window.

b. Select a Port Number in the Dialogic Line Test Application window.

c. Click Dial Number.

d. When the dialed extension rings, answer the call and hang up.

e. Select the next Port Number, and click Dial Number again. 

f. Repeat steps d and e until all ports have been tested.

4. When finished, close the test application window.

5. If a problem occurs, check your board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. For example, make sure that you have configured the correct PBX 
and administered it according to the appropriate configuration notes.

Table 8-2. DL Test status messages 

Status Description Highlight

Channel starting� The channel is being started. Normal

Channels idle� The channel is idle. Normal

Waiting for call� The channel is waiting for an incoming call. Normal

Received call� An incoming call is being processed. Normal

Dialling number� A number is being dialled to make on outgoing call. Normal

Resetting� The user reset the channel. Normal

Line Busy. An outgoing call was made but a busy tone was detected. Normal

No Answer. An outgoing call was made but the call was not answered. Normal

Connected. An incoming or outgoing call was answered so the call is now connected. Normal

Call was disconnected. An incoming or outgoing call was disconnected. Normal

Error. A general error with channel occurred. Error

Error, No Dial tone 
detected.

An outgoing call was made but no dial tone was detected before dialling. Error
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Configuring the voice mail system

This chapter describes how to configure the basic Voice Mail System Configuration 
(VMSC) parameters and complete initial Modular Messaging software administration.   

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the tasks in Chapter 8, 
��Configuring and testing the port boards.�� 
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Overview

You are now ready to configure the basic Voice Mail System Configuration (VMSC) 
parameters and complete initial Modular Messaging software administration. 

To successfully complete this task, you need:

! A completed copy of the forms in Appendix A, ��System planning forms,�� 
specifically:

� Modular Messaging MAS planning form on page A-6

� MAS features list on page A-10

� Required switch and messaging information on page A-11

� Services information on page A-12

! The configuration notes for your PBX or switch. See "Required 
documentation" on page 1-2 for instructions on how to obtain these. 

Configuring the voice mail system 

Voice mail system configuration falls into three areas:

1. Domain-wide administration, some of which must be done on MAS#1 
only (such as initial PBX setup).

2. Administration of domain-wide features that may be installed on any 
MAS, such as Call Me or Message Waiting Indicator.

3. Port board and feature configuration specific to each MAS.

This section guides you through the administration of key parameters that are required 
to get a new system operational.  

Note: This section is intended to get a Modular Messaging system up 
and running with the basic required features. Customers are 
encouraged to tailor the Voice Mail System Configuration (VMSC) 
parameters for their site after a successful installation using the 
Avaya Modular Messaging Software Messaging Application Server 
Administration guide (PDF 3 MB), located on the documentation 
media shipped with the system. 
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Configuring domain-wide features

This section covers the administration of domain-wide features as follows:

! Required features that must be administered for every Modular 
Messaging system are marked On MAS#1 in this guide. This is to 
ensure the configuration of all required system elements. (Note that, 
except for initial PBX administration, most domain-wide features 
technically can be administered on any MAS.) 

! Some domain-wide features are optional and may be installed on any 
MAS, including the first one (such as the Call Me and Message Waiting 
Indicator Servers). Use the MAS features list on page A-10 to determine 
what features need to be configured on a given MAS.

To configure the voice mail system:

1. If you installed multiple languages, specify the preferred language for 
this MAS:

a. Click Start > Programs > Avaya Modular Messaging > Languages.

b. On the Modular Messaging User Properties screen, select the Preferred 
language from the drop-down list.

c. Click OK. 

2. Verify that Modular Messaging service is started as follows: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left-hand pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand Services 
and Applications, then click Services.

b. In the right-hand pane, scroll down to MM Messaging Application Server.

c. Check the Status column.

(1) If the status is Started, continue with step 3.

CAUTION: The procedures in this section can only be completed by 
using the required configuration notes for your PBX or 
switch. See "Required documentation" on page 1-2 for 
instructions on obtaining the configuration notes.

!

Note: This icon has a .msc extension and is labeled Monitor.msc.
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(2) If service is not started, right-click MM Messaging Application 
Server and select Start.

The system begins a messaging service startup. 

d. Track startup progress as follows:

(1) Access the event viewer using one of these methods:

! In the Monitor window, in the left-hand pane, expand Event Viewer 
(Local). 

! In the Computer Management window, in the left-hand pane, expand 
System Tools, then Event Viewer. 

(2) In the left-hand (Tree) pane, click Application. 

(3) Refresh the window periodically until you see Telephony User 
Interface event 1241, �TUI service has been enabled.� You can 
now proceed.

e. When service is restarted, close or minimize this window.

3. Click Start > Programs > Avaya Modular Messaging > Voice Mail 
System Configuration. 

The Voice Mail System Configuration window appears. All MASs 
present in the messaging system are listed. 

4. On MAS#1: Double-click Telephone User Interface.

a. On the General tab, set the �Number of Digits in a Mailbox� to match the 
number of digits in the extension numbers on the customer�s PBX. See 
Required switch and messaging information on page A-11.

b. Click the Subscriber tab. 

(1) If prompted that your extension number changes will invalidate all 
previous mailboxes, click Yes.

Note: When you restart messaging service, the window 
immediately shows a status of Started. However, service 
may actually take several minutes to start, depending on the 
number of port boards installed and the integration method. 

Note: Do the steps in this section under the voice mail domain, not 
under a specific MAS.

Although you are prompted to restart service several times 
during this procedure, you actually need to restart service only 
before entering the port board extension numbers in 
"Configuring MAS-specific parameters" on page 9-9 and at the 
end, when configuration is complete.
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(2) Verify that �Login Failures before Mailbox Lockout� is 18. 

c. Click OK to close this window.

5. To set up Call Me service: Do this procedure if the optional Call Me 
Server is installed on any MAS. See the MAS features list on page A-10.

a. Double-click Call Me.

b. In the Call Me - Voice Mail Domain window, on the General tab, check the 
box to Enable Call Me.

c. For Call Me server, specify the MAS on which the Call Me software is 
installed (such as ZIPPY). If this field is blank:

(1) Click the ... button next to the field.

(2) In the Select Computer window, double-click the name of the MAS 
that has Call Me installed (such as ZIPPY).

(3) Click OK to close this window.

6. To set up MWI service: Do this procedure if the optional Message 
Waiting Indicator Server is installed on any MAS. See the MAS features 
list on page A-10.

a. Double-click Message Waiting Indicator.

b. In the Message Waiting Indicator - Voice Mail Domain window, on the 
General tab, check the box to Enable Message Waiting Indicator (MWI).

c. For MAS MWI server, specify the MAS on which the MWI software is 
installed (such as ZIPPY). If this field is blank:

(1) Click the ... button next to the field.

(2) In the Select Computer window, double-click the name of the MAS 
that has MWI installed (such as ZIPPY).

d. In the �Messaging Application Servers that support MWI� box, list all MAS 
servers that support MWI. To add a server�s name:

(1) Double-click inside the top of the big list box, or click the Add 
(dashed-box) button just above the list box.

(2) A data entry field and ... button appear in the list box. Click the ... 
button.

(3) In the Select Computer window, double-click the name of each 
MAS that supports MWI (such as ZIPPY and ZORRO).

(4) Click OK. 

e. Click OK to close this window.
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7. On MAS#1: Set up access permissions to allow authorized users to 
administer the Modular Messaging system or subscribers on the 
directory server. 

a. In the Voice Mail System Configuration window, expand Security. 

b. Double-click System Administration.

(1) In the Permissions for System Administration window, verify that 
the Modular Messaging account (such as mmacct) is already 
listed. Click Add to include additional required users. 

(2) In the Select Users, Computers, or Groups window, add the 
appropriate users or groups who require system administration 
permissions (for example, the Services remote access account 
such as craft). See item 17 on the Modular Messaging MAS 
planning form on page A-6. Double-click the required entry, then 
click OK. 

(3) Click OK to close this window.

c. Double-click Subscriber Administration.

(1) In the Permissions for Subscriber Administration window, click 
Add to add the users who are required to administer subscribers. 
The prerequisite is Exchange subscriber administration rights and 
Exchange user administration extensions. 

(2) In the Select Users, Computers, or Groups window, add the 
customer-specified users or groups required to administer 
Exchange users and extensions. See item 17 on the Modular 
Messaging MAS planning form on page A-6. Double-click the 
required entry, then click OK. 

(3) Click OK to close this window.

8. On MAS#1: If multiple languages or the optional Text-to-Speech feature 
are used at this site, double-click Languages. Do the following in the 
Languages - Voice Mail Domain window:

a. For Primary Language, select the primary prompt set to be used at this 
site. See the MAS features list on page A-10.

b. If the optional Text-to-Speech (TTS) feature is used at this site: 

(1) Check the box to enable Enable Multilingual Text to Speech. 

(2) In the list box, check all the languages to use for TTS at this site. 
See the MAS features list on page A-10.

Note: The customer may have predefined groups that include users 
who are authorized to perform system or subscriber 
administration. Check with the domain administrator for the 
correct entries to make here. 
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c. Click OK to close this window.

9. To set up the optional offline access feature: Do this procedure on any 
MAS. 

a. Double-click Messaging.

b. In the Messaging - Voice Mail Domain window, click the Offline Access tab.

c. Check the box to Enable offline access to messages.

d. If multiple MASs are installed, check the box to Synchronize offline 
messages with remote store. Click Browse to select an existing, shared 
directory in the domain for the remote offline message store. See item 6 on 
the Modular Messaging MAS planning form on page A-6. 

e. Alter any other parameters on this screen as needed. See the Avaya 
Modular Messaging Software Messaging Application Server Administration 
guide (PDF 3 MB) on the documentation media for details. 

10. On MAS#1: Double-click Serviceability. Enter the following in the 
Serviceability - Voice Mail Domain window:

a. On the General tab, select the type of alarming to be used on this voice 
mail domain for the Modular Messaging system: INADS, SNMP, or none. 

b. If alarming is activated, enter the unique product ID for this system. See 
Services information on page A-12 for this number. 

c. Generally, you can accept the default values for the following parameters, 
unless directed otherwise: 

! The conditions for sending an alarm notification

! The alarm level at which notification will be sent (minor or major)

! The system behavior for stopping Modular Messaging service

d. If you selected SNMP alarming, click the SNMP tab. See SNMP alarming 
information on page A-12 to enter the required values. 

! For Network Management Station, specify the corporate 
network management system (NMS) that will monitor the Modular 
Messaging system for alarm notifications (traps). Either type the 
IP address or fully qualified domain name for the NMS in the field, 
or click Browse to navigate to and select the appropriate NMS.

!  For Context (community), enter the name of the context or 
community to which the NMS belongs (such as public).

Note: If the offline message store is to be on a machine other than an 
MAS, the share must be mapped as a network drive on this 
MAS. See the Administration guide (PDF 3 MB) for details. 

Note: If no modem is present, INADS alarming is not available. 
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!  For Acknowledgement type, select either Return trap (to have 
traps actively acknowledged) or Ping surround (to send a ping to 
the NMS before and after sending a trap to assume trap receipt). 

e. Click OK to close this window.

11. On MAS#1: Obtain and install the license for this system as follows: 

a. To obtain a license, in the Voice Mail System Configuration window, 
right-click Licensing and select Copy Host ID to Clipboard. 

b. Open a text editor application such as Notepad and Paste the ID into the 
file. This is the unique ID for this voice mail domain (system). 

c. Include the following information in the same file: 

(1) The platform (Microsoft Exchange)

(2) Whether this is a new installation or an upgrade (for upgrades, 
specify the release you are upgrading from) 

(3) The number of seats (voice mail-enabled user mailboxes) 
purchased for the system

(4) The maximum number of concurrent sessions of text-to-speech 
conversion purchased for the system

(5) Specify the text-to-speech engine (such as Fonix DECtalk US 
English, ScanSoft Realspeak Any Language, or ScanSoft 
TTS-3000 International). 

(6) The installer�s name and contact information (telephone number 
and email address)

d. Notify the appropriate Modular Messaging remote support center and 
transmit the file as directed (through email, FTP, and so on). 

e. Continue the installation while the remote support center generates and 
transmits back a valid license for this system. 

After the license is obtained, install it as follows: 

a. In the Voice Mail System Configuration window, right-click Licensing and 
select Import License. 

b. On the License Import Wizard welcome screen, click Next.

c. On the Importing the License screen, click Browse. 

Note: The procedure for obtaining a license file may vary. Follow your 
local procedures for obtaining a license for this system. 

You can continue administering the system while a license is 
being generated. Return to this procedure after the license is 
received to install the license. 
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d. Navigate to the location where the license file is stored. 

e. Double-click the appropriate *.xml license file. Click Open. 

f. Click Next to install the license.

g. When the wizard completes, click Finish. 

h. In the Voice Mail System Configuration window, double-click Licensing.

i. On the Licensing - Voice Mail Domain properties screen, on the General 
tab, verify that the correct values for this customer are displayed.

j. Click the Text-to-Speech tab. Every MAS in the voice mail domain is listed. 

(1) For each MAS, double-click the TTS link, such as �Text to speech, 
ScanSoft RealSpeak, Any Language�. 

(2) On the Edit Sessions screen, enter the number of TTS sessions 
required for this MAS (for example, 2 sessions per MAS). See the 
MAS features list on page A-10. 

(3) When finished, click OK. 

k. Click OK again to close the Licensing properties screen.

12. On MAS#1: Set up PBX service for the system.

a. In the Voice Mail System Configuration window, right-click PBXs and select 
Add New PBX Type.

b. For Telephony Type, select the type of port board that is installed in this 
MAS (such as Dialogic Analog).

c. In the PBXs scroll box, select the type of switch integration that you have 
(such as Dialogic Avaya G3 CLAN).

d. Click OK to close this window.

e. In the Voice Mail System Configuration window, expand PBXs.

f. Double-click the PBX entry you just added.

g. Using the configuration notes for your PBX or switch, set up the specific 
PBX parameters required for this integration of the system. 

Configuring MAS-specific parameters

After the domain-wide parameters have been configured, set up the port boards and 
features specific to this MAS. 

Note: Even though you are using the configuration notes for your PBX or 
switch to do many of these steps, read through this section to get 
an overview of the whole configuration procedure.
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To specify MAS-specific parameters: 

1. In the Voice Mail System Configuration window, expand Messaging 
Application Servers. See item 1 on the Modular Messaging MAS 
planning form on page A-6 for MAS names. 

a. For MAS#1: The first time you access this item, a Telephony Configuration 
Wizard runs to help you set up the basic PBX integration details for all 
MASs in this domain. Complete the wizard as prompted. 

b. For a subsequent MAS: Right-click the server name (such as ZORRO), 
then select Telephony Configuration Wizard to run the wizard. Complete 
all steps in the wizard as prompted. 

2. When the wizard completes:

a. Expand Messaging Application Servers again, then expand the directory 
for this server�s name. 

b. Check your configuration notes and add any additional detailed data that 
are dependent on the switch and the integration type.

3. When the configuration note programming is complete, restart service 
as follows: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left-hand pane, click Services if it is not already selected.

! Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand Services 
and Applications, then click Services.

b. In the right-hand pane, scroll down to MM Messaging Application Server. 
Right-click it and select Stop. 

c. When service is stopped, right-click MM Messaging Application Server 
again and select Start.

The system begins a messaging service startup. 

d. Track startup progress as follows:

(1) Access the event viewer using one of these methods:

Note: If the wizard does not start automatically, right-click the server 
name (such as ZIPPY), then select Telephony Configuration 
Wizard.

Note: When you restart messaging service, the window immediately 
shows a status of Started. However, service may actually take 
several minutes to start, depending on the number of port 
boards installed and the integration type.
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! In the Monitor window, in the left-hand pane, expand Event 
Viewer (Local). 

! In the Computer Management window, in the left-hand pane, 
expand System Tools, then Event Viewer. 

(2) In the left-hand (Tree) pane, click Application. 

(3) Refresh the window periodically until you see Telephony User 
Interface event 1241, �TUI service has been enabled.� You can 
now proceed.

e. When service is restarted, minimize this window.

4. In the Voice Mail System Configuration window, expand Messaging 
Application Servers. 

a. Expand the entry for your server name (such as ZIPPY). 

b. Double-click Telephony Interface. Configure the port boards in this MAS. 
Use your configuration notes. See the Required switch and messaging 
information on page A-11 for port board extensions.

c. Double-click PBX Type. Select the same type of PBX service as you did in 
step 12 for "Configuring domain-wide features" on page 9-3. Make sure the 
entry in the PBXs box is highlighted, and click OK. 

d. Double-click PBX Integration and configure the integration type for your 
system. Use your configuration notes to specify or confirm the detailed 
settings required by your switch integration.  

e. If multiple port groups are used, double-click Port Groups. See the 
Required switch and messaging information on page A-11 for details. 

f. If INADS alarming is used, double-click Serviceability to set up dial-out 
information for this MAS. See INADS alarming information on page A-12. 

(1) For COM port, select the communications port that the modem 
should use to initiate calls for alarm notification. This is typically 
COM3 if you used recommended USB port A on an Avaya MAS.

(2) For Phone number, enter the complete telephone number that 
the modem must dial to place an alarm notification with the 
Services support center. Include any special characters needed 
(for example, to access an outside line, insert pauses, and so on). 

(3) For Modem setup, enter the modem initialization (setup) string if 
required for the modem to make alarm notification calls. 

Note: Some values may already be set. Follow the configuration 
notes for your PBX integration.

Note: To set the maximum number of MWI sessions allowed at one 
time, see MAS features list on page A-10.
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(4) Click OK to close this window. 

5. When configuration is complete, restart service again (see step 3). 

6. When finished, close all open windows.

Completing initial MAS administration

This section covers the final steps for completing initial administration of this MAS.

Setting up and starting messaging services

To allow the Modular Messaging (MM) services to restart automatically during normal 
operation, and to start the messaging services:

1. Click Start > Run.

2. In the Run box Open field, type the following and press Enter:

C:\Avaya_Support\Scripts\serverrecovery.vbs 

The script takes a few seconds to run. When it completes, all installed 
MM services will be started.

3. Optional. To verify that all services are started: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left-hand pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand Services 
and Applications, then click Services.

b. In the right-hand pane, scroll down to the list of Modular Messaging (MM) 
services. Make sure that the Status column shows that service is Started 
for each installed messaging service.

c. If service is stopped or the Status column is blank, right-click the 
appropriate MM service and select Start.

d. When finished, close this window.
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Verifying alarming setup 

Run the following test to verify that alarm notification is working:

1. Click Start > Run.

2. In the Run box Open field, type cmd and press Enter.

3. In the command prompt window, type the following and press Enter:

testaom -v

4. Check that the last line of the test reads:

Alarm origination test successful 

Configuring Active Directory Connector if required 

This procedure must be performed by the directory server administrator or other 
authorized personnel. 

Organizations using a mixture of Exchange 5.5 and Exchange 2000 or 2003 servers as 
peer messaging servers in a single voice mail domain require a Windows 2000 service 
called Active Directory Connector (ADC) to be installed. 

To configure ADC to support Modular Messaging software, a two-way connection 
agreement must be created between the voice mail domain container in the Exchange 
5.5 organizational unit and the Exchange 2000 or 2003 organizational unit. The 
connection agreement controls replication between the Active Directory domain 
controller and the Exchange 5.5 site voice mail domain recipient container. It contains 
information required for the replication, such as the account name, server name and 
the location of the voice mail domain containers.

Active Directory Connector:

! Synchronizes the Exchange 5.5 directory with the Exchange 2000 or 
2003 Server Active Directory to allow administration of the directory from 
either the Exchange 5.5 directory or Active Directory. 

! Enables the migration of objects from the Exchange Directory Service to 
Active Directory.

! Controls replication between the Exchange 5.5 site voice mail domain 
recipient container and the Active Directory domain controller.

Note: For instructions on accessing the MAS alarm or error logs, see the 
Avaya Modular Messaging Software Messaging Application Server 
Administration guide (PDF 3 MB) on the documentation media. 
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! Contains replication information including the account name, server 
name and the location of the voice mail domain containers.

To configure Active Directory Connector:

1. Log in to the Active Directory server using an account that has privileges 
to create a connection agreement (such as administrator).

2. Start Active Directory Connector.

3. Select New Action and then click Recipient Connection Agreement.

4. Enter the following information:

! The account name and password of an account with Active Directory 
connection privileges

! The name of the Exchange 5.5 server to replicate with

! The name of the domain controller to replicate with

! The names and passwords of accounts for replication agreement 
authentication

! The location of the voice mail domain container in the Active 
Directory 

Note: The Connection Agreement must be configured to create a new 
Windows NT account if the primary account for the mailbox does 
not exist in the domain. If you create disabled accounts, you must 
enable them manually for the Modular Messaging software to 
operate correctly. 
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Testing and backing up the system

This chapter describes how to perform acceptance tests to verify that the Modular 
Messaging system is providing full service. When functionality is verified, back up the 
system to protect the Modular Messaging configuration data.   

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the tasks in Chapter 9, 
��Configuring the voice mail system.�� 

Section Page

Adding a test subscriber 10-2

Performing acceptance tests 10-4

� Creating and sending a call answer message 10-4

� Retrieving test messages in integrated mode 10-4

� Creating and sending a test message in nonintegrated mode 10-6

� Testing the outcalling capability 10-6

� Running additional tests 10-8

Administering subsequent MASs 10-8

Removing the test subscriber 10-9

Backing up the system 10-9
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Adding a test subscriber

You must create at least one test subscriber to verify Modular Messaging system 
functionality. 

The new account for the test subscriber must be created as a Windows domain user 
account on the appropriate Exchange server. Use your regular Microsoft Exchange 
documentation to create a new account. For example:

! On an Exchange 5.5 system, you would create a new account in the 
Recipients container using the Microsoft Exchange Administrator 
application. You would then enable the appropriate Modular Messaging 
features on the Modular Messaging Properties page. 

! On an Exchange 2000 or 2003 system, you might create a test 
subscriber and enable Modular Messaging features as follows: 

1. Log in to the Active Directory server using an account that has privileges 
to create new user accounts (such as administrator).

2. Click Start > Administrative Tools > Active Directory Users and 
Computers.

3. In the Active Directory Users and Computers window, expand the 
directory for the Windows domain you used for Modular Messaging. See 
item 2 on the Modular Messaging MAS planning form on page A-6.

4. To access the test subscriber account, in the left-hand pane, click Users. 

Note: If you are performing tests following a Modular Messaging software 
upgrade, you may wish to test the system using subscribers that 
are already administered. 

Note: For details on administering Modular Messaging features, 
see Chapter 15, �Creating subscriber accounts for Microsoft 
Exchange,� in the Avaya Modular Messaging Software 
Messaging Application Server Administration guide (PDF 3 
MB) on the documentation media. 

Note: This procedure assumes that a test subscriber has already 
been created (see "Creating a test subscriber account" on 
page 4-6). If you create a test subscriber now, wait a few 
minutes for the Active Directory to synchronize its data with 
the MAS before proceeding. 

The extension for the test subscriber must be administered 
on the PBX by the appropriate party. See Required switch 
and messaging information on page A-11. 
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5. In the right-hand pane, double-click the test subscriber account, such as 
Test Subscriber (testsub1), to open the properties window.

6. Click the Modular Messaging tab.

7. Check the box to Enable Modular Messaging.

There may be a delay as the server logs in. 

8. Activate the features that you have installed and want to test.

9. When finished, click OK. 
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Performing acceptance tests

Verify correct system operation by doing the following tests. 
 

Creating and sending a call answer message

The following test works only if call-coverage has been assigned on the switch to route 
unanswered calls to the test subscriber�s extension.

To create and send a call answer test message:

1. Call the test-subscriber extension from any other telephone. Allow the 
Modular Messaging system to answer.

2. Speak into the telephone and record the following or a similar test 
message after the tone:

�This is a test call answer message.�

3. Hang up the telephone to disconnect. 

Retrieving test messages in integrated mode

Test the fully integrated operation of the system as directed below. You need access to 
the actual telephone whose extension number is assigned to the test-subscriber 
mailbox to perform this test. 

To verify the receipt of your test messages in integrated mode:

1. If MWI is installed: Check the message waiting indicator (MWI) on the 
test-subscriber telephone. The MWI may be a light, a screen display, or 
a dial-tone stutter when you pick up the phone. 

If the MWI does not indicate that a call was received:

a. Check that the Mailbox Monitor and MWI services are started.

(1) Access the window to monitor services using one of these 
methods:

CAUTION: Wait 5 minutes after completing the tasks in Chapter 9, 
��Configuring the voice mail system,�� to give the system time 
to update all servers in the voice mail and Windows domains 
with the correct Modular Messaging information. 

!

Note: The message-waiting lamp may take up to 1 minute to light on 
the appropriate telephone after a test message is sent.
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! Double-click the Monitor icon on the desktop (if present). In the 
left-hand pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand Services 
and Applications, then click Services.

(2) In the right-hand pane, scroll down to the Modular Messaging 
(MM) services. Make sure that the Status column shows that 
service is Started for each installed messaging service.

(3) If service is stopped or the Status column is blank, right-click the 
appropriate MM service and select Start.

(4) When finished, close this window.

b. If service is started, check for a problem with the test subscriber 
administration, the switch integration or switch integration software, or the 
switch number administration for the test telephone. 

2. From the test-subscriber telephone, dial the Modular Messaging 
messaging system message retrieval number.

The system voices the test subscriber�s name.

3. Enter the password for this mailbox and press . 

4. The first time you access this mailbox, you answer a series of prompts to 
set up the mailbox for operation. Answer all voice prompts as directed.

5. After the mailbox is set up, press  to review your new messages.

6. Press  to retrieve a voice message.

7. Listen to the message. If the message does not play properly, contact 
your Services support center.

8. Press  to erase this message.

9. Follow the voice prompts to retrieve the next message (if any), or press 
 to return to the main menu.

10. Hang up the telephone to disconnect when finished.

11. If MWI is installed: Check the MWI on the test-subscriber telephone. The 
MWI should be off. If it is not off, check your MWI administration on the 
MAS and the PBX. 

#

1

1

7

*
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Creating and sending a test message in nonintegrated mode

To create and send a test message in nonintegrated mode: 

1. Dial the Modular Messaging messaging system message retrieval 
number from any telephone that is not administered on the system.

The system voices the �Welcome to Avaya Messaging� prompt.

2. Press  to skip the system introduction. 

3. Enter the extension number for test-subscriber mailbox and press .

4. Enter the password for this mailbox and press . 

5. Press  to create a new message.

6. Speaking into the telephone, record the following or a similar test 
message after the tone.

 �This is a test voice mail message.�

7. Press  to approve your message.

8. Enter the mailbox number for the test subscriber when prompted for the 
extension, followed by .

9. Press  twice (as prompted) to approve the message.

10. Press  again to send the test message to the test-subscriber mailbox.

11. Hang up the telephone to disconnect. 

12. Retrieve the message as described in "Retrieving test messages in 
integrated mode" on page 10-4.

Testing the outcalling capability

Test the outcalling capability of the system using the Subscriber Options package. 

To test system outcalling:

1. Switch the monitor to show the appropriate MAS. See "Switching the 
monitor to show the correct server" on page 6-2 if needed.

2. Install the Subscriber Options package as follows: 

#

#

#

2

#

#

#

#

Note: Microsoft Outlook must not be installed on the MAS. 
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a. Insert the Avaya Modular Messaging Application Software disk in the 
machine�s drive, then navigate to the Install\Client Distrib directory on the 
appropriate drive (such as D:). 

b. Double-click the Install.exe file. 

3. To run the Subscriber Options package, click Start > Programs > Avaya 
Modular Messaging > Subscriber Options.

See the Modular Messaging Subscriber Options User Guide 
(585-310-789, PDF 1 MB) on the documentation media for details if 
needed. 

4. In the User Logon window:

a. Enter the mailbox number and password for the test subscriber. See 
"Adding a test subscriber" on page 10-2.

b. Use the host name for MAS#1 (such as ZIPPY). See item 1 on the Modular 
Messaging MAS planning form on page A-6.

c. Click OK.

5. Play back the spoken name to test outcalling as follows:

a. In the Modular Messaging Software User Properties window, click the 
Record Greetings tab.

b. Under Standard Greetings, click the Spoken Name radio button.

c. Verify that the telephone will be used for name playback:

(1) Check the icon to the left of the status display. If it shows a 
telephone, continue with step d.

(2) If the icon shows a terminal, right-click and select Telephone. The 
icon changes to show a telephone. Continue with step d.

d. Click the Play button (large black single arrow) on the player near the 
bottom of the window. 

e. Answer the telephone when it rings. 

The picture of the phone should change to become off-hook. 

f. Listen for the system to play the spoken name of the test subscriber. 

g. Hang up the telephone. 

The picture of the phone should change back to being on-hook (this 
may take a couple of seconds).

6. When finished, click OK to close the Modular Messaging Software User 
Properties window.
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Running additional tests

You may want to run additional tests to verify the correct operation of features that are 
particularly important to the customer. For example:

! Automated Attendant

! Call Me

! Find Me

! Octel Analog Networking

To test these or other features, see the Avaya Modular Messaging Software Messaging 
Application Server Administration guide (PDF 3 MB) on the documentation media for 
feature setup and operation instructions. 

Administering subsequent MASs 

Continue this installation procedure based on the number of MASs in the system:

! If you have another new MAS to configure, return to the appropriate 
chapter:

� To install another new Avaya MAS, return to Chapter 6, ��Configuring a 
new Avaya MAS.�� 

� To configure another customer-provided MAS, return to Chapter 7, 
��Installing and configuring the Modular Messaging software.�� 

! If all your MASs are now configured, continue with "Removing the test 
subscriber" on page 10-9. 
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Removing the test subscriber

When acceptance testing is completed, remove the test subscriber using the normal 
procedures for your version of Microsoft Exchange (2000, 2003, or 5.5). For example:

1. Log in to the directory server using an account that has privileges to 
delete user accounts (such as administrator).

2. Access Active Directory Users and Computers (for Exchange 2000 or 
2003) or Microsoft Exchange Administrator (for Exchange 5.5).

3. Expand the directory for the Windows domain you used for Modular 
Messaging.

4. In the left-hand pane, click Users or Recipients as required.

5. In the right-hand pane, right-click the test subscriber and select Delete. 

Backing up the system 

As a final installation task, set up the system to perform regular, scheduled backups of 
MAS-specific information using the normal backup procedures for your site. We 
recommend that you do an attended backup now on every MAS to preserve the 
configuration information and to verify the backup function. 

Customers should consider the following when designing their backup program:

! Customized Tone Files: If analog port boards are installed in any MAS 
and you have created customized tone files, keep a copy of the tone 
files (*.tsf for Dialogic boards or *.ton for Brooktrout boards) in a network 
location where they are part of the normal backup procedure. We 
suggest that all tone files be stored in the \Avaya_Support\Tone_Files 
directory. You may choose to back up this location or store a copy of the 
tone files elsewhere for backup.

! Caller Applications: Caller Applications (*.uma files), once deployed, are 
stored on each MAS within a folder that has a GUID. The location for this 
folder is \Program Files\Avaya Modular 
Messaging\VServer\CallerApps. We recommend that you back up a 
copy of this folder as described below. 

Deployed caller applications cannot be backed up using NTBackup 
while the Modular Messaging (MM) Messaging Application Server 
service is running. However, you can make a copy of the CallerApps 
folder while this service is running, and then make a backup of that (you 
could choose to create scripts to carry out this function). See Restoring 
Caller Applications after a catastrophic disk failure on page F-3 for 
details on restoring Caller Applications if needed. 
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! Licensing Files: Keep a backup of your licensing files (*.xml) safe on 
another location. 

! System State: We suggest that you back up the system state of each 
MAS on a regular basis. The registry contains settings particular to your 
MAS.

! Spool: The directory \Program Files\Avaya Modular 
Messaging\Vserver\Spool stores messages that are sent while the 
MAS is offline from the message store. You should back up the Spool 
directory on each MAS.
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11
Upgrading Unified Messenger 5.0 to

Modular Messaging software

This chapter describes how to upgrade a system that is running Unified Messenger 
Release 5.0 software to Modular Messaging Release 1.1 software.  

Note: Do the tasks in this section only if you are upgrading a system that 
is running Unified Messenger Release 5.0 software to Release 1.1 
of the Modular Messaging software. 

Any systems that are running an earlier release of Unified 
Messenger must upgrade to Unified Messenger Release 5.0 
software prior to upgrading to Modular Messaging software.

Section Page

Overview 11-2

Updating the Exchange extensions 11-4

Preparing the MAS for the upgrade 11-4

Updating the Dialogic port board drivers 11-6

Updating messaging software on the MAS 11-10

Updating client software 11-16

Performing acceptance tests and backups 11-16
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Overview

A system that is already running Unified Messenger Release 5.0 software can be 
upgraded to Modular Messaging Release 1.1 Modular Messaging software as 
described in this chapter. 

Upgrade requirements

To successfully upgrade a system to Modular Messaging software, you need:

! A completed copy of the relevant planning forms listed in Appendix A, 
��System planning forms,�� including: 

� The Modular Messaging MAS planning form on page A-6 showing the 
NetBIOS name of each MAS, the default (or primary) peer Exchange 
server, and the directory server.

� The Modular Messaging logon accounts form on page A-9 showing 
the customer-specified Unified Messenger service account name and 
password. This account will be updated automatically to be the 
Modular Messaging (MM) service account. 

� The MAS features list on page A-10 showing the services, prompts, 
and languages to install on each MAS. 

! The newest release of the Avaya Modular Messaging Application 
Software on DVD or CD. 

If the Modular Messaging application software is provided on a CD, you 
also need the following CDs: 

� Intel Dialogic Drivers CD

� Enhanced Email Reader Software containing ScanSoft 
Text-to-Speech (TTS) software in multiple languages (3 CDs) 

� Avaya Modular Messaging Release 1 Documentation CD

If the Modular Messaging software is provided on a DVD, the DVD 
contains all of the information listed on the separate CDs above.

Note: Updating the Modular Messaging software requires several server 
restarts. Plan to do the software upgrade during low-usage hours. 

Note: The Unified Messenger software will change its name to �Modular 
Messaging� following the upgrade. Therefore accounts and 
settings that were formerly labeled �Unified Messenger� will 
become Modular Messaging accounts. 
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! If Brooktrout port boards are installed, obtain a copy of the RealCT 
Direct Software Installation and Configuration Guide, available on the 
Avaya Unified Messenger CD.

Upgrade procedure

The Modular Messaging upgrade procedure involves:

1. Updating the Exchange extensions on any machines where they are 
installed. 

2. Preparing the MAS for the upgrade. 

3. Updating the software on each of the MASs and configuring new 
features as needed. 

4. Updating the client software on each MAS and any other computer 
where it was previously installed. 

5. Performing acceptance tests on the entire system.

Considerations for multiple-MAS upgrades

In a multiple-MAS configuration, it is strongly recommended that all MASs that are 
running Unified Messenger be upgraded to Modular Messaging software as soon as 
possible. The User Administration Extensions use new attributes in Modular 
Messaging and cannot be updated on administrators� machines until all MASs are 
upgraded, or erratic behavior may occur. All MASs in the voice mail domain must be 
upgraded to Modular Messaging before you can enable the new features. 

If you are installing a new Modular Messaging system in a multiple-MAS configuration, 
it cannot join an existing voice mail domain that only has Avaya Unified Messenger 
Voice Servers in it. You must first upgrade one or more of the existing Avaya Unified 
Messenger Voice Servers, leave the system running for at least 15 minutes, then add 
the new Avaya Modular Messaging server. 

Note: Completely upgrade and test one MAS first, and let it run for 15 
minutes before upgrading any additional MASs. 

CAUTION: All servers must meet the requirements listed in the Avaya 
Modular Messaging Concepts and Planning guide (PDF 2 
MB). This guide is available on the documentation media 
shipped with your system. Review this document to make 
sure that your Exchange servers, directory servers, MASs, 
and client machines are all ready to support Modular 
Messaging software.

!
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Updating the Exchange extensions

You must update the Exchange extensions software on any machines where it is 
installed before installing any other Modular Messaging software. This may include 
client, Exchange server, and MAS machines.

To do this: 

1. Follow the procedure in "Updating the Exchange extensions" on page 
5-4. 

2. Return to this chapter after the Exchange extensions have been updated 
on all machines where it was previously installed. 

Preparing the MAS for the upgrade

Do this task on every MAS. 

This section describes how to take the Messaging Application Server (MAS) ports 
offline and prepare for the Release 1.1 Modular Messaging software upgrade.

To prepare the MAS for an upgrade: 

1. If Microsoft Outlook is installed on this machine, uninstall it. 

2. Make sure the anti-virus software and Microsoft Windows updates and 
security patches are current. See "Installing anti-virus software and 
Windows updates" on page 7-3. 

3. If anti-virus software is installed, disable it while you upgrade the 
Modular Messaging software. You will enable the virus-checking 
software again after the upgrade is complete.

4. Adjust the system values to support Modular Messaging. See "Adjusting 
system values" on page 7-3. 

Note: If other Unified Messenger software is installed on this 
machine, many component checkboxes will be checked. This 
ensures that all currently installed components are upgraded to 
Modular Messaging software. The components will be installed 
in the correct order when you click Install. See "Upgrading to 
Modular Messaging software" on page 11-10 for details on 
installing the various software packages. 

If a System Upgrade screen appears, see "Running a system 
upgrade" on page 11-12. 
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5. Install the required prerequisite software on every MAS. This includes:

! Microsoft Windows Simple Network Management Protocol (SNMP) 
services (required by the Modular Messaging Alarming Server). See 
"Installing Windows prerequisite software" on page 7-7. 

! The Microsoft Exchange 2000/2003 System Management Tools or 
the Exchange 5.5 Administration Tools as required. See "Installing 
required Exchange software" on page 7-8. 

6. The PBX administrator must make sure that the ports for this MAS are 
made busy and rerouted to other MASs using the procedures 
appropriate for your PBX. Otherwise callers into the system could hear 
ringing-no answer or a busy signal. 

7. Log in to the MAS using the customer-specified Unified Messaging 
service account name (such as mmacct) and its password (see item A7 
on the Modular Messaging logon accounts form on page A-9). 

8. Close any open windows on the system.

9. Stop and reset all Unified Messenger services as follows:

a. Click Start > Programs > Administrative Tools > Computer Management.

b. In the Computer Management screen, in the left-hand pane, expand 
Services and Applications.

c. Click Services.

d. In the right-hand pane, scroll down to the set of installed Unified Messenger 
services.

e. Double-click the first Unified Messenger service to open the Properties 
window.

f. Under �Service status,� click Stop. 

g. Wait for service to stop, then set the �Startup type� to Manual.

h. Click OK to close this window.

i. Repeat steps e through h for each Unified Messenger service.

j. Close the Computer Management window.

10. If Brooktrout boards are installed, you may want to back up the 
Brooktrout tone file before upgrading the software. 

Note: Stop the Unified Messenger Voice Server service last. 
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Updating the Dialogic port board drivers

Do this task on every MAS that contains Dialogic port boards. 

This section describes how to replace the drivers for the Dialogic port boards as part of 
the Release 1.1 Modular Messaging software upgrade.  

Preparing for driver installation

To prepare the MAS for the Dialogic driver update: 

1. You should already be logged in to the server using the Unified 
Messenger account name (such as mmacct) and its password.

2. Stop the Dialogic drivers as follows:

a. From the task bar, click Start > Programs > Dialogic System Software > 
Dialogic Configuration Manager - DCM. 

b. At the �DCM could not detect devices� message, click OK. 

The Dialogic Configuration Manager window appears.

c. To stop the Dialogic drivers, click the red Stop Service button and wait.

d. When drivers are stopped, close the Dialogic Configuration Manager 
window.

3. For analog boards: If a custom tone file was created, it must be backed 
up on another drive or copied to a new directory now, or it will be 
destroyed during the upgrade. You can use the following procedure:

a. On the C: drive of the MAS, create a new directory named Avaya_Support 
with a subdirectory named Tone_Files. 

b. In the Windows Explorer window, navigate to the directory where the 
custom tone file is stored (for example, C:\Program Files\Dialogic\DATA).

c. If any tone files are present (those with a .tsf extension), select them (use 
Ctrl+click to select multiple TSF files).

d. Right-click one of the selected files and select Copy.

e. Navigate to the C:\Avaya_Support\Tone_Files directory. 

f. In the right-hand pane, right-click and select Paste to copy the .tsf files.

Note: If this MAS uses Brooktrout port boards, the drivers do not need to 
be updated. Continue with "Updating messaging software on the 
MAS" on page 11-10. 
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Uninstalling the existing Dialogic drivers

To remove the existing Dialogic 5.0.1 drivers: 

1. Insert the applications software media in the MAS drive. This is either:

! Avaya Modular Messaging Application Software DVD, or

! For a system that uses CD-ROMs, the Intel Dialogic Drivers CD. 

2. In Windows Explorer, navigate to the CD or DVD drive (D:). 

3. Locate the Dialogic files. They are at the root directory on the CD, or 
under a Dialogic Drivers subdirectory on the DVD. 

4. Double-click the file Uninstall_5_01.bat.

A command (cmd) window opens. Press any key to continue. 

5. If the Dialogic point release Ptr26599 for SR 5.01 for Windows is 
installed, this will be removed first.

a. In the dialog box, select Remove and click Next.

b. At the confirmation message to remove the point release, click OK.

c. If the system reports any files as read only, click Yes to continue with the 
removal.

d. When prompted, select �No, I will restart my computer later� and click 
Finish. 

e. Control returns to the batch file. Press any key to continue. 

6. At the �uninstall the Dialogic System Software and SDK� message, click 
Yes. 

7. When Uninstall pauses, close any open windows. Click OK.

The system stops services.

8. When prompted to Remove Shared File, select No to All.

9. When Uninstall completes, the Remove Programs From Your Computer 
screen may show that some elements were not removed. Click OK.

10. When prompted to reboot, click Yes.
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Installing the new Dialogic drivers

To install the new Dialogic 5.1.1 base release drivers: 

1. Log back in to the server using the Unified Messenger account name 
(such as mmacct) and its password.

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the CD or DVD drive (D:), and locate 
the Dialogic files. 

5. Double-click the file Install_5_11.bat. 

The Intel Dialogic System Software and SDK for Windows System 
Release 5.1.1 for Windows wizard runs. When the installation 
completes, the system automatically reboots. 

Applying the Dialogic Feature Pack

Update the new Dialogic drivers with the 5.11 Feature Pack (FP1): 

1. Log back in to the server using the Unified Messenger account name 
(such as mmacct) and its password. 

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the CD or DVD drive (D:), and locate 
the Dialogic files. 

5. Double-click the file Install_5_11_FP1.bat.

The System Release 5.1.1 Feature Pack 1 wizard launches.

6. On the Welcome screen, click Next.

7. On the License Agreement screen, click Yes.

8. On the Customer Information screen:

a. For User Name type Modular Messaging. 

CAUTION: Several files have similar names. Verify that you 
are about to select the correct file before clicking it.!
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b. Type the appropriate Company Name, then click Next.

9. On the Select Components screen:

a. Verify that the box to install the Program Files is checked.

b. Clear the checkbox to not install the Online Documentation.

c. Click Next.

10. The Start Copying Files screen appears. Click Next. 

This step may take several minutes to complete.

11. When prompted, select Yes, I want to restart my computer now.

12. Click Finish.

The system reboots.

Reconfiguring the Dialogic port boards

Finally, restore the configuration for your Dialogic boards: 

1. Log back in to the server using the Unified Messenger account name 
(such as mmacct) and its password.

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the CD or DVD drive (D:), and locate 
the Dialogic files. 

5. Double-click the file Restore_Config.bat.

6. A command (cmd) window opens. Press any key to continue.

The program cleans up any temporary installation files and replaces 
certain files used by the Dialogic boards.

For a system that uses CD-ROMs, remove the Dialogic drivers CD from 
the drive.

7. Reconfigure and test the Dialogic port boards for this MAS. See 
"Configuring the port boards" on page 8-2.  

Note: Because the Dialogic Line Test application is not yet installed, 
you must insert the application software disk in the MAS drive. 
See step 2 in "Testing the port boards" on page 8-10. When 
testing is complete, continue with the next section.
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Updating messaging software on the MAS

Do this task on every MAS. 

This section describes how to upgrade the Unified Messenger Release 5.0 software to 
Modular Messaging Release 1.1 software on the Messaging Application Server (MAS). 

Upgrading to Modular Messaging software

To upgrade the Unified Messenger Release 5.0 software to Modular Messaging 
software:

1. Insert the application software disk in the MAS drive. This is either:

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD. 

2. Close the drive door and wait for the green LED to go out. Click OK.

3. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the CD or DVD drive (D:).

b. Navigate to the Install directory. 

c. Double-click the file Setup.exe.

The Modular Messaging - Installation Wizard launches. 

4. On the main screen, verify that the Configuration drop-down box shows 
Microsoft Exchange.

5. All components that were previously installed on this machine are 
already selected, as well as the Diagnostic tools. Verify that all 
necessary components for this MAS are checked. 

6. Click Install.

Previously installed software components are updated automatically (no 
response is needed). New software components that are required for 
Release 1.1 are also installed. 

7. You may be prompted to enter information for the following components: 

! Alarming Server 

Note: If a System Upgrade screen appears, see "Running a system 
upgrade" on page 11-12. 
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! Messaging Application Server 

The wizards for these components must be completed as follows: 

a. When the appropriate server installation wizard runs, click Next.

b. When prompted, enter the following account information:

! For Domain, enter the NetBIOS name of the Windows domain 
(such as zodiac). See item 2 on the Modular Messaging MAS 
planning form on page A-6.

! For User Name and Password, enter the Modular Messaging 
account name (such as mmacct) and its password. See item A7 
on the Modular Messaging logon accounts form on page A-9. 

! Click Next. 

c. Click Install.

d. When done, click Finish.

8. You may be prompted for additional information for other software 
components. If prompted, complete the wizards as follows: 

a. If an additional server installation wizard runs, click Next.

b. When prompted, enter name of this MAS machine (such as zippy). See 
item 1 on the Modular Messaging MAS planning form on page A-6. Click 
Next. 

c. When prompted, enter the password for the Modular Messaging account 
(such as mmacct). See item A7 on the Modular Messaging logon accounts 
form on page A-9. Click Next. 

d. Click Install.

e. When done, click Finish.

9. For a system that uses CD-ROMs, you are prompted to insert additional 
disks to install the RealSpeak Text-to-Speech software in multiple 
languages. When prompted to insert installation disk 2: 

a. Remove the Avaya Modular Messaging Application Software and 
Languages CD from the drive. 

b. Insert the first Enhanced Email Reader (Text-to-Speech) RealSpeak 
software CD in the drive and close the door. 

c. Wait for the drive�s green LED to go out. Click OK. 

d. After the disk is copied, you are prompted to insert the next disk: 

! Insert the next RealSpeak TTS software CD in the drive.

! Repeat steps b through d for each RealSpeak TTS software CD.
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Allow several minutes for the RealSpeak software to install. When 
finished, the wizard returns to the main screen. 

10. To complete the upgrade, click Close.

11. Click Restart when prompted to restart the system now. 

12. Remove the media from the CD or DVD drive. 

Running a system upgrade

Do this task only if a System Upgrade screen appears when you launch the Modular 
Messaging Installation Wizard. 

If the required operating system components are not present on the target machine 
when the Modular Messaging installation wizard is launched, the System Upgrade 
Screen is displayed automatically.

! If Windows Installer is not loaded on the system, the Ignore button is 
disabled and you must click Run System Upgrade to install at least the 
Windows Installer component. This procedure requires a reboot. 

! If Windows Installer is already loaded on the system, you can click 
Ignore to continue the installation without upgrading any other operating 
system components. This is only recommended when installing the 
Modular Messaging Exchange Administration extensions. 

To run a system upgrade:

1. On the System Upgrade screen, click Run System Upgrade.

2. The Operating System Upgrade screen appears. This screen lists the 
system components that will be installed on the system. 

3. Select the radio button to choose either:

! Upgrade Windows Installer only (if you are installing only 
Exchange extensions components)

! Upgrade all required system components (used for most MAS 
machines that will run Modular Messaging software). 

4. Click Install.

When the required components have been upgraded, the System 
Upgrade Complete screen appears.

Note: If you choose to ignore a system upgrade, some Modular 
Messaging components will fail to function correctly. 
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5. Click Restart to reboot this machine. 

6. Continue with your previous upgrade activity. 

Configuring the MAS for the new software 

To configure this MAS for the new Modular Messaging software:

1. When the reboot completes, log back in to the server using the Modular 
Messaging (MM) account name (such as mmacct) and its password. 
(This was formerly the Unified Messenger account.) 

The Messaging Application Server - Configuration Wizard launches. 

It make take a few minutes to connect to the MAS.

2. On the Front End Database Update screen, click Next. 

The service starts up.

3. The upgrade procedure compares the prompts installed on the MAS with 
the existing voice mail domain prompts. If any prompts are absent, the 
Missing Prompts screen appears and displays a list of the prompts that 
need to be installed before the installation can continue. To do this:

a. On the Missing Prompts screen, note the missing prompt sets. The 
configuration wizard attempts to locate the installation packages for these 
prompts automatically.

b. If any installation packages cannot be found, a Locate Installation 
Package message appears. Click the text, and then click Browse. 

c. In the Browse for Folder screen, navigate to the Prompts directory.

d. Select the folder containing the missing prompts, and click OK. 

e. Repeat steps b through d for all prompts that cannot be found. 

f. When finished, click Next. (This button is not enabled until all the prompt 
installations are found.) 

4. On the User Information screen, click Next to set up users� messaging 
information on the MAS. 

Note: If you are running Microsoft Windows NT4, you need to reapply 
the latest service pack after a System Upgrade. 

Note: This step may take several hours for a large database or global 
address list (GAL). 

Note: This step may take several hours for a large database. 
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5. On the Setup Complete screen:

a. Read the instructions, then either register now, or clear the checkbox for 
�Register Modular Messaging online with Avaya� to register later. 

b. Click Finish.

Configuring new features

After the new Modular Messaging software is installed, you must configure and activate 
new features for this release using the Voice Mail System Configuration program. 

To configure new features:

1. See "Configuring domain-wide features" on page 9-3 and complete 
steps 1 through 3. 

2. Set up the following new Modular Messaging features: 

a. Serviceability: See step 10 on page 9-7 to activate alarming for the 
system.

b. Licensing: See step 11 on page 9-8 for the steps to obtain and install the 
required license file.

c. Optional: If the Text-to-Speech (TTS) feature is used at this site, see 
Languages (step 8) on page 9-6 to activate this feature. 

d. Optional: If Offline Access is used at this site, see Messaging (step 9) on 
page 9-7 to activate this feature. 

3. If INADS alarming is used at this site, configure it as follows: 

a. In the Voice Mail System Configuration window, expand Messaging 
Application Servers, then expand the entry for this MAS (such as ZIPPY). 

b. Click Serviceability to set up INADS service. See step 4-f on page 9-11 
under Configuring MAS-specific parameters for details. 

Setting up and starting messaging services

To allow the Modular Messaging (MM) services to restart automatically during normal 
operation, and to start messaging services:

1. Click Start > Run.

2. In the Run box Open field, type the following and press Enter:

C:\Avaya_Support\Scripts\serverrecovery.vbs 

Note: You can enable the anti-virus software on the MAS at this time. 
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The script takes a few seconds to run. When it completes, all installed 
MM services will be started.

3. Optional. To verify that all services are started: 

a. Access the window to monitor services using one of these methods:

! Double-click the Monitor icon on the desktop (if present). In the 
left-hand pane, click Services if it is not already selected. 

! Right-click My Computer and select Manage. In the Computer 
Management window, the left-hand (Tree) pane, expand Services 
and Applications, then click Services.

b. In the right-hand pane, scroll down to the list of Modular Messaging (MM) 
services. Make sure that the Status column shows that service is Started 
for each installed messaging service.

c. If service is stopped or the Status column is blank, right-click the 
appropriate MM service and select Start.

d. When finished, close this window.

Completing the upgrade

Continue the Modular Messaging software upgrade as appropriate:

! If client software is installed on this MAS: Update the client software on 
this MAS as described in "Updating client software" on page 11-16. 
When finished, return to this section. 

! If you have more than one MAS: 

a. For MAS#1 only, let the Modular Messaging software run for 15 minutes so 
that it can update shared data across the voice mail domain.

b. Return to "Preparing the MAS for the upgrade" on page 11-4 to begin 
upgrading the next MAS.

c. Repeat the Modular Messaging software upgrade procedure through this 
section until all MASs are upgraded.

! If Brooktrout boards are installed, test each board using Multi-Channel 
Demo. See Brooktrout�s RealCT Direct Software Installation and 
Configuration Guide, available on the Avaya Unified Messenger CD, for 
configuration and test information for Brooktrout port boards. 

! When all MASs are upgraded: Continue with "Performing acceptance 
tests and backups" on page 11-16.
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Updating client software

Do this task on every MAS and every subscriber machine where client software is 
installed. 

The client software packages (such as Subscriber Options) must be updated on every 
MAS and on every subscriber�s machine where they are already installed. 

To update the client software to the latest release:

1. Log in to each MAS or subscriber machine where a client software 
package from the previous release is installed. You must use an account 
with administrator rights to install software (such as the Modular 
Messaging account or local administrator account for a client machine). 

2. Install a new version of the client software. For example, to reinstall the 
Subscriber Options package: 

a. Insert the Avaya Modular Messaging Application Software disk in the 
machine�s drive, then navigate to the Install\Client Distrib directory on the 
appropriate drive (such as D:). 

b. Double-click the Install.exe file. 

The reinstallation process removes the old software and installs the 
newest version.

3. Repeat this procedure until all existing versions of client software have 
been replaced with the version for the newest release.  

Performing acceptance tests and backups

After upgrading the system, verify that it is working correctly, then save your changes: 

1. See "Performing acceptance tests" on page 10-4 and perform all the 
tests relevant to this system. 

2. When acceptance tests are complete, back up the MAS system using 
the regular backup procedures at your location. See "Backing up the 
system" on page 10-9 for guidelines. 

Note: Upgrade all MASs in the system to Modular Messaging before 
before you upgrade the software on any subscriber machines. 

Note: The Subscriber Options software should be updated on every 
MAS prior to performing the acceptance tests. 
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A
System planning forms

Overview

Implementing Modular Messaging software, and especially installing any new 
Avaya Messaging Application Server (Avaya MAS), requires careful network 
planning. Server names, IP addresses, domain names, accounts, extensions, 
and passwords must be administered correctly on each of the servers in the 
system. Some information must be provided by the customer in advance, or 
the installation cannot proceed. 

This appendix provides an overview of system planning and a set of forms for 
you to fill out prior to installation with the help of the local LAN, switch, and 
messaging administrators. Information includes:

! Terminology on page A-2 

! Guidelines for completing the forms on page A-3

! Modular Messaging MAS planning form on page A-6

! Modular Messaging MAS planning form (completed example) 
on page A-8

! Modular Messaging logon accounts form on page A-9

! MAS features list on page A-10

! Required switch and messaging information on page A-11

! Services information on page A-12
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Terminology

The following terminology applies to the LAN administration process. 

Avaya MAS � A Messaging Application Server (MAS) where the hardware is provided 
by Avaya Inc., often with other optional peripheral devices. The port boards and much 
of the required software are pre-installed on an Avaya MAS.

Messaging Application Server (MAS) � Any Microsoft Windows-based machine that 
is running Avaya Modular Messaging software. A customer-provided MAS has some 
different prerequisite hardware and software requirements than an Avaya MAS (for 
example, the port boards and additional Windows software must be installed), but the 
software installation and administration is nearly identical for both platforms. 

Host name � The unique name of the machine. In Microsoft Windows terminology, this 
is often called the NetBIOS machine name. 

NetBIOS name � The Microsoft Windows term for a host name, also called a NetBIOS 
machine name.

Directory server � A server that contains the subscriber mailboxes, such as Active 
Directory or the Microsoft Exchange Administrator application. 

Exchange server � A server that is running a compatible release of Microsoft 
Exchange software. 

Domain name � A unique designator used to identify a group of related computers on 
the internet (for example, avaya.com). Domain names are hierarchical, and the labels 
go from more specific on the left to more general on the right. There can be any 
number of levels in the hierarchy. 

Domain Name Service (DNS) � An Internet protocol service most often used to 
resolve symbolic names to IP addresses. The DNS service is constructed on 
hierarchical domains with different sets of servers serving each hierarchical layer.

DNS server � A machine that has the DNS service active. Such a machine can resolve 
symbolic names for the DNS domain it serves to an IP address. 

NetBIOS domain � A Microsoft Windows domain that is not fully qualified (has no 
periods). For example, zodiac.

IP address � A value used to identify a computer connected to a network. If a machine 
has multiple network interfaces, then the machine will have multiple IP addresses, one 
for each connection to a different network. IP addresses are usually specified as four 
numbers separated by a period (for example, 10.9.55.183).

Subnet mask � A value used to tell which bits of an associated IP address are the 
network portion and which bits identify the specific host on the network. Each network 
interface has an IP address and an associated subnet mask.
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Corporate IP LAN and interface � Each MAS is connected to the LAN infrastructure 
constructed and maintained by the enterprise that purchased the system. The LAN is 
the corporate IP LAN, and may be identified as Local Area Connection 2 or Corporate 
LAC on an Avaya MAS. This LAN gives the MAS access to other machines and users.

IP gateway � An IP gateway is an IP address where IP packets are routed if the 
specified IP address is not on the network directly connected to an interface on the 
machine. An IP gateway is usually an interface on a router.

Default IP gateway � The IP gateway to use if no other specified gateway is available. 
Each MAS has at most one default gateway connected to the corporate IP LAN. 

PPP � Point-to-Point Protocol, an Internet standard protocol used for serial line 
connections, such as dial-up modems.

Initialization and Administration System (INADS) � Avaya's remote service support 
program for monitoring alarms and maintaining installed systems. 

Voice Mail Domain (VMD) � A group of one or more messaging servers. Messaging 
(or voice) servers in a VMD share configuration properties of the VMD and subscribers 
to the VMD.

Windows domain � A grouping of network objects, such as users, groups, and 
computers. All objects in a domain are stored on the directory server, such as Active 
Directory. A directory can reside on one or more domain controllers within a domain.

Guidelines for completing the forms

Use the following guidelines to complete the Modular Messaging MAS planning form 
on page A-6 for each Avaya Messaging Application Server (Avaya MAS) or 
customer-provided MAS that you need to install.  

See the Modular Messaging MAS planning form (completed example) on page A-8 for 
a sample completed form. 

Note: It is crucial to coordinate the IP addresses that will be used for any 
MASs with those on the corporate LAN. If you specify an Ethernet 
address for an Avaya server that conflicts with another Ethernet 
endpoint, the resulting problems with traffic on the local area 
network can be extremely difficult to diagnose and solve.
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To complete the MAS planning form:

1. For a customer-provided MAS, the machine (host) name is already 
assigned. Enter it here for reference. 

For any Avaya MASs that will be installed, choose unique NetBIOS 
machine names for each MAS (for example, zippy and zorro). You must 
keep track of what machine you are administering. In this guide, zippy is 
MAS#1, and zorro is a subsequent MAS. 

2. For the Windows domain NetBIOS name, enter the name already 
assigned by the LAN administrator to the Windows domain that this 
Modular Messaging system will join (for example, zodiac). 

3. For the Peer Exchange server, enter the NetBIOS machine or host 
name already assigned to the server that is to act as the primary 
Exchange server for this MAS machine. 

4. For the Peer Directory server, enter the NetBIOS machine or host name 
already assigned to the directory server (such as Active Directory). 

5. For MAS#1: The voice mail domain (VMD) is created by the Modular 
Messaging software. Choose a simple term different from the Windows 
domain name (such as zebra).

6. If the Offline Access feature will be used in a multiple-MAS system, 
specify the location to be used for the offline message store. The remote 
store is used to synchronize messages in a multiple-MAS configuration. 

7. For any new MASs that will be installed, the corporate LAN addresses, 
domain names, default gateway (if any), and WINS information (if 
needed) must be supplied by the corporate LAN administrator. See 
items 7 through 15 in the Modular Messaging MAS planning form. 

! The IP address for any required DNS or WINS servers must be 
supplied by the corporate IP administrator. 

Note: MAS machine names must be 14 characters or less. Names 
shorter than 10 characters long are recommended for ease in 
completing the online screens. The host and domain names 
can be any term you want, as long as they are unique and 
comply with local conventions. 

Note: If the offline message store is to be on a machine other than an 
MAS, the share must be mapped as a network drive on the 
MAS machine. See the Avaya Modular Messaging Software 
Messaging Application Server Administration guide (PDF 3 
MB) on the documentation media for details. 
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! The domain search order and any domain names must be supplied 
by the corporate LAN administrator in the order required. 

8. Contact the appropriate administrator for site-specific information 
required for a Modular Messaging installation (see items 16 and 17).

9. Complete the Modular Messaging logon accounts form on page A-9 
using the customer-provided account names and passwords required for 
this site.

10. Have the customer specify the messaging services that they want to 
install on each MAS using the MAS features list on page A-10.

11. Complete the Required switch and messaging information on page A-11 
with help from the relevant messaging or switch administrator. 

12. Complete the required Services information on page A-12 with help from 
the customer and the entity responsible for providing ongoing 
maintenance of the system. This information varies depending on 
whether INADS or SNMP alarming is to be used at this site. 

Note: It is strongly recommended that only static IP addresses be 
assigned to MAS interfaces and machines.

IP addresses should be configured on the corporate DNS 
servers (if used) by LAN personnel in keeping with local policy 
and practices. Customers must also register the corporate 
domain names for each MAS on any relevant corporate DNS 
servers.

CAUTION: Keep a copy of the completed planning forms handy during 
initial administration and system configuration. Save your 
planning forms in a safe place when installation is complete 
in case changes or updates are made to the system. 

Be sure to file records of passwords and account names 
securely.

!
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Page 1 of 2

Modular Messaging MAS planning form

# Item MAS #1 MAS #2

1 This MAS�s host name (NetBIOS name)

2 Windows domain NetBIOS name �Use MAS#1 value�

3 Peer Exchange server (host or NetBIOS 
name)

4 Peer Directory server (host or NetBIOS 
name)

5 Voice mail domain name �Use MAS#1 value�

6 Offline message store 

7 Corporate domain name

8 Corporate IP address for this MAS

9 Corporate subnet mask for this MAS

10 Corporate default gateway IP address

11 Corporate DNS servers IP addresses 

12 Search order of DNS domains

13 Register this connection�s IP address in the DNS? 
Register the DNS suffix in the DNS?

14 WINS servers IP addresses 
(if WINS is required) 

15 Static IP addresses for remote access 
(2 required per MAS) 

16 Customer name: 

Organization: 

Windows domain administrator contact information:

Microsoft Exchange administrator contact information:

17 Active Directory users or groups who require system administration access: 

Active Directory users or groups who require subscriber administration access: 
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Page 2 of 2
Copy this form as many times as needed to cover all MASs. 

Modular Messaging MAS planning form (continued)

# Item MAS #3 MAS #4

1 This MAS�s host name (NetBIOS name)

2 Windows domain NetBIOS name �Use MAS#1 value� �Use MAS#1 value�

3 Peer Exchange server (host or NetBIOS 
name)

4 Peer Directory server (host or NetBIOS 
name)

5 Voice mail domain name �Use MAS#1 value� �Use MAS#1 value�

6 Offline message store 

7 Corporate domain name

8 Corporate IP address for this MAS

9 Corporate subnet mask for this MAS

10 Corporate default gateway IP address

11 Corporate DNS servers IP addresses 

12 Search order of DNS domains

13 Register this connection�s IP address in the DNS? 
Register the DNS suffix in the DNS?

14 WINS servers IP addresses 
(if WINS is required) 

15 Static IP addresses for remote access 
(2 required per MAS) 

16 Customer name: 

Organization: 

Windows domain administrator contact information:

Microsoft Exchange administrator contact information:

17 Active Directory users or groups who require system administration access: 

Active Directory users or groups who require subscriber administration access: 
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The following planning form shows a completed example for a two-MAS system. These 
sample values are used in this guide for illustration purposes only. 

Modular Messaging MAS planning form (completed example)

# Item MAS #1 MAS #2

1 This MAS�s host name (NetBIOS name) zippy zorro

2 Windows domain NetBIOS name zodiac �Use MAS#1 value�

3 Peer Exchange server (host or NetBIOS 
name)

exchange1 exchange2

4 Peer Directory server (host or NetBIOS 
name)

directory1 directory1

5 Voice mail domain name zebra �Use MAS#1 value�

6 Offline message store \\zorro\OfflineStore \\zorro\OfflineStore 

7 Corporate domain name loc.avaya.com loc.avaya.com

8 Corporate IP address for this MAS 10.9.83.72 10.9.83.39

9 Corporate subnet mask for this MAS 255.255.255.0 255.255.255.0

10 Corporate default gateway IP address 10.9.83.254 10.9.83.254

11 Corporate DNS servers IP addresses 10.9.1.39
10.9.1.2

10.9.1.39
10.9.1.2

12 Search order of DNS domains loc.avaya.com
avaya.com

loc.avaya.com
avaya.com

13 Register this connection�s IP address in the DNS? yes
Register the DNS suffix in the DNS? yes

14 WINS servers IP addresses 
(if WINS is required) 

10.152.6.24
10.9.6.8

10.152.6.24
10.9.6.8

15 Static IP addresses for remote access 
(2 required per MAS) 

10.168.2.200
10.168.2.201

10.168.2.202
10.168.2.203

16 Customer name: Messaging Administrator

Organization: Avaya Inc.

Windows domain administrator contact information: name, email, telephone number 

Microsoft Exchange administrator contact information: name, email, telephone number 

17 Active Directory users or groups who require system administration access: craft

Active Directory users or groups who require subscriber administration access: Exchange Subscriber 
Administrators
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Account logon names and passwords should be site-specific for security reasons. 

 

Modular Messaging logon accounts form

# Account Logon name (should be 
customer specified) Password Used for

A1 Local administrator 
account for
MAS#1 (required)

customer specified 
(for example, mas1-admin)

Local administration 
for this MAS

A2 Local administrator 
account for 
MAS #2 (if present)

customer specified 
(for example, mas2-admin)

Local administration 
for this MAS

A3 Local administrator 
account for 
MAS #3 (if present)

customer specified 
(for example, mas3-admin)

Local administration 
for this MAS

A4 Local administrator 
account for 
MAS #4 (if present)

customer specified 
(for example, mas4-admin)

Local administration 
for this MAS

A5 Local administrator 
account for 
MAS #5 (if present)

customer specified 
(for example, mas5-admin)

Local administration 
for this MAS

A6 Local administrator 
account for 
MAS #6 (if present)

customer specified 
(for example, mas6-admin)

Local administration 
for this MAS

Add as many local accounts as needed to support all MASs

A7 Modular Messaging (MM) 
account

customer specified 
(for example, mmacct) 

MAS messaging 
services (MM) 
administration 

A8 Services support remote 
access account

customer specified 
(for example, craft)

Remote access 
maintenance 
account for MM

CAUTION: We strongly recommend that passwords and account names 
on the MAS be at least 8 characters long and not composed 
of easily guessed words or numeric combinations, including 
sequential or repeated numbers. For best security, use a 
combination of upper-case, lower-case, and alphanumeric 
characters. At least one of the first 7 characters should be a 
symbol (such as a # sign or punctuation mark), but not a % 
symbol.

Do not use the examples shown above as the actual account 
names; they are provided for example purposes only.

!
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MAS services and features

Fill out the following table with the customer to specify the Modular Messaging services 
and optional features to install on each MAS. Guidelines include: 

! If only one MAS is installed, all required services are installed on that 
machine. Check the features to install in the MAS#1 column. 

! If more than one MAS is installed:

� Install the Call Me Server and MWI Server software on the same MAS. 
These services must be co-resident with the Mailbox Monitor Server, 
and should be installed on the MAS with the smallest number of ports 
if possible, or on the MAS with the second smallest number of ports if 
the Tracing Server is installed.

� Install the Tracing Server on a different MAS than the one that is 
hosting the Call Me and/or MWI software. Always put the Tracing 
Server service on the MAS with the smallest number of ports.

 

* Specify the maximum number of concurrent sessions for the feature based on expected usage. 
Copy this form as many times as needed to assign features to all MASs at this site. 

MAS features list

Messaging service to install Max. # of 
sessions:*

 on 
MAS#1

 on 
MAS#2

on 
MAS#3

 on 
MAS#4

Call Me Server

Message Waiting Indicator (MWI) Server 

Both use Mailbox Monitor Server and should be on the 
same MAS; install these services only once per voice 
mail domain (VMD). 

Caller Applications Editor N/A

Tracing Server (install only once per VMD) N/A

Text-to-Speech (If required, note languages to use; 
specify the number of sessions for each MAS.)

Messaging Application Server

Prompt Files
(One set is required for each MAS that is running the 
Messaging Application Server software; list the default 
file set first and additional prompt files if needed.)

N/A

Language Packs
(Specify additional languages to install if needed; list 
the desired default language first. Install the same set 
of languages on each MAS.)

N/A
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Switch and messaging information 

Collect the required information from the relevant administrator prior to installation. 

CAUTION: You can only install a Modular Messaging system by using 
the required configuration notes for the switch or PBX. See 
��Information on the web�� on page 1-2. 

!

Required switch and messaging information

Item Value Notes

Extension numbers for the port boards on the 
MAS, and the switch ports to which they 
connect.
Note: Distribute the port board extensions 

over a number of switch boards if 
possible for greater reliability.

Use format: cabinet carrier slot 
port 

Connects to extension 
number: 

Number of digits in voice mailbox extension:

Are port groups required? If yes, supply 
name, use, and number of ports. (For 
example, MWI outgoing only, 2 ports)

Port group 1: Port group 2: 

DID numbers used for:

� MM hunt group for messaging services:

� MAS dial-in number (one per modem):

Complete dial-in number: 

Test subscriber information:
� name 
� password 
� extension number to test telephone

�
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Services information 

Fill out the appropriate section depending on how alarming will be implemented at this 
site: either through Avaya's Initialization and Administration System (INADS) or the 
corporation�s Simple Network Management Protocol (SNMP) system. 

Services information required for every installation includes:

! Alarming notification used at this site (INADS, SNMP, or none): ____

! Product ID number: _______________________________________

INADS alarming information

Supply the following information to allow the MAS modem to initiate outgoing calls: 

! Communications (COM) port that each modem should use to initiate 
alarm notification calls. This is COM3 for the recommended USB port A 
on the MAS: _________________

! Complete alarm destination telephone number: _________________

! Modem setup (initialization) string required for the modem to make the 
alarm notification calls; see the documentation included with your 
modem for details: _______________________________________

SNMP alarming information

Supply the following information if SNMP alarming is to be used at this site: 

! Network Management Station IP address or fully qualified domain name 
for the corporate network management system (NMS) that will monitor 
the Modular Messaging system for alarm notifications (traps): 
_______________________________________________________

! Context (community) to which the NMS belongs (see your SNMP NMS 
documentation for details): _____________________________

! Acknowledgement type: choose either Return Trap (to have traps 
actively acknowledged by the NMS) or Ping Surround (to have the MAS 
send a ping to the NMS before and after sending a trap; if the pings 
succeed, the NMS is assumed to have received the trap): 
_______________________________________________________ 

Note: If SNMP alarming is used, it is the customer�s responsibility to 
provide and provision the SNMP network management system, 
and to configure it to receive (and optionally acknowledge) the 
traps generated by the Modular Messaging system. 
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B
Installation checklists

Overview

This appendix contains checklists to help guide you through the various tasks 
described in this guide. Before beginning a new Modular Messaging 
installation or upgrade, print the checklist relevant to the procedure you will be 
performing. Check off the steps as you complete them to make sure that you 
do not overlook any important tasks.

Checklists include:

! New Modular Messaging installation on a customer-provided 
MAS on page B-2

! New Modular Messaging installation on an Avaya MAS on 
page B-5

! Unified Messenger R5.0 to Modular Messaging software 
upgrade on page B-9
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New Modular Messaging installation on a customer-provided MAS

This checklist applies to a new Modular Messaging installation on a customer-provided 
MAS. As you complete a procedure, make a check mark in the � � column.

Modular Messaging on a customer-provided MAS installation checklist 

Task Description Comments

Complete preinstallation planning:

1. Complete the planning forms in Appendix A. Requires 
customer input.

See LAN, messaging, and 
switch administrators as needed. 

2. Obtain virus-checking software for the MAS. Customer obtains if required. 

3. Arrange for LAN administration of the MAS system. 
Some LANs may be administered in advance; others require 
new machine administration to be done at installation.
Register MAS corporate FQDNs on the DNS if required.
Note: Avaya Inc. is not responsible for the installation, 
administration, or test of communications between customer 
PCs and the LAN. 

See the LAN administrator.

4. Verify that the switch is administered. See the switch administrator.

5. Arrange for the Active Directory data schema update and 
schedule downtime for the Exchange server if required.

Review requirements to 
determine if this is needed.

6. Assemble and review the required documentation. Web access is required.

7. Review security issues.

8. Gather the necessary tools and test equipment.

9. Collect any software CDs that will be needed during the 
installation (such as the Microsoft Windows OS CD, Microsoft 
Exchange software CD, SP updates, or anti-virus software) 

Install any required hardware:

10. Install the Dialogic port boards. This includes:
� Setting jumpers and switches
� Installing the Dialogic software and drivers
� Connecting the boards to the switch or PBX 

See the Dialogic documentation 
for details.

IP H.323 integrations skip this 
step. 

11. Install and configure the modem for each MAS. Optional - do if required. 

Prepare to install the Modular Messaging software:

12. Set up the required Modular Messaging service account, plus
� a remote access account for ongoing maintenance
� a test subscriber for acceptance testing 

Do this on the directory server.

 (1 of 3)
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13. Assign permissions to the service accounts. Procedure may vary. 

14. Add a computer account for each MAS to the Active Directory. Do this on the directory server.

15. Set up each MAS to support remote access. Do this on the directory server.

16. Update the Active Directory and data schema if required for 
Windows 2000 or 2003 with Active Directory or Octel systems. 

Do this before installing other 
Modular Messaging software. 

17. Update the Exchange extensions on any machine that is used 
to administer subscribers. 

Most extension updates require 
a server restart. 

Set up the MAS for Modular Messaging: 

18. Configure the network card on the MAS. Use static IP addresses. 

19. Install and update anti-virus software on the MAS, then disable 
it for Modular Messaging software installation. 

Do if required; installation 
procedures vary. 

20. Install the latest Microsoft Windows security patches. Do if required; procedures vary. 

21. Adjust system values on the MAS for Modular Messaging:
� Event Viewer
� Windows 2000 Server operating system properties
� File and Printer Sharing properties

22. Join the Microsoft Windows domain. Do this on the MAS. 

23. Add the Modular Messaging service accounts to the local 
administrators group for this MAS. 

Required for installing software.

24. Install Microsoft Windows software on the MAS required to 
support the Microsoft Exchange tools. 

Requires the Microsoft Windows 
OS CD. 

25. Install required Exchange software on the MAS, including:
� System Management or Administration tools
� Latest service pack for your version of Exchange 

Requires Microsoft Exchange 
software CD. 

Install and configure the Modular Messaging software:

26. Install Modular Messaging software packages using the 
Installation wizard.

Install on each MAS based on 
the planning forms.

27. Use Messaging Application Server - Configuration Wizard to:
� Identify the Exchange and directory servers 
� Set up (on MAS#1) or join the voice mail domain 

Steps vary between MAS#1 and 
a subsequent MAS.

28. Enable the virus-checking software on the MAS. Do if anti-virus software is 
installed. 

29. Set up remote access on each MAS.

Modular Messaging on a customer-provided MAS installation checklist 

Task Description Comments

 (2 of 3)



585-310-331, Issue 1

Avaya Modular Messaging for Microsoft Exchange Release 1.1 Installation

B�4 December 2003

30. Configure and test the port boards. This includes:
� For analog cards, create or use an appropriate tone file.
� Configure each port board.
� Test incoming and outgoing calls on each board.

Configuration notes required.

IP H.323 integrations skip this 
step. 

31. Use the Voice Mail System Configuration program to:
� Enable the messaging services you installed.
� Configure the MAS for this PBX.
� Set up specific features for each MAS.
� Install the license file when received. 

Configuration notes required.

32. Arrange to obtain a license for this system. Local procedures may vary. 

33. Set up and start MAS messaging services.

34. Verify the alarming setup on the MAS.  

35. Configure Active Directory Connector in a mixed Exchange 5.5 
and 2000/2003 environment. 

Do this on the directory server if 
required. 

Test and back up the system:

36. Enable the test subscriber for Modular Messaging. Do this on the directory server.

37. Perform acceptance tests. These include:
� Creating and receiving test messages in both integrated 

and nonintegrated mode
� Testing system outcalling using Subscriber Options
� Testing additional features if required for this site 

38. Install and configure each subsequent MAS. Repeat these steps as needed.

39. Remove the test subscriber.

40. Back up the data on every MAS.

41. Save the planning forms in a safe place.

Modular Messaging on a customer-provided MAS installation checklist 

Task Description Comments

 (3 of 3)
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New Modular Messaging installation on an Avaya MAS

This checklist applies to a new Modular Messaging installation using an Avaya 
Messaging Application Server (Avaya MAS). As you complete a procedure, make a 
check mark in the � � column.

Modular Messaging on an Avaya MAS installation checklist 

Task Description Comments

Complete preinstallation planning:

1. Complete the planning forms in Appendix A. Requires 
customer input.

See LAN, messaging, and 
switch administrators as needed. 

2. Obtain virus-checking software for the MAS. Customer obtains if required. 

3. Arrange for LAN administration of the Avaya MAS system. 
Some LANs may be administered in advance; others require 
new machine administration to be done at installation.
Register MAS corporate FQDNs on the DNS if required.
Note: Avaya Inc. is not responsible for the installation, 
administration, or test of communications between customer 
PCs and the LAN. 

See the LAN administrator.

4. Verify that the switch is administered. See the switch administrator.

5. Arrange for the Active Directory data schema update and 
schedule downtime for the Exchange server if required.

Review requirements to 
determine if this is needed.

6. Assemble and review the required documentation. Web access is required.

7. Review security issues.

8. Gather the necessary tools and test equipment.

9. Collect any software CDs that will be needed during the 
installation (such as the Microsoft Exchange software CD, SP 
updates, or anti-virus software) 

Install the hardware:

10. Review preinstallation site requirements, including:
� environmental requirements
� weight and space requirements
� customer-provided cabinet requirements
� installation area requirements
� power and grounding requirements
� demarcation points

11. Unpack the Modular Messaging system hardware and 
peripheral components.

Open boxes as instructed to 
reuse packing materials.

12. Assemble and identify the system components.

 (1 of 4)
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13. Attach mounting brackets and handles to UPS and any EBM 
units as needed, then cable the units together.

Optional - do if UPS and any 
EBMs are present.

14. Attach the front bezel to each MAS. 

15. Attach rails for rack-mount or rubber spacers for stackable 
configuration to each MAS.

16. Connect the Avaya MAS system power cables.

17. If present, connect the MAS port boards to the switch or PBX. See the Dialogic documentation 
for details.

18. Connect each MAS to the corporate LAN.

19. Assemble the KVM switch. Steps include:
� Attach mounting brackets to KVM switch (if needed).
� Connect KVM switch to the monitor and keyboard/mouse.
� Connect the KVM switch to each MAS.

Optional. Procedure varies 
depending on type of KVM 
switch purchased.

20. Attach the required ferrites to the video cables and QSIG port 
board cables (if present).

21. Set up the external modem for each MAS.

22. Power up the Avaya MAS system.

Prepare to install the Modular Messaging software:

23. Set up the required Modular Messaging service account, plus
� a remote access account for ongoing maintenance
� a test subscriber for acceptance testing 

Do this on the directory server.

24. Assign permissions to the service accounts. Procedure may vary. 

25. Add a computer account for each MAS to the Active Directory. Do this on the directory server.

26. Set up each MAS to support remote access. Do this on the directory server.

27. Update the Active Directory and data schema if required for 
Windows 2000 or 2003 with Active Directory or Octel systems. 

Do this before installing other 
Modular Messaging software. 

28. Update the Exchange extensions on any machine that is used 
to administer subscribers. 

Most extension updates require 
a server restart. 

Set up the Avaya MAS:

29. Switch the monitor to show the correct MAS.

30. Install the hard disk image from the OS boot CD or DVD. Do only if the operating system 
must be reloaded on this MAS.

31. Complete the Found New Hardware wizards if they appear. Complete wizards as prompted.

Modular Messaging on an Avaya MAS installation checklist 

Task Description Comments
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32. Complete the Windows 2000 Server Setup Wizard to:
� Localize system information
� Assign IP addresses and DNS servers 
� Join the Microsoft Windows domain 

Use your planning forms.

33. Test IP addresses on the corporate network using ping. Optional but recommended.

34. Install and update anti-virus software on the MAS, then disable 
it for Modular Messaging software installation. 

Do if required; installation 
procedures vary. 

35. Install the latest Microsoft Windows security patches. Do if required; procedures vary. 

36. Enable Windows prerequisite services for Exchange 2003. Do for Exchange 2003 only. 

37. Install required Exchange software, including: 
� System Management or Administration tools
� Latest service pack for your version of Exchange 

Requires Microsoft Exchange 
software CD. 

38. Complete the Modular Messaging OS Component 
Configuration Wizard to: 
� Identify the message store
� Set up account information 

Use the logon accounts form.

Install and configure the Modular Messaging software:

39. Install Modular Messaging software packages using the 
Installation wizard.

Install on each MAS based on 
the planning forms.

40. Complete the Messaging Application Server - Configuration 
Wizard to:
� Identify the Exchange and directory servers 
� Set up (on MAS#1) or join the voice mail domain

Steps vary between MAS#1 and 
a subsequent MAS.

41. Enable the virus-checking software on the MAS. Do if anti-virus software is 
installed. 

42. Set up remote access on each MAS.

43. Configure and test the port boards. This includes:
� For analog cards, create or use an appropriate tone file.
� Configure each port board.
� Test incoming and outgoing calls on each board.

Configuration notes required.

IP H.323 integrations skip this 
step.

44. Use the Voice Mail System Configuration program to:
� Enable the messaging services you installed.
� Configure the MAS for this PBX.
� Set up specific features for each MAS.
� Install the license file when received. 

Configuration notes required.

45. Arrange to obtain a license for this system. Local procedures may vary. 

46. Set up and start MAS messaging services.

Modular Messaging on an Avaya MAS installation checklist 

Task Description Comments
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47. Verify the alarming setup on the MAS.

48. Configure Active Directory Connector in a mixed Exchange 5.5 
and 2000/2003 environment. 

Do this on the directory server if 
required. 

Test and back up the system:

49. Enable the test subscriber for Modular Messaging. Do this on the directory server.

50. Perform acceptance tests. These include:
� Creating and receiving test messages in both integrated 

and nonintegrated mode
� Testing system outcalling using Subscriber Options
� Testing additional features if required for this site 

51. Install and configure each subsequent MAS. Repeat these steps as needed.

52. Remove the test subscriber.

53. Back up the data on every MAS.

54. Save the planning forms in a safe place.

Modular Messaging on an Avaya MAS installation checklist 

Task Description Comments

 (4 of 4)
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Unified Messenger R5.0 to Modular Messaging software upgrade

This checklist should be used when you upgrade an existing Unified Messenger 
Release 5.0 system to run the new Modular Messaging software. As you complete a 
procedure, make a check mark in the � � column. 

Modular Messaging upgrade checklist 

Task Description Comments

Prepare for the upgrade:

1. Schedule downtime for the Exchange server if required. Review requirements to 
determine if this is needed.

2. Update the Exchange extensions on any machine that is used 
to administer subscribers. 

Most extension updates require 
a server restart. 

3. Install and update anti-virus software on the MAS, then disable 
it for Modular Messaging software installation. 

Installation procedures vary. 

4. Install the latest Microsoft Windows security patches. Do if required; procedures vary. 

5. Adjust system values on the MAS for Modular Messaging:
� Event Viewer
� Windows 2000 Server operating system properties
� File and Printer Sharing properties

6. Install Microsoft Windows software on the MAS required to 
support the Microsoft Exchange tools. 

Requires the Microsoft Windows 
OS CD. 

7. Install required Exchange software on the MAS, including:
� System Management or Administration tools
� Latest service pack for your version of Exchange 

Requires Microsoft Exchange 
software CD. 

8. Busy-out and reroute the ports to this MAS. Use PBX procedures.

9. Log in to the MAS to be upgraded using the Unified Messenger 
service account. 

This will become the Modular 
Messaging service account. 

10. Stop and reset all Unified Messenger services. 

11. Update the Dialogic port board drivers. This includes:
� For analog cards, copy the custom tone file to safe place 
� Stop and uninstall the existing drivers
� Install and update the new drivers
� Reconfigure and test the Dialogic port boards 

Configuration notes required.

Installations that use Brooktrout 
port boards skip this step. 

Install and configure the Modular Messaging software:

12. Upgrade existing and install new Modular Messaging software 
packages using the Installation wizard.

13. Complete the Messaging Application Server - Configuration 
Wizard to update the data base and directory server 

 (1 of 2)
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14. Use the Voice Mail System Configuration program to:
� Enable the new messaging services you installed.
� Set up specific new features for each MAS.
� Install the license file when received. 

Configuration notes required.

15. Arrange to obtain a license for this system. Local procedures may vary. 

16. Set up and start MAS messaging services.

17. Upgrade each additional MAS. Repeat this section as needed.

Complete the upgrade:

18. Allow 15 minutes for the upgrade information to be shared. Do this for MAS#1. 

19. Update client software packages on all machines. Do only after all MASs are 
upgraded. 

20. Perform acceptance tests. These include:
� Creating and receiving test messages in both integrated 

and nonintegrated mode
� Testing system outcalling using Subscriber Options
� Testing additional features if required for this site

21. Back up the data on every MAS.

Modular Messaging upgrade checklist 

Task Description Comments

 (2 of 2)
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C
Creating a new tone file

Overview

This appendix describes how to build a tone file for Dialogic analog port boards by 
using the PBXpert utility to learn PBX tones. 

This procedure must be done after the port boards are administered on the switch, but 
before you configure them using the Intel Dialogic Configuration Manager (see 
��Configuring analog port boards�� on page 8-3). 

You can use PBXpert either automatically or manually to learn the call progress tones 
for your PBX and store them in a Tone Set File (TSF). Many tone sets can be stored in 
a single TSF file. 

! Automatic Learning: PBXpert uses two different channels on the Dialogic 
voice board to set up tones and learn the resulting call progress tones 
automatically. See Learning tones automatically on page C-2.

Note: If Brooktrout port boards are installed, use the RealCT Direct 
Software Installation and Configuration Guide, available on the 
Avaya Unified Messenger CD, to create a tone file if needed.

CAUTION: Use the configuration notes to administer the port boards for 
your particular PBX or switch integration. See ��Required 
documentation�� on page 1-2 for instructions on obtaining the 
configuration notes. The port boards must be administered 
on the switch before you can proceed.

!
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! Manual Learning: PBXpert uses one channel on the Dialogic voice 
board and a telephone to set up tones and learn the resulting call 
progress tones manually. PBXpert prompts you how and when to use 
the telephone. See Learning tones manually on page C-7.  

Learning tones automatically

This section describes the following procedures:

! Running the PBXpert wizard on page C-2 

! Consolidating and saving the TSF file on page C-6

! Using the new TSF in Dialogic Configuration Manager on page C-6

Running the PBXpert wizard

The PBXpert wizard guides you through learning the tones used by your PBX and 
saving the information as a TSF file. PBXpert can learn the following tones: 

! Dial tone

! Ringback

! Busy

! Reorder (fast busy)

! Disconnect

To run the PBXpert wizard: 

1. Start the Dialogic voice cards. 

a. You should have already started the Intel Dialogic Configuration Manager. 
See steps 1 through 3 in ��Configuring analog port boards�� on page 8-3. 

b. Click the green Start Service button on the button bar. 

The installed boards show a green light when service is started, and the 
Stop Service button becomes active.

Note: If only one line is connected to the Dialogic voice board, you 
must use Manual Learning.
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2. Click Start > Programs > Dialogic System Software > PBXpert.

The PBXpert main window appears (see Figure C-1 on page C-3). Most 
fields are blank until tones are learned.

! If you are using PBXpert for the first time after installation, the 
PBXpert wizard starts automatically.

! If the PBXpert wizard does not start automatically, click Tones > 
Tone Wizard.  

Complete the PBXpert wizard screens as follows: 

1. When the PBXpert Wizard Welcome screen appears, click Next. 

2. On the PBX Information page:

! Under PBX, enter the name of the manufacturer (such as Mitel) and 
the model of the PBX (such as SX-2000).

Note: You can change the default settings in the wizard if you are 
familiar with your PBX environment and the Dialogic API. Any 
settings that you change are saved when you exit PBXpert. For 
help on a particular screen, click the Help button in the wizard.

Figure C-1. PBXpert main window
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! You can use the automatically created Tone Set File name as it 
appears, or alter it as desired.

! Click Next.

3. On the TAPI Information page, just use the default values. Click Next.

4. On the Select a Board screen:

! Select the Dialogic board to use.

! Click Next.

5. On the Select the Calling Resource screen, for the Line A Calling 
Channel: 

! For �Select the Channel,� enter the port number or channel to use.

! For �Phone Number,� enter the extension number of this port. See 
Required switch and messaging information on page A-11 for port 
board extensions.

! Click Next.

6. On the Select the Calling Resource screen, for the Line B Called 
Channel: 

! For �Select the Channel,� enter a different port number or channel to 
use.

! For �Phone Number,� enter the extension number of this port. 

! Click Next.

7. On the Settings Confirmation screen:

! Verify your settings. Click Back if you need to change anything.

! Make sure that the Run Wizard Auto-Test box is checked.

! Click Next.

8. The Auto Line Test window appears while PBXpert verifies the 
connection between the two specified channels. 

! If you see a �Test finished successfully!� message, click OK to close 
this window and proceed.

! If the line test fails, click OK to close this window. Click Back on the 
wizard, adjust your settings, and try the test again.

9. On the Learn Tones screen, click Next to begin learning tones 
automatically.
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The Learn Tones window appears. See Figure C-2 on page C-5.  

10. When PBXpert completes learning, buttons appear allowing you to keep 
or discard the data.

! If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

! If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust your settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

11. On the Verifying the Learn screen, click Next to test the learned tones.

! If the test succeeds, click OK to close the test window and proceed.

! OK to close this window. Click Back on the wizard, adjust your 
settings, and try the test again. 

12. The Summary of Results page shows the final wizard status and tone 
definitions. Click Finish.

Tone definitions are displayed in the main window (see Figure C-3 on 
page C-6). 

Note: You can click Cancel at any time during the test to stop 
automated learning.

Figure C-2. Learn Tones window (learning in progress)
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Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. On the Save As screen, navigate to the following directory to ensure that 
the file will be backed up: c:\Avaya_Support\Tone_Files 

(If you use the default DATA directory, this file will not be backed up.) 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Intel Dialogic Configuration Manager window.

Figure C-3. Sample tone definitions in main window 
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2. Click the red Stop Service button on the button bar.

3. Return to step 4 in ��Configuring analog port boards�� on page 8-3 and 
complete board configuration and testing.

Learning tones manually

This section describes the following procedures:

! Running PBXpert on page C-7 

! Adding a new tone set on page C-8 

! Learning tone definitions on page C-8 

! Testing the tone set on page C-10

! Consolidating and saving the TSF file on page C-10 

! Using the new TSF in Dialogic Configuration Manager on page C-10 

Running PBXpert

To run PBXpert manually: 

1. Start the Dialogic voice cards. 

a. You should have already started the Intel Dialogic Configuration Manager. 
See steps 1 through 3 in ��Configuring analog port boards�� on page 8-3. 

b. Click the green Start Service button on the button bar. 

The installed boards show a green light when service is started, and the 
Stop Service button becomes active.

2. Click Start > Programs > Dialogic System Software > PBXpert.

The PBXpert main window appears (see Figure C-1 on page C-3). Most 
fields are blank until tones are learned.

3. If you are using PBXpert for the first time after installation, the PBXpert 
wizard starts automatically. If the PBXpert32 Wizard starts, check the 
�Don�t run wizard at startup� checkbox and click the Cancel button.

A new, empty TSF is now active.

4. In the PBXpert main window, click Settings on the button bar.



585-310-331, Issue 1

Avaya Modular Messaging for Microsoft Exchange Release 1.1 Installation

C�8 December 2003

5. In the Settings window:

a. For Line A, enter the Board Number (such as 1) and the Channel Number 
or port number.

b. The Manual mode checkbox should be checked.

c. For Line B, for Phone Number, enter extension for this port or channel. 
See Required switch and messaging information on page A-11 for port 
board extensions

You can use the default values for all the other fields on this screen. 
Click Help for more information if needed.

d. Click OK.

Adding a new tone set

To add a new tone set to a TSF:

1. From the PBXpert main window, click Edit > New Tone Set.

2. In the New Tone Set window:

a. Enter the PBX Manufacturer (such as Mitel) and Model name (such as 
SX-2000).

b. Click OK.

The PBXpert main window shows the manufacturer and model names 
you entered. The tone definitions are set to zero.

Learning tone definitions

To add tone definitions to the new tone set:

1. From the PBXpert main window, click Tones > Learn.

2. On the Start Learn window:

a. Select the tones for the Dialogic cards to learn (the default is all tones). 

b. Click Start Learn to have PBXpert start learning tones.

Note: If you are familiar with your PBX environment and the 
Dialogic API, you can change these default settings. Any 
settings that you change are saved when you exit PBXpert.
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The Learn Tones window appears (see Figure C-4 on page C-9). 

3. You are prompted to listen for ringing, and to pick up or replace the 
telephone handset during the test. When the message box pops up, do 
the requested action, then click OK. 

4. When the learning process has finished, tone definitions appear in the 
Learn window. Keep or discard the data as follows:

! If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

! If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust your settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

The Learn window closes. The new tone definitions appear in the 
PBXpert main window. See Figure C-3 on page C-6 for an example. 

Note: Click Cancel at any time to stop learning.

Figure C-4. Learn Tones window (learning complete)
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Testing the tone set

The Test function checks that the consolidated tone set in the active TSF works 
correctly with the Perfect Call call-progress analysis utility. 

To test the newly learned tones:

1. In the main PBXpert window, Tones > Test.

2. A Test window appears. 

When testing is complete, test results are displayed in the Test window.

3. Check that the tone definitions of the learned tones are correct.

Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. On the Save As screen, use the default DATA directory. 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Intel Dialogic Configuration Manager window.

2. Click the red Stop Service button on the button bar.

3. Return to step 4 in ��Configuring analog port boards�� on page 8-3 and 
complete board configuration and testing.
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D
Administrator�s reference

Overview

This appendix details the permissions and data schema modifications that are required 
to support Modular Messaging software in a Microsoft Exchange environment. 
Information for Exchange 2000/2003 and Exchange 5.5 servers is included.

Exchange 2000/2003 permissions

Avaya Modular Messaging service account permissions are covered in ��Assigning 
Exchange 2000/2003 permissions�� on page 4-7. This section details why the Modular 
Messaging service account must be added to the following groups:

! The BuiltIn/Account Operators group in each domain contains accounts 
that will be enabled for Avaya Modular Messaging. This ensures that the 
Modular Messaging software has rights to perform the following 
operations:

� Provide full access to the ms-Exch-Extension-Data attribute for user 
objects that are to be enabled for Modular Messaging. This access 
right is required to enable Modular Messaging subscriber accounts.

� Create container objects. Avaya Modular Messaging creates a voice 
mail domain container. By default, the voice mail domain container is 
located root of the domain for which the Modular Messaging service 
account is a member. This container stores the directory objects 
required for the Messaging Application Server and Mailbox Monitor 
Server software components.
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If the Modular Messaging service account does not have sufficient 
privileges to create container objects at the base location of the 
domain that contains the service account, a voice mail domain 
container must be created manually. See ��Creating the voice mail 
domain container manually if required�� on page 4-11 for this 
procedure.

� Create User objects, and mailbox-enable User objects, in the voice 
mail domain container. This right is required for the operation of the 
Messaging Application Server and Mailbox Monitor Server software.

! The BuiltIn/Administrators group in the domain that contains the Global 
Catalog server(s), that will be used as peer-directory servers for Avaya 
Modular Messaging servers. This can be the domain that contains the 
service account, or any sub-domain that contains the service account. 
The right enables the Modular Messaging software to obtain search 
results from the peer-directory server, including recently deleted objects. 
This allows Avaya Modular Messaging to maintain consistency in its 
Front End Database (FEDB).

! The Domain Exchange Servers group in the domain that contains 
subscriber mailboxes. This right enables Avaya Modular Messaging 
software to access the information store for subscribers in order to 
provide Modular Messaging services.

The following table details the property permissions required to support Modular 
Messaging and their purpose. It also indicates the lowest level in the Exchange Service 
property tree that this permission should be applied.

Table D-1. Required switch and messaging information

Permission Description
Applies to this 
object and 
subcontainers

Modular Messaging 
requirement 

Read Read permission for items in container Mailbox Store Core requirement

Execute Execute permission for items in 
container

Mailbox Store Automatic with �Read�

Read Permissions Ability to read the permissions for an 
object

Mailbox Store Automatic with �Read�

Create Children Ability to create an object below the 
current object

Connectors Octel Analog 
Networking

List Contents Displays the contents and children of an 
object

Exchange 
Organization

Exchange System 
Manager

Read Properties Allows for Properties to be read from the 
class object

Administrative 
Group

Core requirement

Write Properties Allows for existing class object 
Properties to be written to

Connectors Octel Analog 
Networking
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Active Directory schema updates

Avaya Modular Messaging software requires the following changes to be made to the 
schema in an Exchange 2000/2003 environment before any other Modular Messaging 
server components are installed:

! Enable replication of the ms-Exch-Extension-Data attribute in the Global 
Catalog.

! Add classes and attributes for Octel Analog Messaging (if applicable).

The Modular Messaging software stores information about subscriber configurations in 
the ms-Exch-Extension-Data attribute. For Modular Messaging MASs to obtain this 
information, this attribute must be replicated in the Global Catalog, a central repository 
for information about objects in the Windows 2000 or 2003 forest. By enabling the 
replication, the system instructs the Global Catalog servers to include the 
ms-Exch-Extension-Data attribute in the list of objects replicated in the Windows 2000 
or 2003 forest.

Replication of the ms-Exch-Extension-Data in the Global Catalog is also necessary for 
the correct operation of the Modular Messaging Subscriber Options. This is because 
the MAPI address book provider for Active Directory uses the Global Catalog as its 
data source. Replication is required for MAPI to support access to client applications, 
such as Subscriber Options, through the PR_EMS_AB_EXTENSION_DATA property.

Administer Information 
Store

Allows creation of objects at root of folder Mailbox Store Voicemail Domain 
Mailbox

Create Named 
Properties in the 
Information Store

Allows new properties to be added to the 
class object

Mailbox Store User Admin

View Information Store 
Status

Required for MAPI Logon Mailbox Store External Caller 
Mailbox

Receive As Receive on behalf of privilege Mailbox Store Core requirement

Send As Send on behalf of privilege Mailbox Store Core requirement

Table D-1. Required switch and messaging information

Permission Description
Applies to this 
object and 
subcontainers

Modular Messaging 
requirement 
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When the Modular Messaging Subscriber Administration software component is 
installed, the following changes occur:

! The Modular Messaging property page is added for each user in Active 
Directory Users and Computers. More specifically, the guide 
�A6688A44-CEDE-456E-AE57-3567D9909AE7� is added to the 
multi-valued attribute adminPropertyPages on the user-Display object, 
which has the dn: CN=user-Display,CN=409, 
CN=DisplaySpecifiers,CN=Configuration,DC=mycorp,DC=com.

! Files for the software components required to display the Modular 
Messaging property page are copied to the Program Files\Avaya 
Modular Messaging directory.

Exchange 5.5 subscriber administration tools

On an Exchange 5.5 system, Modular Messaging subscriber accounts are created and 
administered using Voice Mail User Administration Extension. When Voice Mail User 
Administration Extension is installed, the following changes occur:

! An administration extension directory object is created under 
ORG\Site\Configuration\Add-Ins. This directory object is called 
�Extension for Modular Messaging User Administration�.

The administration extension object is created with the dn, 
/o=org/ou=unit/cn=Configuration/cn=Add-Ins/cn=gnvuaext:i386

! The extension is added to the list of administration extensions displayed 
for mailboxes in the site�s Recipients container. More specifically, the 
value �gnvuaext� is added to the multi-valued attribute 
�Extension-Name-Inherited� on the /o=org/ou=unit/cn=Recipients object.

! The software components required for running Voice Mail User 
Administration Extension are installed. These files are copied to the 
Add-Ins\gnvuaext\i386 directory of the Exchange 5.5 server running the 
installation.
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E
Reloading software on an Avaya

MAS

Overview

This appendix describes how to reload the operating system and application software 
on an Avaya Messaging Application Server (Avaya MAS). This procedure may be used 
to install new software on a new system, or to put the required software on the hard 
disk if the MAS suffered a catastrophic disk failure and a hard disk had to be replaced. 

Loading new MAS software

To copy new software to the Avaya Messaging Application Server (Avaya MAS):

1. The KVM switch should be connected to the MAS through one of the 
VGA computer ports. Verify that the monitor is showing the correct MAS.

! For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, press slowly in sequence Scroll Lock, then Scroll 
Lock, then the up (or down) arrow key to change to the server 
connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the up 
or down arrow key (such as 02 for port 2). See your KVM switch 
documentation for complete user instructions.

! If the monitor does not showing the correct server, see ��Connecting 
the KVM cables�� on page 2-24 and verify the cable connections. To 
correct cabling problems, power down the system, correct the 
cabling, then power up the system again. 
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2. Insert the Avaya Modular Messaging OS Boot Software DVD in the DVD 
drive.

Wait for green LED on the drive to go out. 

3. Press Ctrl + Alt + Del to reboot the system.

a. In the Windows Security window, click Shut Down...

b. On the Shut Down Windows screen, select Restart and click OK.

4. When the machine begins to boot, it displays a warning message that 
the hard drive contents will be overwritten. Press any key to continue. 

5. At the message confirming that the hard drive will be overwritten, press 
any key to continue.

The MAS begins to copy the disk image to the hard disk. The entire copy 
procedure may take up to 20 minutes. 

6. When finished, the program prompts you to remove the media before 
the system reboots.

! Remove the DVD from the drive and close the drive door. 

! Press any key to continue.

7. When the reboot completes, the Windows 2000 Server Setup Wizard 
appears. Complete the wizard as follows:

a. On the Your Product Key screen, type the Windows product key for this 
MAS (each unit has a unique product key). 

b. Click Next.

c. On the Licensing Modes screen, do nothing. The wizard continues the 
setup on its own.

The machine automatically reboots. 

8. When the reboot completes, proceed as follows:

! If no Found New Hardware Wizard appears, continue with step 9.

Note: This number must be entered exactly as shown. It is located on 
a sticker or tag on the side or rear of each MAS unit.

CAUTION: Do not touch the keyboard once the software starts loading, 
or the software will not install properly.!
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! If a Found New Hardware Wizard appears, it must be completed first, 
or the software will not install correctly. The hardware wizard appears 
once for every Dialogic port board installed in the system.

Disable the Dialogic hardware for now as follows: 

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next.

c. On the Locate Driver Files screen, clear the checkbox for �Specify a 
location� (no boxes will be checked). Click Next.

d. On the Driver Files Search Results screen, make sure that �Disable the 
device� is selected.

e. Click Finish.

f. Repeat steps a through e for each repetition of the wizard.

9. Double-click the MM_Setup.bat icon on the desktop. 

A C:\WINNT\system32\cmd.exe window appears. 

10. The program prompts you to load the required application software:

a. When prompted, insert the Avaya Modular Messaging Application Software 
DVD or CD in the DVD drive.

b. Wait for green LED on the drive to go out. 

c. When ready, press any key to continue. 

d. When notified that the D:\MM_Load\MM_Load.bat file was copied, press 
any key to continue. 

The machine displays the list of files that were copied. 

e. When prompted, press any key to continue.

11. When prompted to remove the media:

a. Remove the DVD or CD from the drive and close the drive tray door.

b. Press any key to continue.

12. When prompted that the Mini-Setup program will run after the system 
reboots, press any key to continue.

The machine stores the information and shuts down. 
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F
Recovering from a catastrophic disk

failure

Overview

This appendix summarizes the procedure for restoring a Messaging Application Server 
(MAS) if the hard disk drive failed and had to be replaced. 

To recover from a catastrophic disk failure, you will need:

! This guide and other required documentation for system installation. See 
��Required documentation�� on page 1-2 for a complete list.

! For an Avaya-provided MAS only, the Avaya Modular Messaging OS 
Boot Software DVD.

! A copy of the completed planning forms, which should be on file. See 
Appendix A, ��System planning forms.�� 

Recovery procedure

Follow the steps in this section for:

! ��Restoring an MAS after a catastrophic disk failure�� on page F-2

! ��Restoring Caller Applications after a catastrophic disk failure�� on page 
F-3

Note: Make sure that the planning forms are accurate and up-to-date. 
When you restore the MAS machine, you must duplicate exactly 
the information from your original setup (machine names, domain 
names, passwords, and so on) to avoid problems.
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Restoring an MAS after a catastrophic disk failure

To restore any MAS following a catastrophic disk failure:

1. The faulty drive must be replaced and the operating system reloaded 
and brought up to date. 

! For a customer-provided MAS: Follow these steps:

(1) Use the hard disk restoration procedures appropriate for your site 
to replace the hardware and reload the operating system. 

(2) When the disk is restored, complete the installation procedures 
from ��Prerequisite steps for a customer-provided MAS�� on page 
7-3 through ��Configuring the MAS�� on page 7-14. 

! For an Avaya MAS: Follow these steps:

(1) See �IDE drive replacement� on the documentation media for 
hardware replacement steps. 

(2) Install the operating system on the new disk drive. Follow the 
steps in Appendix E, ��Reloading software on an Avaya MAS.��

(3) Complete the installation from ��Setting up the Windows system�� 
on page 6-4 through ��Configuring the MAS�� on page 7-14. 

2. When you reach ��Configuring the MAS�� on page 7-14, do these steps: 

a. The Messaging Application Server - Configuration Wizard automatically 
launches. Complete steps 1 through 4 as directed. 

b. For step 5, on the Voice Mail Domain Selection screen, always join the 
voice mail domain as a �Subsequent server in an existing voice mail 
domain� (even if this is MAS#1).

c. Continue with the wizard as directed until step 8. If the Caller Applications 
Editor was installed, proceed as directed in ��Restoring Caller Applications 
after a catastrophic disk failure�� on page F-3. 

d. Complete the wizard as directed in ��Configuring the MAS�� on page 7-14. 

3. Complete the rest the MAS installation through Chapter 9, ��Configuring 
the voice mail system.�� 

4. Reinstall any previously installed patches on this MAS.

5. Restore data files from backup including spooled messages, customized 
caller applications and prompts. See ��Restoring Caller Applications after 
a catastrophic disk failure�� on page F-3 if relevant to this MAS. 

CAUTION: Do not restore the System State following a catastrophic disk 
failure.!

mdide.htm
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6. Reinstall any other software that was previously installed on this MAS 
(for example, Subscriber Options). 

7. Do ��Performing acceptance tests�� on page 10-4 and perform all the 
tests relevant to this system.

8. When you are satisfied that the system is running correctly, back up the 
restored MAS using the regular backup procedures at your location. See 
��Backing up the system�� on page 10-9 for details. 

Restoring Caller Applications after a catastrophic disk failure

The procedure for restoring the Caller Applications Editor software varies depending 
on how it is installed at this site. 

If MAS#1 is the only MAS in the voice mail domain, or if Caller Applications have been 
deployed on only the MAS that has had the hard disk replaced: 

1. Stop the Modular Messaging (MM) Messaging Application Server 
service as follows:

a. Double-click the Monitor icon on the desktop.

b. Select the Services (Local) item in the left-hand pane if it is not already 
selected.

c. In the right-hand pane of the Monitor window, scroll down to the MM 
Messaging Application Server service. 

d. RIght-click the service and select Stop. 

e. Wait for service to stop, then click OK to close this window.

2. From your MAS backup files, restore the CallerApps directory to the 
correct location: 
C:\Program Files\Avaya Modular Messaging\VServer\CallerApps

3. Restart the Messaging Application Server service. Follow the procedure 
in step 1, but select Start when you right-click the service.

If you are restoring any MAS to service in a multiple-MAS system and if Caller 
Applications has been deployed on one or more of the other MASs that are still 
operational and their services are running:

1. In the Messaging Application Server - Configuration Wizard, on the 
Caller Application screen, accept the default setting to get the Caller 
Application information from the voice mail domain. 

2. If you skip this screen or have problems with Caller Applications after 
installation, restore the CallerApps directory as described for a single 
MAS deployment above.
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3. If you still encounter problems after following these procedures, then 
restore the CallerApps *.uma files to a convenient location and redeploy 
Caller Applications. 
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G
Removing Modular Messaging

components

Overview

This appendix describes how to remove Modular Messaging software components 
from a machine where they are currently installed. You might use this procedure if you 
want to change the Messaging Application Server (MAS) on which a particular feature 
is installed, or to remove Modular Messaging software packages or tools from an 
administrator�s Microsoft Windows machine. 

Removing software components

To remove Modular Messaging software components:

1. Click Start > Settings > Control Panel.

2. From the Control Panel window, double-click Add/Remove Programs.

3. In the Add/Remove Programs window, scroll down the list of currently 
installed programs to locate the Modular Messaging software 
components installed on this machine. 

All Modular Messaging components begin with the name MM. 

4. Click the Modular Messaging software component you want to remove 
(for example, click MM Caller Applications Editor). 

5. Click Remove.

6. If prompted to confirm the deletion:

! Click Yes to remove the selected component.
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! Click No to leave this component installed on this machine. 

When the component removal is complete, the next item in the 
Add/Remove Programs window is selected. 

7. Repeat steps 3 through 6 to remove additional software components if 
needed.

8. When finished, close this window.
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overview, 6-2
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Caller Applications Editor, 7-12, 7-16, 10-9, A-10
catastrophic disk failure, 7-15 to 7-16, E-1, F-2
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installation checklist, B-2
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default gateway, 6-6, A-3
demarcation points, 2-6
Diagnostic Tools, 7-11 to 7-12
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8-6, 8-8
Dialogic drivers, 3-9, 11-6 to 11-8

Dialogic Line Test Application window, 8-10 to 8-12
Dialogic Line Tester program, 8-10
Dialogic port boards, see port boards
DID numbers, A-11
directory server, 1-8, 4-1, 9-13, A-2, A-4
DNS server, A-2
DNS setup, 6-6 to 6-7, A-4
documentation, i-xi, 1-2 to 1-3
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domain-wide feature setup, 9-3
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jumper settings, 3-7
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Ethernet switch installation, 2-22
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Exchange 5.5 administration extensions, D-4
Exchange extensions update, 5-1, 5-4, 7-11
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Ethernet switch, 2-22
ferrites, 2-27
front bezel, 2-16
hardware list, 2-7, 3-2
KVM switch, 2-23 to 2-24, 2-26
packing materials, 2-8
port board cables, 3-12
port boards, 3-2, 8-2
power cables, 2-20
preinstallation requirements, 1-8, 2-3, 3-3
sample installed system, 2-8, 2-19
unpacking the hardware, 2-7, 3-2
UPS and EBMs, 2-10
USB modem, 2-28, 9-11
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how to use this book, i-x
humidity requirements, 2-3
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IIS Admin Service, 6-12, 7-8
INADS alarming, 9-7, 9-11, 11-14, A-12
information on the web, 1-2
initial administration for PBX/switch and LAN, 1-7, A-4
Initialization and Administration System, see 
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install a license, 9-8
installation

Avaya MAS setup, 6-1
backing up system, 10-9
checklist, B-1
configuring port boards, 8-1
configuring voice mail system, 9-1 to 9-2
creating a new tone file, C-1
hardware installation, 2-1, 3-1
installing Modular Messaging software, 7-1
load new operating system, E-1
planning forms, A-1
preinstallation requirements, 1-1
preparing to install Modular Messaging, 4-1
testing the system, 10-1
updating Exchange extensions, 5-1, 5-4

installing Modular Messaging software, 7-10
integrated mode test, 10-4
Intel Dialogic Configuration Manager window, 8-3, 8-5, 
8-7, C-6, C-10
intended audience, i-ix
Internet Protocol (TCP/IP) Properties window, 6-6, 6-9
IP address, A-2
IP address administration, 6-6, 7-19, A-3 to A-4
IP gateway, A-3

J
joining a voice mail domain, 7-15, F-2
joining a Windows domain, 7-5

K
key components of Avaya MAS, 2-14
keyboard, monitor and mouse setup, see KVM switch
KVM switch

installation, 2-23 to 2-24, 2-26
showing the correct server, 6-2
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LAN

administration, 6-6
demarcation points, 2-6
initial administration, A-4
terminology, A-2

Language Packs, 7-12, A-10
languages, A-10
Languages - Voice Mail Domain window, 9-6
launching Modular Messaging Installation wizard, 4-14, 
5-5, 7-10, 11-10
Learn Tones window, C-5, C-9
learning tones, C-1 to C-2, C-7
license file backup, 10-10
license, obtain or install, 9-8, 11-14
loading new MAS software, E-1
local administrator account, 6-15, 7-6, A-9
Local Area Connection, A-3
logon accounts, A-9

M
Mailbox Monitor Server, 7-12 to 7-13, A-10
MAS administration

access permissions, 9-6
computer accounts, 4-10
load new software, E-1
remove software, G-1
setting up remote access, 7-17
subsequent MAS, 10-8
testing port boards, 8-10

MAS port board installation, 3-8
MAS services and features, A-10
MAS-specific parameters, 9-9
maximum number of concurrent sessions, A-10
Message Waiting Indicator - Voice Mail Domain 
window, 9-5, 9-7
Message Waiting Indicator (MWI) Server, 7-12 to 7-13, 
9-5, A-10
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Messaging Application Server, 7-12, A-10
Messaging Application Server (MAS), A-2
Messaging Application Server Configuration 
wizard, 7-14, 11-13, F-2 to F-3
Messaging Application Server, see MAS
messaging service recovery procedures, 9-12, 11-14
messaging services to install, A-10
Microsoft Exchange 2000 or 2003 Installation 
wizard, 6-13, 7-8
Microsoft Exchange 2000/2003 System Management 
Tools, 6-13 to 6-14, 7-9
Microsoft Exchange 5.5 Administration Tools, 6-13 to 
6-14, 7-9
Microsoft Windows updates, 1-5, 6-12, 7-3, 11-4
MM Messaging Application Server, 9-3, 9-10
modem configuration, 7-19, 9-11
modem installation, 2-28, 3-13
Modular Messaging Installation wizard, 7-11, 11-10
Modular Messaging MAS planning form, A-3, A-6 to 
A-8
Modular Messaging OS Component Configuration 
wizard, 6-15
Modular Messaging service accounts, 4-3, 4-7, 6-15, 
7-6, A-9
Modular Messaging software installation, 7-1, 7-10
monitor and keyboard/mouse setup, see KVM switch.
monitor showing correct server, 6-2
MultiTech modem, 2-28, 7-19
MWI

configuring, 9-5
installing software, 7-12 to 7-13
maximum number of sessions, 9-11, A-10
testing operation, 10-4

N
NetBIOS domain, A-2, A-4
NetBIOS name, A-2, A-4
network addressing on Avaya MAS, 6-6
network card configuration, 7-3
Network News Transfer Protocol (NNTP) 
software, 6-12, 7-7
network planning, A-1
nonintegrated mode test, 10-6

O
obtain a license, 9-8
Octel Analog Networking, 4-14 to 4-15, 5-6
offline access feature, 7-15, 9-7, 11-14, A-4
Offline Storage Location screen, 7-15

online help, i-xii
outcalling test, 8-12, 10-6

P
passwords

guidelines, A-9
Modular Messaging logon accounts form, A-9
security, 1-5, A-5

PBX
configuration notes, 1-2, 8-2, 8-10, 8-12, 9-3, 9-9 
to 9-11, A-11, C-1
configuring, 9-9
demarcation points, 2-6
integration, 9-11
planning form, A-11
supported integrations, 9-9

PBXpert utility for tones file, C-1, C-7
PBXpert wizard, C-2
performing acceptance tests, 10-4, 10-6, 10-8, 11-16
permissions for service account, 4-7, 4-9, D-1 to D-2
Permissions for Subscriber Administration window, 9-6
Permissions for System Administration window, 9-6
Phone And Modem Options window, 7-20
ping IP addresses, 6-11
planning forms, i-x, 1-7, A-1

MAS features list, A-10
Modular Messaging logon accounts form, A-9
Modular Messaging MAS planning form, A-6 to 
A-8
switch and messaging information, A-11

Point-to-Point Protocol, see PPP, A-3
port boards

Brooktrout, 10-9, 11-3, 11-5, 11-15, C-1
configuring, 3-13, 8-1 to 8-2, 8-5, 8-7, 9-11, 11-9
connecting cables, 3-12
drivers and software, 3-9
extension numbers, A-11
hardware wizard, 3-9
installation, 3-1 to 3-3, 3-8
jumper settings, 3-4
supported boards, 3-2, 8-2
testing, 3-13, 8-7, 8-10, 8-12, 11-9
updating drivers, 11-6

power cables for Avaya MAS, 2-20
power requirements, 2-5
preferred language, 9-3
preinstallation planning, 1-7, A-1
preinstallation requirements, 1-1

hardware, 1-8
LAN and PBX/switch administration, 1-7
security, 1-4 to 1-5
tools, 1-6
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preparing to install Modular Messaging software, 4-1
prerequisite software for MAS, 6-12 to 6-13, 7-7 to 7-8
prerequisite steps for customer-provided MAS, 7-3
primary language, 9-6
private LAN

settings on Avaya MAS, 6-9
testing addresses with ping, 6-11

product ID number, 9-7, A-12
Prompt Files, 7-12, A-10

R
rack-mount setup

Avaya MAS, 2-17
KVM switch, 2-23
sample installed system, 2-8
UPS and EBMs, 2-10

related resources, i-xi
remote access account, 4-5, 6-15, A-9
remote access setup, 4-12, 6-14, 7-17
remote support center, i-xii
remove MAS software, G-1
remove test subscribers, 10-9
restart messaging service, 9-10
restricted-access location, 2-4
retrieving test messages, 10-4

S
safety requirements, 2-4 to 2-5
scheduled backup, 10-9
schema updates, 4-2, D-3
security, 1-4 to 1-5

passwords, A-5, A-9
permissions to access system, 9-6

Security - Voice Mail Domain, 9-6
security patches, 1-4 to 1-5, 6-12, 7-3, 11-4
sending test messages, 10-4, 10-6
service accounts

creating, 4-3, 4-5, 4-7
permissions, 4-7, 4-9, D-1

Serviceability - Voice Mail Domain window, 9-7
set emulation boards

cabling, 3-12
configuring, 8-5
jumper settings, 3-6
testing, 8-10

setting up remote access, 4-12, 7-17
Simple Mail Transfer Protocol (SMTP) software, 6-12, 
7-7
site requirements

customer-provided cabinet, 2-3

demarcation points, 2-6
environmental conditions, 2-3
installation area, 2-4
power and ground, 2-5
test equipment, 1-6
weight and space considerations, 2-3

SNMP alarming, 9-7, A-12
software shipped with system, 1-3
space considerations, 2-3
stackable configuration

Avaya MAS, 2-19
KVM switch, 2-24
UPS and EBMs, 2-12

start messaging service, 9-12, 11-14
starting up the Avaya MAS, 6-3
static IP addresses, 7-19, A-4
subnet mask, A-2
Subscriber Options package, 10-6, 11-16
subsequent MAS, 7-15 to 7-16, 9-10, 10-8, 11-15, 
A-4
switch and messaging information, A-11
switch, see PBX
system hardware, see hardware installation
system planning forms, A-1
system security, 1-4 to 1-5
System Upgrade screen, 11-12

T
T1/E1 connections, 2-4
T1-QSIG boards

cabling, 3-12
configuring, 8-7
jumper settings, 3-7
testing, 8-10

TCP/IP settings, 6-6 to 6-7, 6-9
technical assistance, i-xii
Telephone User Interface, 9-4
telephones for acceptance testing, 1-6, 10-4
Telephony Configuration wizard, 9-10
Telephony Interface configuration, 9-11
temperature requirements, 2-3
terminology, A-2
test equipment, 1-6, 10-4
test subscriber, 4-6, 10-2, A-11

remove, 10-9
testing IP addresses using ping, 6-11
testing outcalling capability, 8-12, 10-6
testing port boards, 3-13, 8-10, 11-9
testing the system, 10-1
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Text-to-Speech (TTS) feature, 7-13, 9-6, 9-9, 11-11, 
11-14, A-10
tone file, 8-3 to 8-4, 10-9, 11-5 to 11-6, C-1, C-5, C-9
tools for installation, 1-6
Tracing Server, 7-12 to 7-13, A-10
track messaging service startup, 9-4, 9-10
trademarks, i-xi
training, i-xii

U
Unified Messenger Release 5.0 upgrades, 11-1
uninterruptible power system, see UPS
unpacking the system hardware, 2-7
updating Active Directory and data schema, 4-13
updating Exchange extensions, 5-1, 5-4, 7-11
upgrades

backups, 11-16
checklist, B-9
client software, 11-15 to 11-16
configuring MAS, 11-13
configuring new features, 11-14
Dialogic drivers, 11-6
Exchange extensions, 11-4
from Unified Messenger Release 5.0, 11-1
multiple-MAS configuration, 11-3
overview, 11-2 to 11-3
preparation, 11-4
prerequisite software, 11-5
requirements, 11-2
running system upgrade, 11-12
supported port boards, 8-2, 8-7
test subscribers, 10-2
testing port boards, 8-10
updating Modular Messaging software, 11-10

UPS installation, 2-10
USB modem, 2-28, 7-19

V
ventilation of servers, 2-4
verifying alarming setup, 9-13
virtual memory size for MAS, 7-4
virus-checking software, 1-4 to 1-5, 6-12, 7-3, 11-4
voice mail domain, 7-15, 9-4, A-3 to A-4
voice mail domain container manual creation, 4-11
Voice Mail System Configuration (VMSC) setup, 9-1 to 
9-2
Voice Mail System Configuration window, 9-4, 9-10

W
web access to documentation, 1-2

weight and space considerations, 2-3
Windows 2000 Server Setup wizard, 6-4
Windows Components wizard, 7-7
Windows domain, A-3
Windows product key, 6-5, E-2
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